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whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or

substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS

OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY

CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT

OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.



Technical Support

Symantec Technical Support maintains support centers globally. Technical

Support’s primary role is to respond to specific queries about product feature and

function, installation, and configuration. The Technical Support group also authors

content for our online Knowledge Base. The Technical Support group works

collaboratively with the other functional areas within Symantec to answer your

questions in a timely fashion. For example, the Technical Support group works

with Product Engineering and Symantec Security Response to provide alerting

services and virus definition updates.

Symantec’s maintenance offerings include the following:

■ A range of support options that give you the flexibility to select the right

amount of service for any size organization

■ A telephone and web-based support that provides rapid response and

up-to-the-minute information

■ Upgrade insurance that delivers automatic software upgrade protection

■ Global support that is available 24 hours a day, 7 days a week worldwide.

Support is provided in a variety of languages for those customers that are

enrolled in the Platinum Support program

■ Advanced features, including Technical Account Management

For information about Symantec’s Maintenance Programs, you can visit our Web

site at the following URL:

www.symantec.com/techsupp/

Select your country or language under Global Support. The specific features that

are available may vary based on the level of maintenance that was purchased and

the specific product that you are using.

Contacting Technical Support

Customers with a current maintenance agreement may access Technical Support

information at the following URL:

www.symantec.com/techsupp/

Select your region or language under Global Support.

Before contacting Technical Support, make sure you have satisfied the system

requirements that are listed in your product documentation. Also, you should be

at the computer on which the problem occurred, in case it is necessary to recreate

the problem.

www.symantec.com/techsupp/
www.symantec.com/techsupp/


When you contact Technical Support, please have the following information

available:

■ Product release level

■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical

support Web page at the following URL:

www.symantec.com/techsupp/

Select your region or language under Global Support, and then select the Licensing

and Registration page.

Customer service

Customer service information is available at the following URL:

www.symantec.com/techsupp/

Select your country or language under Global Support.

Customer Service is available to assist with the following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade insurance and maintenance contracts

■ Information about the Symantec Value License Program

www.symantec.com/techsupp/
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■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals

Maintenance agreement resources

If you want to contact Symantec regarding an existing maintenance agreement,

please contact the maintenance agreement administration team for your region

as follows:

■ Asia-Pacific and Japan: contractsadmin@symantec.com

■ Europe, Middle-East, and Africa: semea@symantec.com

■ North America and Latin America: supportsolutions@symantec.com

Additional Enterprise services

Symantec offers a comprehensive set of services that allow you to maximize your

investment in Symantec products and to develop your knowledge, expertise, and

global insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

These solutions provide early warning of cyber

attacks, comprehensive threat analysis, and

countermeasures to prevent attacks before they occur.

Symantec Early Warning Solutions

These services remove the burden of managing and

monitoring security devices and events, ensuring

rapid response to real threats.

Managed Security Services

Symantec Consulting Services provide on-site

technical expertise from Symantec and its trusted

partners. Symantec Consulting Services offer a variety

of prepackaged and customizable options that include

assessment, design, implementation, monitoring and

management capabilities, each focused on establishing

and maintaining the integrity and availability of your

IT resources.

Consulting Services

Educational Services provide a full array of technical

training, security education, security certification,

and awareness communication programs.

Educational Services

contractsadmin@symantec.com
semea@symantec.com
supportsolutions@symantec.com


To access more information about Enterprise services, please visit our Web site

at the following URL:

www.symantec.com

Select your country or language from the site index.

www.symantec.com
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Introducing Symantec

Backup Exec System

Recovery Manager

This chapter includes the following topics:

■ About Symantec Backup Exec System Recovery Manager

■ What is new and updated in this release

■ Components of Backup Exec System Recovery Manager

■ How Backup Exec System Recovery Manager works

■ What you can do with Backup Exec System Recovery Manager

■ Best practices for creating recovery points

■ Where to find more information

About Symantec Backup Exec System Recovery
Manager

Symantec Backup Exec System Recovery Manager is designed to work with the

following products to provide enterprise-level management tasks for server and

desktop protection and recovery:

■ Symantec Backup Exec™ System Recovery 8.0 and 7.0–Server Edition

■ Symantec Backup Exec™ System Recovery 8.0 and 7.0–Windows Small Business

Server Edition
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■ Symantec Backup Exec™ System Recovery 8.0 and 7.0–Desktop Edition

■ Symantec Backup Exec™ Retrieve 8.0 and 7.0

■ Symantec Backup Exec™ System Recovery Granular Restore 8.0 Option

(previously called Symantec Backup Exec™ System Recovery Exchange Retrieve

7.0 Option)

Using Backup Exec System Recovery Manager, you can centrally monitor the

recovery point status for Windows servers, desktops, and laptops across your

organization, all from a single console (you can install multiple instances of the

console). From the Home page, you can easily view the computers that are

protected, including job status. You can also perform remote system and drive

recovery of Windows computers.

What is new and updated in this release
Table 1-1 describes new and updated features in Backup Exec System Recovery

Manager.

Table 1-1 What is new and updated

DescriptionFeature

Symantec ThreatCon is Symantec's early threat warning system.

You can now configure backups to detect a change in the threat

level whenever managed computers are connected to the

Internet. When the threat level meets or exceeds the level you

specify, Backup Exec System Recovery automatically starts a

backup job. You can specify a different ThreatCon level for each

backup.

Symantec ThreatCon

Response

Backup Exec System Recovery and Backup Exec System Recovery

Manager console is designed to run on Windows Server 2008.

Windows Server® 2008

compatibility

Backup Exec System Recovery now supports NTFS partitions up

to 16TB (formatted with 4k clusters).

Support for NTFS

partitions

An administrator tool that lets you recover a Microsoft Exchange

user's mailbox, email folders, and email messages directly from

recovery points. You can also restore documents from Microsoft

SharePoint, or search and restore a version of a lost file using

the Files and Folders view. The Granular Restore Option works

with Backup Exec System Recovery.

See “Backup Exec System Recovery Manager optional tool”

on page 20.

Granular Restore Option

(previously called

Symantec Backup Exec

Exchange Retrieve

Option)

Introducing Symantec Backup Exec System Recovery Manager
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Table 1-1 What is new and updated (continued)

DescriptionFeature

Use Licensing in Backup Exec System Recovery Manager to

manage Backup Exec System Recovery product licenses and their

assignments throughout your organization.

Besides product licenses, you can also manage the Backup Exec

System Recovery Manager license from the console.

See “About managing licenses” on page 89.

License management

Components of Backup Exec System Recovery
Manager

An installation of Backup Exec System Recovery Manager consists of several main

components for managing recovery points on computers. It also gives you the

ability to create and update Easy Installers of Symantec Backup Exec System

Recovery (and other components, such as LightsOut Restore and Management

Control) on client computers.

Note: Backup Exec System Recovery Manager requires the installation of a

Symantec product key for full product activation.

Table 1-2 describes these main components.

Table 1-2 Components of Backup Exec System Recovery Manager

DescriptionComponent

The Backup Exec System Recovery Manager console, which can be installed

on any computer (Windows 2000 or later), lets you remotely run and

manage backup and recovery tasks on client computers from a central

location. It serves as the main interface to the Backup Exec System Recovery

Manager server. The console requires Microsoft .NET Framework 2.0 to

run.

See “About using the console” on page 41.

Backup Exec

System

Recovery

Manager

console

A dedicated Windows 2003 server class computer that provides the support

files that are needed to integrate with the console.

Among other things, the database that is installed on the server stores

backup jobs, client computer information, job history, recovery point

information, and configuration details.

Backup Exec

System

Recovery

Manager

server and

database
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Table 1-2 Components of Backup Exec SystemRecoveryManager (continued)

DescriptionComponent

Management Control is a necessary component of Backup Exec System

Recovery and must be installed on each computer that has backups you

want to manage.

Microsoft .NET Framework 2.0 must be installed on client computers prior

to the installation of Management Control.

This component publishes a variety of event information to the console

(by way of the server), such as the following:

■ The drives on the computer

■ A list of recovery points and their storage locations

■ Backups assigned to the computer

■ License status

■ Backup Exec System Recovery version

■ Management Control version

■ Any configuration changes that are made to the computer

Management Control periodically reads the Backup Exec System Recovery

Manager database on the server and pulls down jobs or licenses as needed

by the client computer.

If Symantec Backup Exec System Recovery is already installed on a

computer, you can install or update the Management Control component

separately.

A computer is considered "managed" by Backup Exec System Recovery

Manager when Management Control is installed on it.

See “About adding computers to the console” on page 55.

Management

Control
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Table 1-2 Components of Backup Exec SystemRecoveryManager (continued)

DescriptionComponent

Backup Exec System Recovery Manager lets you create and update Easy

Installers. Easy Installers are used to deploy software such as Symantec

Backup Exec System Recovery and Management Control to one or more

computers across your local area network or wide area network.

Backup Exec System Recovery Manager ships with several Easy Installers

including the following:

■ Backup Exec System Recovery 8.0 (with and without a user interface)

■ Management Control 8.0

■ Indexing Server (optional; for Windows Server 2003 only)

Easy Installers are made available through the Backup Exec System

Recovery Download Center Web page. The Web page location is

https://<server_name or IP_address>:8443/DownloadCenter. This

page gets created when you install Backup Exec System Recovery Manager.

Users access the Web page to download and install the software onto the

computer. Or, you can deploy the software onto client computers through

a logon script.

See “About adding computers to the console” on page 55.

Easy

Installers

Backup Exec Retrieve is installed at the same time you install the Backup

Exec System Recovery Manager server.

Backup Exec Retrieve communicates with the Indexing Server component

on client computers to let users recover their own files from the Backup

Exec Retrieve Web page.

Backup Exec

Retrieve

The Indexing Server maintains a folder of files that allow users to search

file names, file versions, and recent activity for recovery by way of the

Backup Exec Retrieve Web page. The service is an optional feature that

can be installed on Windows Server 2003 by way of an Easy Installer. The

Indexing Server includes an index control component that communicates

with Backup Exec System Recovery Manager and adds the indexer to the

database.

You must enable indexing support in a backup job and a backup destination

in order for remote users to take advantage of file retrieval.

Note: Backup Exec System Recovery must be installed on client computers

prior to installing Indexing Server.

See “About configuring Backup Exec Retrieve” on page 96.

Indexing

Server
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Table 1-2 Components of Backup Exec SystemRecoveryManager (continued)

DescriptionComponent

LiveUpdate is the Symantec technology that lets any installed Symantec

products connect to a Symantec server automatically and receive program

and virus definition updates.

This ensures that you have the most current software updates associated

with your version of the Backup Exec System Recovery Manager console.

LiveUpdate

Backup Exec System Recovery Manager optional tool

You can purchase the Symantec Backup Exec System Recovery Granular Restore

Option for your Backup Exec System Recovery Manager configuration. This option

provides fast and flexible recovery of Microsoft Exchange mailboxes, folders, and

individual messages, Microsoft SharePoint documents, and unstructured files

and folders.

Note: Backup Exec System Recovery must be installed on the client computer

prior to installing the Granular Restore Option.

When the Granular Restore Option is installed, a link to the software is added to

the Backup Exec System Recovery Manager console from the Manage page, under

Services.

You can use Backup Exec System Recovery Manager to create a package of the

Granular Restore Option, and then use the package to create an Easy Installer for

download or deployment.

See Symantec BackupExec SystemRecoveryGranularRestoreOptionUser's Guide

for more information.

How Backup Exec System Recovery Manager works
In Backup Exec System Recovery Manager, backup, recovery, convert to virtual,

and delete recovery point operations, called jobs, are submitted through the

console and stored in the database. Client computers pull the jobs down from the

server and process them. Administrators can run the console from the Backup

Exec System Recovery Manager server, or from a remote system. After jobs are

created, they are processed by the Backup Exec System Recovery Manager

components on the server. All interaction to the Backup Exec System Recovery

Manager system, such as submitting jobs, viewing results, and working with Easy

Installers, can be done through the console.

Introducing Symantec Backup Exec System Recovery Manager
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Figure 1-1 illustrates how the components work together to provide complete

backup and recovery functionality to an entire network.

Figure 1-1 How Backup Exec System Recovery Manager works

Through the console, you can create a one-time job, such as recovering a drive on

a client computer, or you can schedule recurring jobs, such as daily backup jobs.

Wizards guide you through most Backup Exec System Recovery Manager

operations such as the creation of backup jobs, recovery jobs, or Easy Installers,

and the conversion of recovery points to virtual disks.

You can view a job’s current progress from the Monitor page or the Manage page.

Through Backup Exec System Recovery Manager's management functions, you

can logically group client computers together to simplify the back up process. On

the Manage page, you can organize, track, and troubleshoot all of the computers

whose backups you are managing. You can view the backup status and statistics

for servers and desktops, including failed jobs.
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After a job has been processed, the job’s results are stored in the database. Log

files, if configured in the console by the administrator, are uploaded to the server

to tell you what happened during the processing of the job (events, errors, and so

forth).

What you can do with Backup Exec System Recovery
Manager

Backup Exec System Recovery Manager lets you work from a remote location to

back up and recover Windows-based computers, convert recovery points to virtual

disks, and manage recovery points.

Table 1-3 describes the most frequently used tasks.

Table 1-3 What you can do with Backup Exec System Recovery Manager

DescriptionTask

■ Define daily, weekly, monthly, or quarterly backup jobs, and assign

them to one or more computers

■ Create full independent recovery points or recovery point sets with

incrementals

■ Define recovery point destinations on a network share or on a local

drive on the client computer

■ Use your existing installation of Symantec Backup Exec™ for

Windows Servers to back up recovery point storage locations on a

network to tape media

Define backups

and recovery

point storage

locations

■ Allow users to retrieve their own files and folders using the Backup

Exec Retrieve Web page

■ Retrieve email, folders, entire mailboxes, SharePoint documents,

or lost files and folders using the Backup Exec Granular Restore

Option

■ Remotely recover a data drive on a client computer

■ Remotely recover a system drive on a client computer that is

bootable, using LightsOut Restore

Recover files,

folders, or entire

drives

■ Convert recovery points of a physical computer to a VMware Virtual

Disk (.vmdk)

■ Convert recovery points of a physical computer to a Microsoft

Virtual Disk (.vhd)

Convert recovery

points to virtual

disks

■ Delete entire recovery point sets

■ Delete recovery points within a set

Remotely delete

recovery points
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Table 1-3 What you can do with Backup Exec System Recovery Manager

(continued)

DescriptionTask

■ Troubleshoot and resolve jobs remotely

■ Build and deploy Easy Installers to install Backup Exec System

Recovery products and options such as LightsOut Restore and

Backup Exec Granular Restore Option

■ Monitor the overall status of recovery points for an entire network

of Windows computers

Remotely

administer

server, desktop,

and laptop

computers

remotely

Best practices for creating recovery points
The following list represents some best practices for creating recovery points:

■ Before a backup

■ During a backup

■ After a backup

Before a backup

Table 1-4 describes best practices to ensure the successful creation of recovery

points.

Table 1-4 Before a backup

DescriptionBefore abackup

Computers must be turned on and Windows must be running at the

time a backup occurs. If the computer remains off after being polled

six times, the computer is put into a "Needs attention" state. However,

if Backup Exec System Recovery (with a user interface) is installed on

the client computer, Backup Exec System Recovery asks the user if they

want to run the missed backup (after the computer is turned on and

they log on to Windows). In the meantime, the backup status of the

client computer in Backup Exec System Recovery Manager console is

"Needs Attention".

Schedule backups

when you know

computers are

turned on

This practice helps speed the creation of recovery points and reduce

the amount of information that needs to be restored.

Where possible,

separate the

operating system

from the business

data
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Table 1-4 Before a backup (continued)

DescriptionBefore abackup

You should store recovery points to a network share or to a hard disk

on the client computer other than the primary hard disk C. This practice

helps ensure that you can recover the system in the event that the

client's primary hard disk fails.

Use a network

destination or a

secondary hard

disk on the client

computer as the

recovery point

storage location

When you use the console to create recovery points of computers across

one or more time zones, the backup runs on the day and local time

where the client computer is physically located. For example, suppose

a client computer's physical location is 2 hours ahead of the Backup

Exec System Recovery Manager console time. You create a backup job

to run at 6:00 p.m.. When the backup job begins on the client computer

it is 6:00 p.m. However, the console displays the job as beginning at

4:00 p.m..

Understand how

backups are run

on computers

that may be in

different time

zones

By defining recovery point destinations that are separated from backups

and computers, you can easily see how many computers are backed up

to a given location and optimize network load balancing during a

backup.

Use defined

recovery point

destinations

Use the Assign New Backup Job Wizard to schedule the consistent

creation of recovery points. Use the Configure Backup Exec Job Wizard

to schedule the backup of recovery point storage locations to tape

media.

Create recovery

points often and

regularly

Backup Exec System Recovery Manager supports saving recovery points

to network locations or to a local hard disk.

You should avoid storing recovery points on the Backup Exec System

Recovery Manager server because as the number or size of recovery

points grows, you have less disk space available for regular server use.

When you save recovery points to a separate drive, network location,

or removable media, you eliminate this problem.

Save recovery

points to the

proper location

During a backup

While a backup is running, consider the following best practice:

■ Improve client computer performance during a backup.

Backup Exec System Recovery requires significant system resources to run a

backup. If remote users are working at their computers when a backup starts,

they might notice that the performance of their computer slows down. If
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slowing occurs, you can reduce the speed of the backup to improve client

computer performance.

See “Setting client options for computers” on page 153.

After a backup

Table 1-5 describes best practices after a backup occurs.

Table 1-5 After a backup

DescriptionAfter a backup

Store recovery points on the network and create CDs, DVDs, or tapes

of recovery points for storage off-site in a safe, secure place.

Use Symantec Backup Exec for Windows Servers to back up recovery

point locations on the network.

Maintain duplicate

recovery points for

safety.

Where possible, document and test your entire recovery process by

doing a restore of recovery points (using the Backup Exec System

Recovery console) and single files (using the Recovery Point Browser

in Backup Exec System Recovery or Backup Exec Retrieve) on the

original client computer where the recovery points were created.

Doing so can uncover potential hardware or software problems.

Enable the Verify recovery point after creation feature when you

create a backup job.

Use the Convert to Virtual feature to test and evaluate restored

recovery points.

Verify that

recovery points or

recovery point sets

are stable and

usable.

Delete incremental recovery points to reduce the number of files you

have to maintain. This strategy also uses hard disk space more

efficiently.

Manage storage

space by deleting

old backup data.

Periodically review the contents and events in the Error Jobs dialog

box and on the Home page to ensure stability in the computer system.

You should also review log files periodically.

Review

information in the

Error Jobs dialog

box and on the

Home page .

Ensure that you back up essential data by periodically reviewing the

contents of recovery points files with Backup Exec Retrieve or the

Recovery Point Browser in Backup Exec System Recovery.

Review the

contents of

recovery points.
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Where to find more information
This product's documentation includes an Implementation Guide (sbesrm.pdf)

and readme file on the Backup Exec System Recovery Manager product CD, a

printed Getting Started Guide, and online Help available from within the console.

In addition to the product documentation, check the Symantec Web site and the

Knowledge Base for answers to frequently asked questions, troubleshooting tips,

online tutorials, and the latest product information. On the Internet, go to:

www.symantec.com/techsupp/

Note: Viewing the online manuals requires Acrobat Reader 5.0 or later.

Introducing Symantec Backup Exec System Recovery Manager
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Installing Backup Exec

System Recovery Manager

This chapter includes the following topics:

■ Preparing for installation

■ About installing the product

■ Post-installation tasks

■ Uninstalling Backup Exec System Recovery Manager

Preparing for installation
Installation procedures might vary, depending on your work environment and

how you want to install the Backup Exec System Recovery Manager console and

server. You can install the Backup Exec System Recovery Manager console and

server on the same computer, or customize the installation by installing the

console and server on separate computers.

You can have multiple installations of the console in a network domain (or across

network domains if the correct ports are set up), and you can run one or more

instances of the console at a time within the domain.

Before you install the product, make sure your computer meets the system

requirements. Review the Readme file on the installation CD for any known issues.

Note: Installation of the product is not supported on encrypted file systems.
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System requirements for Backup Exec System Recovery Manager

To install and use this product, your computer must meet the minimum

requirements that are described in Table 2-1.

Table 2-1 Minimum system requirements

RequirementsComponent

Pentium 3: 1 GHz or higher (Pentium 4: 3.0 GHz or higher recommended)Processor

See “Supported Windows operating systems” on page 28.Operating

system

The memory requirements for the two main components are as follows:

■ Backup Exec System Recovery Manager server: 1 GB

■ Backup Exec System Recovery Manager console: Dependent on the

operating system

RAM

The hard disk space requirements for each component are as follows:

■ Backup Exec System Recovery Manager console: 100 MB

■ Backup Exec System Recovery Manager server: 750 MB

■ Backup Exec Retrieve: 15 MB

■ Microsoft .NET Framework 2.0: 280 MB (32-bit computers); 610 MB

(64-bit computers)

■ Storage space on the network for the recovery points

Available hard

disk space

Microsoft .NET Framework 2.0 is required to run Backup Exec System

Recovery Manager and Backup Exec System Recovery on client computers.

When you start the Backup Exec System Recovery Manager console for

the first time, .NET is automatically installed if it does not already exist

or an older version exists. However, it does not get installed when Backup

Exec System Recovery is installed on client computers.

Note:Microsoft .NET Framework 2.0 must be installed on client computers

before you install Management Control.

Software

Supported Windows operating systems

Table 2-2 describes the supported Windows operating systems for Backup Exec

System Recovery Manager console and server installations. For security reasons,

the Backup Exec System Recovery Manager server must be installed on a dedicated

Windows 2003 server class computer with an NTFS-formatted hard disk.
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Table 2-2 Supported Windows operating systems for console and server

installations

ServerConsoleOperating system (with minimum service

pack)

XWindows Vista Home Basic

XWindows Vista Home Premium

XWindows Vista Ultimate

XWindows Vista Business

XWindows Server 2008

XWindows Small Business Server 2005

XXWindows Server 2003 x64 Editions (SP 1)

XXWindows Server 2003 R2 Editions (SP 1)

XXWindows Small Business Server 2003 (SP 1)

XXWindows Server 2003 (SP 1)

XXWindows Small Business Server 2003 (SP 1)

XWindows Advanced Server 2000 (SP 4)

XWindows Server 2000 (SP 4) and Update Rollup

1 for SP 4

XWindows Small Business Server 2000 (SP 4)

XWindows XP Professional x64 Edition (SP 2 or

later)

XWindows XP Professional (SP 2 or later)

XWindows Professional 2000 (SP 4)

Migration from Symantec LiveState Recovery Manager

Backup Exec System Recovery Manager does not support the migration of any

version of LiveState Recovery Manager.

If you are currently running any version of LiveState Recovery Manager with

LiveState Recovery on client computers, you should first uninstall all LiveState

Recovery clients. You should then uninstall the LiveState Recovery Manager

console and server. No legacy data or backup jobs are preserved.
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Note: If a user uninstalls LiveState Recovery and chooses to keep their backup

history and jobs, Backup Exec System Recovery Manager creates new backup jobs

in the database (based on the user's old backup jobs) when their computer becomes

managed.

Refer to the Symantec LiveState Recovery Manager Implementation Guide for

uninstall instructions.

Supported virtual disk programs

You can use Backup Exec System Recovery Manager to convert recovery points

of a physical computer to a VMWare Virtual Disk (.vmdk) or a Microsoft Virtual

Disk (.vhd).

See “Converting recovery points to virtual disks” on page 133.

Virtual disks created from recovery points are supported on the following

platforms:

■ VMware GSX Server 3.1 and 3.2

■ VMware Server 1.0

■ VMware ESX Server 2.5 and 3.0

■ VMware Infrastructure 3

■ Microsoft Virtual Server 2005 R2

System requirements for packages

Packages of Backup Exec System Recovery can be installed with an Easy Installer

on a variety of Windows operating systems.

Note: The specific hardware requirements for packages vary depending on the

package contents. Refer to Backup Exec System Recovery product documentation

for complete system requirements.

This product supports up to 1000 installations of Backup Exec System Recovery

for each installation of Backup Exec System Recovery Manager. However, because

network performance varies greatly among organizations, the total number of

supported installations of Backup Exec System Recovery may be more or less for

your network. Network performance should be monitored to ensure that

installations of Backup Exec System Recovery are not extended beyond the capacity

and capability of your network.
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Backup Exec System Recovery Manager comes with several packages for use in

Easy Installers, including the following products:

■ Backup Exec System Recovery

■ Management Control

■ Indexing Server

If you want to a create a package of LightsOut Restore , you need the Symantec

Recovery Disk. LightsOut Restore requires 500 MB of hard disk space on the client

computer. If you want to create a package of Backup Exec Granular Restore Option,

you need to purchase the product.

See “Creating packages for an Easy Installer ” on page 56.

Backup Exec System Recovery–Server Edition and –Windows
Small Business Server Edition

Table 2-3 describes the supported install packages of Backup Exec System

Recovery–Server Edition and Backup Exec System Recovery–Windows Small

Business Server Edition on Windows operating systems.

Table 2-3 Supported install packages on Windows operating systems

Without user interfaceWith user interfaceOperating system

XXWindows Server 2008

XXWindows Vista Business

XXWindows Server 2003

XXWindows Small Business

Server 2003

XXWindows 2000 Advanced

Server (SP 4 or later)

XXWindows 2000 Server (SP 4

or later)

XXWindows 2000 Small

Business Server

Backup Exec System Recovery-Desktop Edition

Table 2-4 describes the supported install packages of Backup Exec System

Recovery–Desktop Edition on Windows operating systems.
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Table 2-4 Supported install packages on Windows operating systems

Without user interfaceWith user interfaceOperating system

XXWindows Vista Ultimate

XXWindows XP Professional

x64 Edition (SP 2 or later)

XXWindows XP Professional (SP

2 or later)

XXWindows Professional 2000

(SP 4 or later)

Upgrading from existing installations of Backup Exec SystemRecovery
6.5

Backup Exec System Recovery Manager 8.0 does not support the backup

management of existing installations of Backup Exec System Recovery 6.5 on

client computers. Instead, you must upgrade Backup Exec System Recovery 6.5

to version 7.0 or 8.0.

See “About adding computers to the console” on page 55.

Compatibility and integrationwith Symantec Backup Exec forWindows
Servers

Backup Exec System Recovery Manager includes the Configure Backup Exec Job

Wizard. This wizard is a finite version of the full Backup Job Properties dialog box

that is found in Symantec Backup Exec™ 11d for Windows Servers and Symantec

Backup Exec 10d for Windows Servers.

By tapping into your existing installation of Backup Exec, you can use Backup

Exec System Recovery Manager to back up network-stored recovery points directly

to media.

See “Configuring a Backup Exec for Windows Servers backup job” on page 135.

User rights requirements

Users on Windows Vista/XP/Server 2008/2003 Server/2000 must have

administrator rights to install and use Backup Exec System Recovery Manager,

or to deploy Easy Installers of Backup Exec System Recovery.
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60-day trial version

If you install the 60-day trial of Backup Exec System Recovery Manager, you can

install Backup Exec System Recovery and create recovery points of system and

data volumes for up to 10 computers.

With the trial version, you also have access to the Symantec Support Knowledge

Base. This searchable database includes software library files, frequently asked

questions, customer-to-customer news groups, and additional technical

information.

The Backup Exec System Recovery Manager trial expires 60 days after your first

use of the software. At that time, you can upgrade to the full version (even after

the trial expiration). Or, you can continue to use the Backup Exec System Recovery

Manager console, but only to remove computers from the Manage page.

About installing the product
The Backup Exec System Recovery Manager installation program checks for the

required software and hardware resources, lets you select the installation folder,

updates registry settings, and then copies the required files to the hard disk. The

console installation program copies the .NET Framework 2.0 files to the hard

drive. When you run the console for the first time, you may be prompted to install

.NET if it is not already installed or a previous version of .NET exists.

See “Installing the Backup Exec System Recovery Manager server” on page 33.

See “Installing the Backup Exec System Recovery Manager console” on page 35.

Installing the Backup Exec System Recovery Manager server

Before you begin, you should review the requirements for installing the Backup

Exec System Recovery Manager server.

See “System requirements for Backup Exec System Recovery Manager” on page 28.

If you install the Backup Exec System Recovery Manager server into a new

environment where Backup Exec System Recovery does not exist, the installation

creates a new database structure for storing data about computers and jobs.

Note: Following the installation of the server, you may need to reconfigure TCP/IP

port numbers to enable successful communication with Backup Exec System

Recovery Manager.

See “Configuring TCP/IP ports for a new installation of Backup Exec System

Recovery Manager” on page 175.
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Warning: For security reasons, the Backup Exec System Recovery Manager server

must be installed on a dedicated Windows 2003 server class computer with an

NTFS-formatted hard disk.

It is recommended that the Backup Exec System Recovery Manager server be

assigned a static IP address after you install the server. This avoids the problem

where dynamic DNS service is either limited or unavailable which can cause

bi-directional communication problems between the Management Control

component on the client computer and the Backup Exec System Recovery Manager

server.

To install the Backup Exec System Recovery Manager server

1 Insert the Backup Exec System Recovery Manager product CD into the media

drive of the server computer.

■ If CD auto-run is enabled, the install browser window is displayed.

■ If the CD auto-run is not enabled, on the Windows taskbar, click Start >

Run, type drive:\autorun (where drive is the drive letter of your media

drive), and then click OK.

If you are running Windows Vista and the Run option is not visible, do

the following:

■ Right-click the Start button, and then click Properties.

■ On the Start Menu tab, click Customize.

■ Scroll down and check Run command.

■ Click OK twice.

■ On the Windows taskbar, click Start >Run, type drive:\autorun

(where drive is the drive letter of your media drive), and then click OK

2 Click Install Backup Exec SystemRecoveryManager.

3 Read the license agreement, and then click I accept the terms in the license

agreement.

4 Click Next.

5 Do one of the following:.

■ Click Complete to install the server and console on the same computer

and to the default installation path. Click Next and then go to step 8.

■ Click Custom, and then click Next. Go to the next step.
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6 On the Manager Console drop-down list, select This featurewill not be

available. This ensures that the console is not installed. (You can optionally

install the console if you want.)

7 Do one of the following:

■ To install Backup Exec System Recovery Manager server in the default

folder path, click Next.

■ To change the default folder path, click Change, locate the folder in which

you want to install the server, and then click OK. Click Next.

8 Specify the user name and password for the server.

This password is used to access the server when you log on to the console.

The password cannot contain the following three special characters: '

(apostrophe), " (quotation mark), or \ (backslash).

You cannot access the server through the console if you do not enter the

password correctly, or you forget the password. In such cases, you must

uninstall, and then reinstall the software. Store the password in a secure

place; Symantec has no method for restoring a password to the server.

This account grants full privileges inside the console and is known as the

System Admin role. When you log on to the console as the System Admin,

you can set up other role-based user accounts with varying levels of privileges.

9 Click Next.

10 Click Install to begin installing the Backup Exec System Recovery Manager

server.

11 Click Finish at the conclusion of the installation.

12 Click Exit to close the Installation Wizard.

Installing the Backup Exec System Recovery Manager console

Before you begin, you should review the requirements for installing the Backup

Exec System Recovery Manager console.

See “System requirements for Backup Exec System Recovery Manager” on page 28.

Note: Backup Exec System Recovery Manager console does not require the

installation of a product key for full activation.

See “60-day trial version” on page 33.

You can install the console anywhere in your enterprise where you need access

to the Backup Exec System Recovery Manager server and database. You can have
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multiple installations of the console in a network domain, and you can run one

or more instances of the console at a time within the domain (or across network

domains if the correct ports are set).

To install the Backup Exec System Recovery Manager console

1 Insert the Backup Exec System Recovery Manager product CD into the media

drive of the console computer.

■ If CD auto-run is enabled, the install browser window is displayed.

■ If the CD auto-run is not enabled, on the Windows taskbar, click Start >

Run, type drive:\autorun (where drive is the drive letter of your media

drive), and then click OK.

If you are running Windows Vista and the Run option is not visible, do

the following:

■ Right-click the Start button, and then click Properties.

■ On the Start Menu tab, click Customize.

■ Scroll down and check Run command.

■ Click OK twice.

■ On the Windows taskbar, click Start >Run, type drive:\autorun

(where drive is the drive letter of your media drive), and then click OK

2 Click Install SystemRecoveryManager .

3 Read the license agreement, click Iacceptthetermsofthelicenseagreement,

and then click Next.

4 Do one of the following:

Click Install to begin installing the

console.

If you are installing the console on

Windows Vista, Windows XP, or Windows

Professional 2000

◆ Do one of the following:

■ ClickCustom and then clickNext.

On the Manager Server

drop-down list, clickThis feature

will not be available, and then

click Next.

■ Click Console Only.

◆ Click Install to begin installing the

console.

If you are installing the console on a

supported Windows server
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5 When the installation is complete, check Launch Symantec Backup Exec

SystemRecoveryManager console if you want to start the console after

closing the wizard.

6 Click Finish.

If you unchecked the optionLaunchSymantecBackupExecSystemRecovery

Manager console, you are finished.

If you chose to launch the console after closing the installation wizard, you

may be prompted to install Microsoft .NET Framework 2.0 if it does not exist

on the computer or a previous version is installed.

7 Click Yes, and then follow the on-screen prompts to install Microsoft .NET

Framework 2.0.

Post-installation tasks
Some of the post-installation tasks to get you started include the following:

■ See “Starting Backup Exec System Recovery Manager ” on page 41.

■ See “Editing server and client settings” on page 84.

■ See “About adding computers to the console” on page 55.

■ See “Updating the Backup Exec System Recovery Manager console” on page 53.

■ See “Creating a backup job” on page 103.

Uninstalling Backup Exec System Recovery Manager
You can uninstall the Backup Exec System Recovery Manager. The uninstallation

program removes the files and registry settings that it copied to the computer's

hard disk during installation.

You uninstall the product through the Add or Remove Programs option in the

Windows Control Panel. After the removal process begins, you cannot cancel it.

Backup Exec System Recovery Manager automatically deletes product files and

program shortcuts on the Windows Start menu.

If you uninstall Backup Exec System Recovery Manager where the server is located,

be aware that Backup Exec System Recovery is not uninstalled from any client

computers that you have added to the console. Therefore, to uninstall Backup

Exec System Recovery, you should first remove the client computer from the

console. Management Control is "turned off" on the client computer so it no longer

communicates with Backup Exec System Recovery Manager. You can then use
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Windows Add or Remove Programs on the client computer itself to uninstall

Backup Exec System Recovery.

See “Removing computers from the console” on page 75.

Uninstalling the Backup Exec System Recovery Manager console

When you uninstall the Backup Exec System Recovery Manager console, product

files are automatically deleted, including program shortcuts on the Windows Start

menu.

If you do not uninstall Backup Exec System Recovery Manager where the server

is located, any computers, computer groups, jobs, or job categories that you have

added to the console remain in the Backup Exec System Recovery Manager

database. If you decide to reinstall the console later, the computers, groups,

recovery point storage locations, and jobs in the database re-populate the console

interface.

To uninstall the Backup Exec System Recovery Manager console

1 From the computer where the console is installed, do one of the following:

■ On the Windows taskbar, click Start > Settings > Control Panel >Add or

Remove Programs.

■ On the Windows Vista taskbar, click Start > Control Panel > Programs

and Features >Uninstall or Change a Program.

2 Click Symantec Backup Exec SystemRecoveryManager.

3 Click Remove (Uninstall on Windows Vista).

4 Click Yes to begin the uninstallation.

Uninstalling the Backup Exec System Recovery Manager server

If you uninstall Backup Exec System Recovery Manager where the server is located,

be aware that Backup Exec System Recovery is not uninstalled from any client

computers that you have added to the console. Therefore, to uninstall Backup

Exec System Recovery, you should first remove the client computer from the

console. Management Control is "turned off" on the client computer so it no longer

communicates with Backup Exec System Recovery Manager. You can then use

Windows Add or Remove Programs on the client computer itself to uninstall

Backup Exec System Recovery.

See “Removing computers from the console” on page 75.

To uninstall the Backup Exec System Recovery Manager server

1 From the computer where the server is installed, do one of the following:
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On the Windows taskbar, click Start > Settings > Control Panel >Add or

Remove Programs.

■

■ On the Windows Vista taskbar, click Start > Control Panel > Programs

and Features >Uninstall or Change a Program.

2 Click Symantec Backup Exec SystemRecoveryManager.

3 Click Remove (Uninstall on Windows Vista).

4 Click Yes to begin the uninstallation.
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Using the Backup Exec

System Recovery Manager

console

This chapter includes the following topics:

■ About using the console

■ Using the Drag-and-drop Workspace

■ Updating the Backup Exec System Recovery Manager console

■ Sending feedback

■ Where to go from here

About using the console
If you are new to using Backup Exec System Recovery Manager, you should first

review this information before adding computers to the console or deploying

backups and other jobs.

From the console you can create and deploy backups from your workstation, delete

recovery points, recover a computer, and convert recovery points to virtual disks.

You can view various reports and the complete status of all jobs that are running

on the computers that you manage.

Starting Backup Exec System Recovery Manager

You start the console from the Windows Start menu.
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During the installation of the Backup Exec System Recovery Manager server, you

had to specify an administrator account password. When you start the console,

you must type the correct user name, password, and server name (or IP address

of the server) to access the server through the console's interface.

To start Backup Exec System Recovery Manager

1 Do one of the following:

■ On the classic Windows taskbar, click Start > Programs > Symantec >

BackupExecSystemRecovery>SymantecBackupExecSystemRecovery

Manager.

■ On the Windows Vista, Windows XP, or Windows 2003 taskbar, click Start

>All Programs>Symantec>BackupExecSystemRecovery>Symantec

Backup Exec SystemRecoveryManager.

If you are starting the console for the first time, you may be prompted to

install Microsoft .NET Framework 2.0 if it does not exist on the computer or

you have a previous version of .NET.

2 Click Yes and follow the on-screen prompts to install Microsoft .NET

Framework 2.0. Otherwise, skip to the next step.

3 Type the user name and password to the console.

4 In the Log on to text box, type the computer name or IP address of the Backup

Exec System Recovery Manager server.

5 Click OK.

6 If this is your first log on to the server, click OK, and then click Yes to install

the certificate of authority. Otherwise, skip to the next step.

7 Do one of the following:

■ If you are logging on to a trial version of the software, enter the product

key and then click Activate to activate the Backup Exec System Recovery

Manager server.

■ Click Later to activate the Backup Exec System Recovery Manager server

later on and continue using the trial version.

Exiting Backup Exec System Recovery Manager

When you exit Backup Exec System Recovery Manager, the console is closed and

you are returned to the Windows desktop. Any jobs you have deployed to computers

continue to function as usual.

Using the Backup Exec System Recovery Manager console
About using the console

42



To exit Backup Exec System Recovery Manager

1 On the File menu of the console, click Exit.

2 Click Yes.

Logging off from the server

When you log off, the console is closed and the Backup Exec System Recovery

Manager log on dialog box is displayed. Any jobs you have deployed to computers

continue to function as usual.

To log off from the server

1 On the File menu of the console, click Log off.

2 Click Yes.

Changing console passwords

You must be logged on in the role of System Admin to change your console

password or the console passwords of other users. Users who are not logged on

in the role of System Admin can change their own password. Passwords are

case-sensitive.

Note: You cannot access the Backup Exec System Recovery Manager server by

way of the console if you do not enter the correct password, or you forget the

password. (In such cases, you must uninstall, and then reinstall the console and

the server software.) Store the password in a secure place; Symantec has no method

for restoring a password to the server.

See “About managing roles-based user accounts” on page 86.

To change your own console password

1 Verify that you are already logged on to the console in the role of System

Admin.

2 On the Tools menu, click Change Password.

3 Type the password that you want to change in the Old password text box.

4 Type the new password in the New password and Confirm password text

boxes.

5 Click OK.
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To change the console passwords of other users

1 Verify that you are already logged on to the console in the role of System

Admin.

2 On the Tools menu, click Options >Users.

3 On the right pane, select a user name.

4 On the toolbar, click Edit.

5 Type the new password in the Password and ConfirmPassword text boxes.

6 Click OK.

7 Click Close.

About the console views

The console consists of the following five main views where you do your work:

■ Home page

■ Manage page

■ Monitor page

■ Reports page

■ Shortcuts page

Home page

The Home page is the default view each time you log on to the console. It is always

available as a tab in the left pane of the console window.

The Home page provides a visual overall status of servers and desktops that may

or may not be protected by Backup Exec System Recovery. Actual data regarding

computer or server incidents populates this page.

Table 3-1 describes the information available from the Home page.
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Table 3-1 Home page information

DescriptionPane

name

The Status pie chart shows the proportions of certain current status types for

all recovery-enabled servers or desktops. A computer is considered

recovery-enabled if is has Backup Exec System Recovery and Management

Control installed on it.

You can click the drop-down list button in the upper-right corner of this pane

to select a status type or to print the chart.

You can also click a pie slice in the chart to open a corresponding tab on the

Manage page for a detailed view. You can refine the details further by using

the Filter bar above the table.

See “Changing pane details” on page 51.

Status

Computer status types include the following:

■ Backed up: The number of all managed computers, servers, or desktops,

that have made a recovery point of all drives in the last 30 days and have

not missed the last scheduled back up. Computer can be considered "Backed

up" without having an assigned backup job as long as one or more recovery

points have been created within the last 30 days. A backed up drive can be

fully recovered.

■ Needs Attention: The number of all managed computers, servers, or desktops

that have a backup job assigned but it has not been run for a long time, or

it has missed the last scheduled backup (meaning that existing recovery

points are probably old). A computer drive that needs attention can be

recovered, but if the recovery points are older, it will not contain the latest

versions of files or folders.

■ At Risk: The number of all managed computers, servers, or desktops that

have no recovery points available from which to recover the drives.

A computer at risk cannot be recovered.

The License pie chart shows the proportions of licenses for all managed

computers. License status types include the following:

■ License: The number of all managed computer that have a current license

assigned.

■ Not Licensed: The number of all managed computers that have a trial version

of Backup Exec System Recovery installed but the trial license has expired,

or an installation of Backup Exec System Recovery exists but no license has

been activated.

■ Trial License: The number of all managed computers that have a trial version

of Backup Exec System Recovery installed.
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Table 3-1 Home page information (continued)

DescriptionPane

name

The Statistics pie chart shows a summary of all of the managed computers.

The computers are sorted by servers, desktops, and operating systems. You

can click the drop-down list button in the upper-right corner of this pane to

select a statistic type or to print the chart.

See “Printing a chart on the Home page” on page 48.

You can also click a pie slice in the chart to open a corresponding tab in Manage

for a detailed view. You can further refine the details by using the Filter bar

above the table.

See “Changing pane details” on page 51.

Statistics

Computer statistics include the following:

■ Server and Desktop: The number of managed server and desktop computers.

■ Server Operating System: The number of managed server computers that

are running a particular version of Windows.

■ Desktop Operating System: The number of managed desktop computers

that are running a particular version of Windows.

Displays the current state of all server and all desktop computers under the

management of Backup Exec System Recovery Manager.

Click the drop-down list button in the upper-right corner of this pane to select

filtering options or to print the chart.

You can click a bar in the Hot Spot bar chart to open a corresponding view.

This view can help you further troubleshoot problems. For example, depending

on the view, you can show Management Control and Event log files or retry a

backup. Or, you can request updated information from selected client

computers. Over time, the console gets populated with any new information

as computers respond.

Hot Spots
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Table 3-1 Home page information (continued)

DescriptionPane

name

Hot Spot data types include the following displays:

■ Backup Failures: The number of managed server and desktop computers

that have backup failures.

Backup failures can be caused by running out of hard disk space at the

recovery point storage location, or if the backup is unable to connect to the

specified recovery point storage location (usually a non-local storage

location).

■ Recovery Failures: The number of managed servers and desktops that have

failed recovery jobs.

■ Conversion Failures: The number of managed servers and desktops that

have failed convert to virtual jobs.

■ Deletion Failures: The number of managed servers and desktops that

attempted to delete incremental recovery points but failed.

■ Not Reporting: The number of managed servers and desktops that have not

reported back to the Backup Exec System Recovery Manager server within

a set time interval.

A computer is considered not responding if the client computer has an

assigned backup job and the server has not heard from the computer at the

next scheduled recovery point creation time (which is six times the default

Management Control polling interval as set in Client Options). This error

is often caused by network connectivity issues, like the computer or laptop

not being connected to the network or being turned off.

See “Setting client options for computers” on page 153.

See “About monitoring computers” on page 159.

Displays a line chart that shows the number of computers that have had Backup

Exec System Recovery events for a specified date range.

Trends

(historical)

Trend data types whose display you can turn on or off include the following:

■ Backup Failures

■ Recovery Failures

■ Conversion Failures

■ Deletion Failures

■ Not Reporting Failures

The line chart does not contain any hyperlinks.
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Table 3-1 Home page information (continued)

DescriptionPane

name

You can click the drop-down list button in the upper-right corner of this pane

to do the following:

■ Filter the chart data by servers, or desktops, or include all computers.

■ Select chart options, such as the types of data to display, and the date range

for confining the data to a specified period of time.

■ Print the chart on the default printer.

Printing a chart on the Home page

You can print each chart on the Home page on the default printer that is already

set up.

To print a chart on the Home page

1 On the Home page, do one of the following:

■ On the File menu, click Print > Status, Hot Spots, Statistics, or Trends.

■ Click the drop-down list in the upper-right corner of each chart pane, and

then click Print Chart.

2 Specify the print settings for the chart, and then click Print.

Manage page

The Manage page, available as a tab in the left pane of the console, is used to

display all the computers, computer groups, backup jobs, and recovery point

destinations that the Backup Exec System Recovery Manager server currently

manages.

It also serves as a launching point for additional services that may be installed

such as Backup Exec Retrieve, and Backup Exec Granular Restore Option.

From the Manage page you can do the following, among other things:

■ Create or edit backup jobs, backup destinations, and groups of computers

See “Creating a backup job” on page 103.

See “About managing recovery point destinations” on page 80.

See “About organizing groups of computers” on page 77.

■ Assign backup jobs to computers and groups

See “Assigning a backup job to computers or groups” on page 123.

■ Run a backup job on all assigned client computers or a single client computer

See “Running an existing backup job immediately” on page 124.
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■ Set client options such as communication ports and notifications for computers

or groups of computers

See “Setting client options for computers” on page 153.

■ Use a previously created recovery point to recover a data drive on a client

computer to a new or an existing data drive on the same computer

See “About recovering a drive” on page 139.

■ Convert recovery points to a VMWare Virtual Disk (.vmdk) or a Microsoft

Virtual Disk (.vhd)

See “Converting recovery points to virtual disks” on page 133.

■ Delete recovery points on a computer to use hard disk space more efficiently

See “About managing recovery points” on page 129.

■ View the progress of a job on computers as it occurs

■ Filter and sort computers, groups of computers, backup jobs, and backup

locations according to specific criteria that you select on the Filter bar above

the table

■ Assign licenses to activate installations of Backup Exec System Recovery on

computers, or unassign licenses

See “About managing licenses” on page 89.

■ View a computer's drive details (like the drive's used and free space, and

assigned backup jobs), recovery point history, or event details to verify that

Backup Exec System Recovery functions properly

See “Viewing the properties of a computer” on page 165.

■ Use the Drag-and-drop Workspace to simplify working with objects and tasks

in the multiple workspace environment of the Manage page

See “Using the Drag-and-drop Workspace” on page 52.

Monitor page

The Monitor page publishes status information regarding any jobs (such as

backups, recoveries, and conversions to virtual disks) that are currently running.

When a job is completed or cancelled, any computers that are associated with the

job are removed from the table on the Monitor page.

You can affect the published progress of a job by specifying a percentage interval.

For example, if you specified 10 (the default) in the Management Control panel

of Client Options, the job updates the console display after each 10 percent of the

job's completion on the client computer. You can also choose to have no job

progress published. In such cases, only an entry for the running job appears on

the Monitor page. When the job is finished, the entry is removed.
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See “Setting client options for computers” on page 153.

From this page you can do the following:

■ Cancel a job in progress. The Progress column in the table displays "Cancel

Requested".

■ View any pending jobs for a selected computer.

■ View the number of backup, recovery, deletion, or conversion errors on a

computer. When you select an error from the Errors drop-down list on the

Tool strip, a corresponding troubleshooting dialog box is displayed to help you

solve the problem.

■ Filter and sort computers or jobs according to specific criteria on the Filter

bar.

See “Changing pane details” on page 51.

See “Viewing the progress of jobs” on page 161.

Reports page

The Reports page includes a variety of pre-defined data reports that you can either

view in the right pane or export to the following file formats:

■ Microsoft Office Excel 2003 or later (.xls)

■ Comma-separated value (.csv)

■ HTML Web page

■ XML

See “Viewing reports” on page 163.

Shortcuts page

The Shortcuts page lets you add links (or shortcuts) to external programs or Web

pages outside of the console.

When you install the console, the following default program shortcut icons are

automatically added to the Shortcuts page:

■ Backup Exec 11d

■ Backup Exec 10d

■ LiveUpdate

■ Symantec pcAnywhere

These program shortcuts are active if you have the programs (or any other program

from the family of Backup Exec products) installed on the same computer as the

console.
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See “About the Shortcuts page” on page 169.

Refreshing the console manually

Refreshing the console manually updates the currently displayed page (excluding

the Shortcuts page) with new data. All cached backup, computer, group, or recovery

point destination information is reread to ensure that any changes are updated

in the user interface of the page you are viewing.

You can set up the console to refresh automatically.

See “Editing server and client settings” on page 84.

To refresh the console manually

◆ Do one of the following:

■ Press F5.

■ On the Home, Manage, Monitor, or Reports page, click View>Refresh.

Changing pane details

To help you manage hundreds or thousands of computers, you can use the Filter

bar in the upper right pane of the Manage page and other areas of the console to

refine or organize the displayed results. For example, you can use the Add Filter

drop-down list on the left end of the bar to further refine the results. Or, you can

select only those column headings that you want to see or hide in the table. You

can also sort columns of information in ascending or descending order. Or, you

can rearrange the order of column headings.

Note: The Add Filter drop-down list on the left end of the Filter bar and the View

Columns drop-down list on the right end of the Filter bar function independently

of each other.

To change pane details

1 On the Manage page, in the right pane, click a tab.

The Filter bar appears directly above the table on the right pane.

2 Select a filter type from the Add Filter drop-down list at the left end of the

Filter bar.

Click All on the Filter bar to view all of the data for the selected tab. The

number next to All is the total number of computers, groups, backups, or

destinations that are listed in the table.

3 Do one of the following:

51Using the Backup Exec System Recovery Manager console
About using the console



To sort the information by ascending or descending order, click a column

heading in the table.

■

■ To reorganize the information, drag a column heading in the table to a

new location within the same bar.

■ To check (show) or uncheck (hide) column names in the table, use the

Columns view drop-down list on the Filter bar.

■ Right-click on any column heading, and then check (show) or uncheck

(hide) the column headings that you want.

Using the Drag-and-drop Workspace
The Drag-and-drop Workspace simplifies working with objects and tasks in the

multiple workspace environment of the Manage page.

For example, suppose that you wanted to quickly assign three groups of computers

to a particular backup job. On the Manage page, you would select three group

names in the Groups tab. Then you would select a backup name on the Backup

Jobs tab. Notice that the respective icons also identify the number of objects you

have selected. Now, in the Drag-and-drop Workspace, drag the Backup icon and

drop it onto the Groups icon (or vice versa). The backup job is now assigned to all

the computers in the selected groups.

To use the Drag-and-drop Workspace

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computers.

■ In the right pane, on the Groups tab, select one or more group names.

■ In the right pane, on the Backup Jobs tab, select one or more backup names.

2 Do one of the following on a different tab from above:

■ In the right pane, on the Computers tab, select one or more computers.

■ In the right pane, on the Groups tab, select one or more group names.

■ In the right pane, on the Backup Jobs tab, select one or more backup names.

Your selection depends on what you want to do. For example, do you want to

assign computers to groups, computers to backups, or groups to backups?

3 On the Drag-and-drop Workspace, drag the icon that represents your first

selection and drop it onto the icon that represents your second selection (or

vice versa).
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Changing the location and view of the Drag-and-drop Workspace

You can dock the Drag-and-drop Workspace on the left, right, top, or bottom of

the right pane on the Manage page.

You can also pin (continually display) or unpin (temporarily hide) the workspace

when it is docked on the left or the right side. When you unpin, you access the

workspace by moving your mouse pointer onto the Drag-and-drop Workspace

tab.

The workspace objects can be arranged in the following manner:

■ Tiles: Large icons with the object name displayed to the side of the icon.

■ Icons: Medium icons with the object name displayed under the icon.

■ List: Small icons with the object name displayed to the side of the icon.

To change the location and view of the Drag-and-drop Workspace

1 On the Manage page, do one of the following:

■ To change the workspace view, on the View menu, click Drag-and-drop

Workspace > Tiles, Icons, or List.

■ To change the workspace location, on the View menu, clickDrag-and-drop

Workspace > Left, Top, Right, or Bottom.

■ Drag the title bar of the Drag-and-drop Workspace to a highlighted location

in the right pane area.

2 If the workspace is located on the left or right side of the Manage page, click

the pin icon to pin (continually display) or unpin (temporarily hide) the

workspace.

Updating the Backup Exec SystemRecoveryManager
console

You can receive software updates that are associated with your version of the

Backup Exec System Recovery Manager console by connecting to the Symantec

LiveUpdate server. You can select the updates that you want to install.

Run LiveUpdate after you have installed the console and opened it for the first

time. After you know that your files are up to date, run LiveUpdate periodically

to obtain program updates for the console.

To update the Backup Exec System Recovery Manager console

1 On the Help menu, click LiveUpdate.

2 Follow the on-screen instructions.

53Using the Backup Exec System Recovery Manager console
Updating the Backup Exec System Recovery Manager console



Sending feedback
Please take a moment to share your feedback and comments with Symantec

regarding Backup Exec System Recovery Manager.

To send feedback

1 On the Help menu, click Send Feedback.

2 Follow the on-screen instructions.

3 When you are finished, click Submit.

Where to go from here
Add computers to the Backup Exec System Recovery Manager console and assign

backups to those computers.

See “About adding computers to the console” on page 55.

See “Creating a backup job” on page 103.

See “About working with backup jobs” on page 126.
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Configuring Backup Exec

System Recovery Manager

This chapter includes the following topics:

■ About adding computers to the console

■ About adding computers that have existing installations of Backup Exec System

Recovery

■ Removing computers from the console

■ About organizing groups of computers

■ About managing recovery point destinations

■ Editing server and client settings

■ About managing roles-based user accounts

■ About managing licenses

■ About configuring Backup Exec Retrieve

About adding computers to the console
Before you can begin to manage backups of computers on a network or a remote

location, you must first add computers to the server and database so that they

show up in the console. Adding computers to the console is a streamlined process

that involves the installation of Backup Exec System Recovery and Management

Control software on client computers. The following overview describes the tasks

and processes that are involved.
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■ Optionally create packages of products such as LightsOut Restore or Backup

Exec Granular Restore. (Packages for Backup Exec System Recovery Manager,

Management Control, and Index Server are already created for you.)

See “Creating packages for an Easy Installer ” on page 56.

■ Optionally create an Easy Installer that includes one or more packages.

See “Creating an Easy Installer ” on page 58.

■ Remote users navigate to the Backup Exec System Recovery Download Center

Web page and click the name of the Easy Installer to download and install. Or,

you use your existing logon scripts to deploy the Easy Installer onto computers.

See “Downloading an Easy Installer by end users” on page 66.

See “Deploying an Easy Installer by administrators” on page 68.

■ Management Control reports to the Backup Exec System Recovery Manager

server. The Computers tab on the Manage page of the console is automatically

updated with detailed information about the computers. Each computer is now

integrated and under the management of Backup Exec System Recovery

Manager.

After computers are added to the console, you can define and assign backups to

those computers.

See “Creating a backup job” on page 103.

Creating packages for an Easy Installer

Backup Exec System Recovery Manager already includes numerous pre-installed

packages such as the following:

■ Backup Exec System Recovery

■ Management Control - A necessary component of Backup Exec System Recovery

that must be installed on each computer whose backups you want to manage.

■ Indexing Server

You would need to create packages for an Easy Installer if any of the following

reasons apply:

■ A newer version is released for any of the pre-installed packages.

■ You want to install LightsOut Restore on computers that you manage.

Backup Exec System Recovery Manager does not ship with a pre-installed

package of LightsOut Restore. However, you can use the Symantec Recovery

Disk CD (or a Symantec Recovery Disk CD that you have customized) to create

a package of LightsOut Restore. The CD comes with Backup Exec System

Recovery Manager.
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LightsOut Restore gives you the ability to restore servers in remote, unattended

environments and distributed locations.

See “About recovering a drive” on page 139.

■ You want to install Backup Exec Granular Restore Option on Exchange servers

with Backup Exec System Recovery already installed.

You must purchase Backup Exec Granular Restore Option. You can then use

the product's CD to create a package of Backup Exec Granular Restore Option

using Backup Exec System Recovery Manager.

See “Creating an Easy Installer ” on page 58.

A package contains one software product such as Backup Exec System Recovery

or Management Control. You combine one or more packages to create an Easy

Installer that users download onto their computers, or you deploy to computers

with a logon script. Packages and Easy Installers are stored on the Backup Exec

System Recovery Manager server.

Typically, you create packages only once and then use them in an Easy Installer

until a new version of the product is released. At that time, you can run the Create

Packages wizard again to create the appropriate package and then create a new

Easy Installer.

To create packages for an Easy Installer

1 Depending on the package that you want to create, make sure you have one

or more of the following product CDs available before you continue:

■ Symantec Backup Exec System Recovery 7.0 or 8.0 Server Edition

■ Symantec Backup Exec System Recovery 7.0 or 8.0 Windows Small

Business Server Edition

■ Symantec Backup Exec System Recovery 7.0 or 8.0 Desktop Edition

■ Symantec Backup Exec System Recovery Manager 7.0 or 8.0

■ Symantec Recovery Disk

■ Symantec Backup Exec Granular Restore Option

2 On the Tools menu, click Create Easy Installer.

3 Click AddPackage.

4 Select a product whose package you want to create based on the product CD

you have available, and then click Next.

5 Click Fromproduct CD.
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6 When prompted, insert the appropriate product CD into the media drive.

The install browser window may appear after you insert the CD. In such cases,

click Exit to return to the wizard.

7 To begin copying the files from the product CD, click Next.

The package is added to the Backup Exec System Recovery Manager server.

When you are finished creating packages, you are ready to combine different

packages into an Easy Installer.

See “Creating an Easy Installer ” on page 58.

Deleting packages

You can delete those packages that you no longer need or use from the Backup

Exec System Recovery Manager server. Deleting a package does not affect any

Easy Installers that use that package.

Note: You cannot undo a deleted package. If you delete a package by mistake, you

need to recreate it.

See “Creating packages for an Easy Installer ” on page 56.

To delete packages

1 On the Tools menu, click Create Easy Installer.

2 From the list box, select the package that you want to delete .

3 Click Delete.

4 Click Yes to confirm the deletion.

Creating an Easy Installer

An Easy Installer is a single installation that contains one or more packages that

you have previously created, and other optional functions that are applied to the

installer, such as prompting users to reboot their computer. Easy Installers reside

on the Backup Exec System Recovery Manager server.

See “Creating packages for an Easy Installer ” on page 56.

Depending on how you created the Easy Installer, you can have the resulting

install added to a Web page as a hyperlink so that users can download and install

the software onto their computers. Or, you can use your established client

computer management software and deployment processes to install the software,

by way of an Easy Installer, onto client computers.
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See “Downloading an Easy Installer by end users” on page 66.

See “Deploying an Easy Installer by administrators” on page 68.

After the users install the software, their client computer becomes managed (and

visible) from the Backup Exec System Recovery Manager console.

Table 4-1 describes the packages that are already available for you to use in Easy

Installers.

Table 4-1 Available packages

DescriptionPackage

Provides advanced backup and recovery for client computers.

Backup Exec System Recovery Manager is necessary if you intend

to install Index Server or Backup Exec Granular Restore Option

on client computers.

Backup Exec System

Recovery

A necessary component for managing computers with Backup

Exec System Recovery installed.

Note: You can have multiple versions of Management Control

packages available. The Management Control version that you

install on the client computer must be compatible with the

version of Backup Exec System Recovery that is also installed.

For example, Management Control 8.0 is compatible with Backup

Exec System Recovery 7.0 and 8.0. You can check versions when

you create the Easy Installer.

Management Control

Provides the capability for users to retrieve their own files with

Backup Exec Retrieve on the Web.

Note: Backup Exec System Recovery must be installed on client

computers prior to installing Indexing Server.

See “About configuring Backup Exec Retrieve” on page 96.

Indexing Server

To create an Easy Installer

1 On the Tools menu, click Options.

2 In the left pane, click Easy Installers.

3 In the right pane, click Create.
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4 Check the packages that you want to include in the Easy Installer, and then

click Next.

If you select multiple packages and one of them is Backup Exec System

Recovery, you have the option of including Management Control (a necessary

component for managing Backup Exec System Recovery). The Management

Control component can also be installed separately, if desired.

Note:The Management Control version that you install on the client computer

must be compatible with the version of Backup Exec System Recovery that

is also installed. For example, Management Control 8.0 is compatible with

Backup Exec System Recovery 7.0 and 8.0. You can check versions when you

create the Easy Installer.
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5 Depending on the packages that you selected, you may need to set certain

options specific to the package.

If you selected the Backup Exec System Recovery package, specify the

following options:

Installs only the Backup Exec System Recovery agent. The

agent is the unseen engine that does the actual creation and

Install Backup Exec

System Recovery

restoration of recovery points on a computer. Because thewithout a user

interface agent functions as a service, it does not have a graphical user

interface on the client computer.

The agent does, however, have a tray icon that is available

from the Windows system tray to provide feedback of current

conditions and to perform common tasks.

For example, from the tray icon a user can view assigned

backups or cancel a job that is currently running.

Installs the full Backup Exec System Recovery product that

includes the agent and the graphical user interface.

Install Backup Exec

System Recovery with

a user interface
See “Setting client options for computers” on page 153.

Installs Backup Exec System Recovery based on the default

language setting used in Windows.

Use the default

language that is

specified in Symantec

Recovery Disk

Lets you choose the language version of Backup Exec System

Recovery that you want to install, regardless of the default

language setting in Windows.

Choose language

If you selected the LightsOut Restore package, specify the following options:

Specify how long the boot menu is displayed on the client

computer. The default is 10 seconds.

Time to display boot

menu

Check this option if you want the capability to load the

Symantec pcAnywhere thin host on the client computer for

Enable Symantec

pcAnywhere

recovery environment access. This is useful for

troubleshooting a system recovery.

Check this option if you want networking to start when

LightsOut Restore is loaded.

Enable network

services

Click the type of IP addresses that you want LightsOut Restore

to use for communication with Backup Exec System Recovery

Manager.

Dynamic IP address or

Static IP Address
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Installs Backup Exec System Recovery that is based on the

default language setting used in Windows.

Let OS determine

language

Choose the language version of Backup Exec System Recovery

that you want to install, regardless of the default language

setting in Windows.

Choose language

Note: The LightsOut Restore feature requires a minimum of 1 GB of memory

on the client computer to run.

6 Click Next.

7 Select the options that you want the Easy Installer to include.

Type the name of the Easy Installer. The name is what users

see on the Web page that they visit. It is also the name of the

Easy Installer file.

By default, the package names you selected earlier are

combined and represented as the Easy Installer name.

Easy Installer name
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This option is checked by default.

Adds the Easy Installer to the Backup Exec System Recovery

Download Center Web page. The Easy Installer is represented

as a hyperlinked name on the Web page.

If you intend to have users download the software, the link is

what users click to download and install it. If you intend to

deploy the software, the same link is used to download and

save the software to your computer. You can then use your

existing logon scripts to install the software onto computers.

Note: Be aware that if your logon script detects that the

expected version ofBackup Exec System Recovery is already

installed on a client computer, it may still run the Easy

Installer which would uninstall and then reinstall Backup Exec

System Recovery. To prevent this from happening repeatedly

at log on, be sure your script first checks for an installation

of the expected version of Backup Exec System Recovery and

runs accordingly.

The Backup Exec System Recovery Download Center Web page

is located on the Backup Exec System Recovery server and

available at the following locations:

■ On the Tools menu, click Options. In the left pane, click

Easy Installers. The Web hyperlink is displayed in the

lower right pane.

■ Secure port: https://<server_name or
IP_address>:8443/DownloadCenter

Show Easy Installer

on Web Page

This option is checked by default. Prompts the users, where

required, to reboot their computer following the installation

of the software.

Warning: If you uncheck this option, the client computers

will still reboot (if necessary), but the users will not be

prompted.

Prompt user to reboot

if necessary

This option is checked by default.

Displays the status of the installation to the user on the client

computer.

Show Easy Installer

status on client

computer

63Configuring Backup Exec System Recovery Manager
About adding computers to the console



Specify the user context to run the install on the client

computer.

If you know that users do not have Administrator privileges

to download and install the product, select this option.

Specify the appropriate user credentials so that the user can

download and install the software

You must have an administrator user name and password for

the computers that you want to manage. Also, the

administrator user name and password must be the same for

all the computers that you want to place under management

at one time. To accomplish this, all unmanaged computers

must be in the same domain. You should also use a domain

administrator user name (for example, name@domain.com)

and password for authentication. If you add only a few

computers, you can specify a local user account.

For security reasons, you should not use the same user name

and password that is used to log on to the Backup Exec System

Recovery Manager console.

Run-as the following

user on the client

computer.

8 Click Next.
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9 Select the behavior control options that you want the Easy Installer to include:

Check this option to include all of the necessary install files

in the Easy Installer. Including install files results in a larger

Easy Installer file size to download. However, the installation

is faster because the Easy Installer does not need to

communicate with the server or download the install files

separately.

Note: If the Easy Installer is being downloaded or deployed

over a VPN or a slow network connection, you should check

this option.

If you do not check this option, the Easy Installer downloads

the necessary install files from the Backup Exec System

Recovery Manager server at the time of installation. The result

is a longer installation time.

Include Files

Check this option to specify which IP address on the Backup

Exec System Recovery Manager server that the Easy Installers

should use when they communicate with the server. This

option is useful if the server has multiple NIC cards or, if you

assigned a static IP address to the Backup Exec System

Recovery Manager server.

IP Address

Check the role names that are permitted to download the Easy

Installer.

Accessibility

10 Click Next to review the options you have selected.

11 Click Finish.

You are ready to use Easy Installers to add computers to the console.

See “Downloading an Easy Installer by end users” on page 66.

See “Deploying an Easy Installer by administrators” on page 68.

Editing an Easy Installer

You can edit an existing Easy Installer even if is already available from the

download center Web page.

To edit an Easy Installer

1 On the Tools menu, click Options.

2 In the left pane, click Easy Installers.

3 In the right pane, select the name of an Easy Installer that you want to edit.
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4 Click Edit.

5 Change the options that you want, and then click OK.

Deleting an Easy Installer

When you delete an Easy Installer, you remove both the hyperlink from the

associated download center Web page and the Install itself from Backup Exec

System Recovery Manager. Any packages inside the Easy Installer are still saved

in the Backup Exec System Recovery database for future use.

To delete an Easy Installer

1 On the Tools menu, click Options.

2 In the left pane, click Easy Installers.

3 In the right pane, select the name of an Easy Installer that you want to delete.

4 Click Delete.

5 Click Yes to confirm the deletion.

Downloading an Easy Installer by end users

You can add computers to the console by having remote users download and install

the Backup Exec System Recovery Easy Installer. The Management Control

component publishes information back to the server, which populates the Backup

Exec System Recovery Manager console.

Users can also download Easy Installers of LightsOut Restore and Backup Exec

Granular Restore Option if you have made them available on the download center

Web page.

You may prefer to deploy Easy Installers to client computers with a logon script

instead.

See “Deploying an Easy Installer by administrators” on page 68.

See “About adding computers to the console” on page 55.

To have end users download an Easy Installer

1 Navigate to the Backup Exec System Recovery Download Center Web page

by doing one of the following:

■ On the Tools menu, click Options. In the left pane, click Easy Installers,

and then in the right pane, click the Web hyperlink.

■ Type the following in a Web browser:
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https://<server_name or IP_address>:8443/DownloadCenter

2 Type the user name and password that is assigned to the role, and associated

with the Easy Installer.

For example, if you assigned the Download A role when you created the Easy

Installer, you would type the user name and password assigned to that role.

If you did not assign a role to an Easy Installer, the role defaults to Download

All with "download" as the default user name and password. It is recommended

that you change the default Download All user name and password.

See “Editing a user account” on page 88.

3 Click the email hyperlink to the right of the Easy Installer that you want users

to download.

Your default email program opens a new email window. The Web hyperlink

to the Easy Installer is added to the body of the email message.
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4 Specify the email addresses of all intended users, including any additional

instructions, and then click Send.

The users open the email, and then type the necessary user name and

password to open the Web page. They click the name of the Easy Installer to

begin the download and installation of the software.

Note: If Backup Exec System Recovery already exists on a client computer

before installation, any backup jobs (including command files) created by the

user remain intact. Management Control publishes the user's backup job to

the server and updates the console. However, the backup history is deleted.

Following the installation of Backup Exec System Recovery, the computer

either reboots automatically after 60 seconds, or it gives the user the option

to reboot later. (The reboot option was defined at the time you created the

Easy Installer.)

5 The Management Control component publishes information back to the

Backup Exec System Recovery Manager server.

The computer appears on the Manage page of the console and is considered

manageable. You can now assign backup jobs to the computer to bring it

under full backup management.

See “Components of Backup Exec System Recovery Manager” on page 17.

For each installation of Symantec Backup Exec System Recovery on computers,

you also need to add a product key (for Backup Exec System Recovery 8.0) or

deploy a license file (for Backup Exec System Recovery 7.0) to activate the

software.

See “Assigning Backup Exec System Recovery licenses to computers”

on page 90.

Deploying an Easy Installer by administrators

You can add computers to the console by using your established client computer

management software and deployment processes to install the software, by way

of an Easy Installer, onto client computers. The Management Control component

publishes information back to the server, which populates the Backup Exec System

Recovery Manager console.

You can also deploy Easy Installers of LightsOut Restore and Backup Exec Granular

Restore Option if you have made them available.

You may prefer to have remote users download Easy Installers from the download

center Web page instead.
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See “Downloading an Easy Installer by end users” on page 66.

See “About adding computers to the console” on page 55.

To have administrators deploy an Easy Installer

1 Navigate to the Backup Exec System Recovery Download Center Web page

by doing one of the following:

■ On the Tools menu, click Options. In the left pane, click Easy Installers,

and then in the right pane, click the Web hyperlink.

■ Type the following in a Web browser:

https://<Server_name or IP_address>:8443/DownloadCenter

2 Type the user name and password that is assigned to the role, and associated

with the Easy Installer.

For example, if you assigned the Download A role when you created the Easy

Installer, you would type the user name and password assigned to that role.

If you did not assign a role to an Easy Installer, the role defaults to Download

All with "download" as the default user name and password. It is recommended

that you change the default Download All user name and password.

See “Editing a user account” on page 88.

3 To download and save the file to a location on your computer, click the name

of an Easy Installer.
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4 Use your existing logon scripts to deploy the Easy Installer onto computers

and install the software. For example, you can integrate the Easy Installer

with your domain logon scripts.

Be aware that if your logon script detects that the expected version ofBackup

Exec System Recovery is already installed on a client computer, it may still

run the Easy Installer which would uninstall and then reinstall Backup Exec

System Recovery. To prevent this from happening repeatedly at log on, be

sure your script first checks for an installation of the expected version of

Backup Exec System Recovery and runs accordingly.

Note: If Backup Exec System Recovery already exists on a client computer

before installation, any backup jobs (including command files) created by the

user remain intact. Management Control publishes the user's backup job to

the server and updates the console. However, the backup history is deleted.

Following the installation of Backup Exec System Recovery, the computer

either reboots automatically after 60 seconds, or it gives the user the option

to reboot later. (The reboot option is defined at the time you created the Easy

Installer.)

5 The Management Control component publishes information back to the

Backup Exec System Recovery Manager server.

The computer appears on the Manage page of the console and is considered

manageable. You can now assign backup jobs to the computer to bring it

under full backup management.

See “Components of Backup Exec System Recovery Manager” on page 17.

For each installation of Symantec Backup Exec System Recovery on computers,

you also need to add a product key (for Backup Exec System Recovery 8.0) or

deploy a license file (for Backup Exec System Recovery 7.0) to activate the

software.

See “Assigning Backup Exec System Recovery licenses to computers”

on page 90.

About adding computers that have existing
installations of Backup Exec System Recovery

Backup Exec System Recovery Manager 8.0 supports the backup management of

existing installations of Symantec Backup Exec System Recovery 8.0 and 7.0 on

client computers. To bring such computers under backup management, you need

to install Management Control 8.0 using an Easy Installer.
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See “Creating an Easy Installer ” on page 58.

After Management Control is installed, it publishes information back to the Backup

Exec System Recovery Manager server and the following occurs:

■ Any user-defined backup jobs on the client computer or existing recovery point

information gets imported to the Backup Exec System Recovery Manager

server and appears in the console.

■ If the backup job specifies a network destination for saving the recovery

points, you must reconcile the destination by specifying the proper network

credentials in Backup Exec System Recovery Manager. The backup job will

then become functional in Backup Exec System Recovery Manager and

continue to store recovery points on the designated network share.

Otherwise, you can choose to delete the destination and any backup jobs

that are associated with it, and then create or assign a new backup job for

the affected computers.

See “Reconciling a recovery point network destination for an imported

backup job” on page 72.

■ If the backup job includes the use of a recovery point password, you must

reconcile the job from the console by specifying the correct password. The

backup job will then become functional in Backup Exec System Recovery

Manager and continue to apply password protection to recovery points.

Otherwise, you can choose to delete the backup job, and then assign a new

backup job to the affected computers.

See “Reconciling recovery point passwords or command files for an

imported backup job” on page 73.

■ If the imported recovery points were created with password protection,

you must reconcile each recovery point in the console by specifying the

original password. This ensures that the imported recovery points are

accessible from Backup Exec System Recovery Manager and that you can

restore a recovery point with the password, if necessary.

See “Reconciling passwords for imported recovery points” on page 75.

■ Any command files that are associated with imported jobs are not copied to

the server. Instead, you must edit the backup job and either specify the

necessary command files that you want to run or remove the files from the

backup job.

See “Reconciling recovery point passwords or command files for an imported

backup job” on page 73.

In the console, you can segregate Backup Exec System Recovery 8.0 and 7.o client

computers by turning on the Backup Exec System Recovery Version column on

the Manage page.
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See “Changing pane details” on page 51.

Reconciling a recovery point network destination for an imported
backup job

When you bring existing installations of Backup Exec System Recovery 8.0 or 7.0

under backup management, any user-defined backup jobs on those client

computers are automatically imported into the console. If those jobs specified a

network destination for recovery points, you must reconcile each destination in

the console. This ensures that the backup jobs that use the network share can

continue to function as usual and also be able to store the recovery points on the

specified network share.

To reconcile a recovery point network destination, you need to specify the correct

network credentials. Or, you can choose to delete the destination and any backup

jobs that are associated with it, and then assign a new backup job to the client

computer.

Any destinations that you need to reconcile are displayed each time you start the

console.

See “Reconciling recovery point passwords or command files for an imported

backup job” on page 73.

See “Reconciling passwords for imported recovery points” on page 75.

See “About adding computers that have existing installations of Backup Exec

System Recovery” on page 70.

To reconcile a recovery point network destination for an imported backup job

1 On the Manage page, in the right pane, click the Destinations tab.

In the table, network destinations that require reconciliation are listed as

Action Required under the column headings Network User and Password.

2 On the Tasks menu, click DestinationsNeeding Credentials.

You can use the Filter bar above the table to refine or organize the displayed

results.

3 Select one or more paths that need credentials.

4 Do one of the following:

■ To remove the destination and any backup jobs that are associated with

it, click Delete > Yes.

■ To specify the credentials to the network destination, click Edit, and then

continue with the next step.
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Notice that you cannot edit the path. To edit the path, you need to delete

this destination instead, and then define a new one.

5 In the network credentials group box, type the user name and password for

logging on to the network storage location.

6 To verify that the specified user name and password to the network location

are valid, you can check Validate network location.

If you selected two or more destinations in step 3 to edit at the same time,

Validate network location is not available.

7 If necessary, edit the Backup Exec Retrieve indexing settings.

If you selected two or more destinations in step 3 to edit at the same time,

Backup Exec Retrieve indexing settings are not available.

8 Click OK.

Reconciling recovery point passwords or command files for an imported
backup job

When you bring existing installations of Backup Exec System Recovery 8.0 or 7.0

under backup management, any user-defined backup jobs on those client

computers are imported into the Backup Exec System Recovery Manager server

and appear in the console. If those jobs specified the use of a recovery point

password or command files, you must reconcile each job in the console. This

ensures that the job will continue to function as usual and also create recovery

points that are protected with a password.

To reconcile a job, you need to specify a password for the recovery points. Or, you

can choose to delete the job, and then assign a new job to the client computer.

Any backup jobs that you need to reconcile are displayed each time you start the

console.

See “Reconciling a recovery point network destination for an imported backup

job” on page 72.

See “Reconciling passwords for imported recovery points” on page 75.

See “About adding computers that have existing installations of Backup Exec

System Recovery” on page 70.
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To reconcile recovery point passwords or command files for an imported backup

job

1 On the Manage page, in the right pane, click the Backup Jobs tab.

In the table, backup jobs whose passwords require reconciliation are listed

as Action Required under the Password column header. Likewise, backup jobs

whose command files require reconciliation are listed as Action Required

under the Command Files column header.

2 On the Tasks menu, click Backup JobsNeedingAttention.

3 Do one or more of the following:

■ Select one or more job names with Action Required status

under the Password column header.

You can use the options on Filter bar above the table to refine

the displayed results.

■ Do one of the following:

■ To remove the backup jobs, click Delete > Yes.

■ To specify the recovery point password for the backup

job, click Set Password and then continue with the next

step.

■ Type the password twice, and then click OK.

To reconcile

recovery point

passwords for an

imported backup job

■ Select one or more job names with Action Required under

the Command Files column header

You can use the options on Filter bar above the table to refine

the displayed results.

■ Click Edit.

■ ClickNext in the Edit Backup Job wizard until the Command

Files panel appears.

■ Select a command file (.exe, .bat) from each drop-down list

to run during a particular stage in the recovery point

creation process, and then specify the amount of time (in

seconds) that you want the command to run before it is

stopped.

To add command files to the drop-down lists, click Add or

Remove Command Files. Command files are copied and

stored on the Backup Exec System Recovery Manager server.

See “About running command files during a back up”

on page 116.

■ To complete the Edit Backup Job wizard, click Next twice,

and then click Finish.

To reconcile

command files for

an imported backup

job

4 To return to the console, click Close in the Backup Jobs Needing Attention.
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Reconciling passwords for imported recovery points

When you bring existing installations of Backup Exec System Recovery 8.0 or 7.0

under backup management, any existing recovery points are automatically

imported for viewing in the console. If the imported recovery points were created

with password protection, you must reconcile each recovery point in the console

by specifying the original password. This ensures that the imported recovery

points are still accessible from Backup Exec System Recovery Manager and that

you can restore a recovery point, if necessary.

See “Reconciling recovery point passwords or command files for an imported

backup job” on page 73.

See “Reconciling a recovery point network destination for an imported backup

job” on page 72.

See “About adding computers that have existing installations of Backup Exec

System Recovery” on page 70.

To reconcile passwords for imported recovery points

1 On the Manage page, in the right pane, do one of the following:

■ Click the Computers tab, and then select one or more computer names in

the table.

■ Click the Groups tab, and then select one or more group names in table.

■ Click the Destinations tab, and then select one or more paths in the table.

2 On the Tasks menu, click Recovery Points >View.

3 On the Add Filter drop-down list, click Password >ActionRequired.

4 Select all the recovery points for a particular computer, and then click Specify

Original Password.

5 Type the original password that was assigned to the recovery points, and

then click OK.

Removing computers from the console
When you remove one or more computers or a group of computers, the following

occurs:

■ The computers are removed from all views in the console.

■ Management Control becomes inactive. Computer information is no longer

published back to the Backup Exec System Recovery Manager server.
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■ Backup Exec System Recovery, Management Control, and the Microsoft .NET

Framework remain installed on each computer.

■ The Backup Exec System Recovery license remains on each computer.

You can optionally have the license unassigned at the time you remove

computers from the console. In such cases, Backup Exec System Recovery

returns to a 60-day trial version on the client computer.

■ Backup jobs remain on each computer.

You can optionally have backup jobs unassigned at the time you remove

computers from the console.

Note: To add the computers to the console again, you can use an Easy Installer to

reinstall Management Control on the client computers.

See “Creating an Easy Installer ” on page 58.

See “Downloading an Easy Installer by end users” on page 66.

See “Deploying an Easy Installer by administrators” on page 68.

See “About managing licenses” on page 89.

To remove computers from the console

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

2 Do one of the following:

■ If you selected one or more computers, on the Tasks menu, clickUnmanage

Computers.

■ If you selected one or more groups of computers, on the Tasks menu, click

Unmanage Computers inGroups.

3 Check Remove licenses from computers before unmanaging if you want to

unassign all Backup Exec System Recovery licenses from the selected

computers. The licenses can be reassigned to other computers that you

manage.

4 Check Unassign backup jobs from computers before unmanaging if you

want to remove backup jobs from the selected computers before the computers

are removed from the console.

5 Click OK twice to confirm the removal.
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About organizing groups of computers
You can organize computers in the console by creating computer groups. Although

not a necessary task, computer groups simplify the backup management of large

numbers of computers. For example, if you want to back up desktop computers

once a month, you can create a group for those computers, regardless of where

they reside on the network. You can then assign a monthly backup job for that

group.

You can group computers by department, network location, physical location, job

schedules, or any other grouping criteria you establish. You can then assign one

or more jobs to that group. This method saves you time by not having to create a

job for each computer in the console.

Note: Only one incremental job per drive can be assigned on a client computer. If

you assign a second incremental job to the same drive, a job error occurs.

You can create any number of groups for the computers that are added to the

console, and you can add computers to one or more groups.

Computer groups cannot be nested within other computer groups.

You can organize groups of computers in the following ways:

■ Add computer groups to the console

See “Adding groups to the console” on page 77.

■ Edit a computer group name and description

See “Editing groups” on page 78.

■ Remove computer groups from the console

See “Deleting groups” on page 78.

■ Assign computers to groups

See “Assigning computers to a group” on page 79.

■ Remove computers from groups

See “Unassigning computers from a group” on page 79.

■ View computers that are assigned to a group

See “Viewing the properties of a group” on page 79.

Adding groups to the console

When you create a group for computers, the name is added to the Groups tab on

the Manage page.
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You can add a computer to more than one group, but you can only assign one

incremental job at a time (per drive), on the selected computer (this does not apply

to base-only jobs).

See “Assigning computers to a group” on page 79.

To add groups to the console

1 On the Manage page, in the right pane, click the Groups tab.

2 On the Tasks menu, click Create Group.

3 In the Computer group name text box, type the name that you want to use to

identify the group.

4 Type a description for the computer group.

5 Click OK.

The group appears in the table on the Groups tab.

Editing groups

You can change the name or description of an existing computer group in the

console.

To edit groups

1 On the Manage page, in the right pane, click the Groups tab.

2 Select a group name in the table.

3 On the Tasks menu, click Edit.

4 Make the changes that you want to the group name and description.

5 Click OK.

Deleting groups

When you delete a computer group, the group name is removed from the Groups

tab on the Manage page. The computers, however, continue to be managed in

their respective tabs on the Manage page.

See “Removing computers from the console” on page 75.

To delete groups

1 On the Manage page, in the right pane, click the Groups tab.

2 Select a group name in the table.

3 On the Tasks menu, click Delete.

4 Click Yes to confirm the deletion.
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Assigning computers to a group

After you have created a computer group, you can customize the group by adding

or removing the computers that exist in the Backup Exec System Recovery Manager

database.

You use traditional file selection methods in the console to select one or more

computers that you want to add to a computer group.

See “Adding groups to the console” on page 77.

To assign computers to a group

1 On the Manage page, in the right pane, click the Groups tab.

2 Select the group name in the table.

3 On the Tasks menu, click Assign > Computers.

If necessary, you can use the Filter bar in the Assign Group to Computer

dialog box to refine the list of computers.

4 Select the computers that you want to assign to the group.

5 Click OK.

Unassigning computers from a group

When you remove computers from a group, the computers remain visible on the

Computers tab of the Manage page. This situation occurs because the computers

are already added to the Backup Exec System Recovery Manager console and

server.

See “Removing computers from the console” on page 75.

To unassign computers from a group

1 On the Manage page, in the right pane, click the Groups tab.

2 Select the group name in the table.

3 On the Tasks menu, click Unassign > Computers.

To refine the list of computers, you can use the Filter bar in the Unassign

Computers from Groups dialog box.

4 Select the computers that you want to delete from within the group.

5 Click OK.

Viewing the properties of a group

You can review all computers that are assigned to a selected group.
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To view the properties of a group

1 On the Manage page, in the right pane, click the Groups tab

2 Select a group name in the table.

3 On the Tasks menu, click Properties.

4 In the left pane, click a detail or assignment to view the accompanying results

on the right pane.

5 Click Close.

About managing recovery point destinations
You can manage the destinations of recovery points in the following ways:

■ Define destinations for storing recovery points

See “Creating recovery point destinations” on page 80.

■ Change a previously defined destination

See “Editing recovery point destination network credentials” on page 82.

■ Delete a recovery point destination

See “Deleting recovery point destinations” on page 83.

■ View computers and backup jobs you have assigned to a recovery point

destination

See “Viewing the properties of a recovery point destination” on page 83.

See “About destination options for recovery points” on page 107.

Creating recovery point destinations

On the Manage page of the console, you can define destinations where you want

to store recovery points by client computers. A recovery point destination that

you define is saved and made available in the Define Backup Wizard, One-time

Backup Wizard, and in the Destinations tab on the Manage page.

By defining recovery point destinations that are separate from jobs and computers,

you can see how many computers have backed up to a given destination. You can

also optimize the network load balance during a job.

You define a recovery point destinations by typing a local folder path, UNC path,

or IP address to the location, or by browsing a particular network domain.
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Note: When you specify a local folder path as a recovery point destination, the

path corresponds to the drive that is found on the managed client computer; it is

not the path on the computer where you are running the Backup Exec System

Recovery Manager console.

If you use Symantec Backup Exec, you can use the same remote Backup Exec server

location defined by Symantec Backup Exec.

See “About managing recovery point destinations” on page 80.

To create recovery point destinations

1 On the Manage page, in the right pane, click the Destinations tab.

2 On the Tasks menu, click CreateDestination.

3 Do one of the following:

■ Type a UNC path to a network share. Make sure the UNC path is preceded

with double backslash characters "\\".

■ Type the IP address path to a network share. Make sure the IP address

path is preceded with double backslash characters "\\".

■ Type a local folder path. The local folder path you specify is relative to

the managed client computer; it is not the folder path on the computer

where you are running the Backup Exec System Recovery Manager console.

Go to step 5.

Local folder paths do not get indexed by the Backup Exec Retrieve Indexing

component; only network share paths are indexed.

■ Click Browse to locate a destination on a network domain.
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4 If you typed a path to a network share, set the following options:

In the Network credentials group box, type the user name

and password for logging on to the network storage location.

Check Validate network location (default) to verify that

the specified user name and password to the network

location are valid.

Network Credentials

Check this option to turn on the Indexing Server component

of Backup Exec Retrieve. The Indexing Server component

indexes all the files inside a recovery point, at the specified

network share path. Indexing files allows remote users to

search and recover files by name, versions, or recent activity

by way of Backup Exec Retrieve's Web-based interface.

This is an optional feature, and it is available only when

you specify a recovery point destination on a network share.

See “About configuring Backup Exec Retrieve” on page 96.

Enable Backup Exec

Retrieve indexing

From the drop-down list, select the indexing server that

you want to use.

Note: If you enable Backup Exec Retrieve indexing and

there are no Index Servers available from the drop-down

list, you need to first install Index Server on a computer.

Index Server

5 Click OK.

The new destination is listed in the Destination tab of the Manage page.

Editing recovery point destination network credentials

You can change an existing recovery point destination's network credentials that

you have previously defined. The change takes effect when the existing connection

on the client computer is closed (usually by restarting).

Note: To edit the destination path, you must define a new destination.

See “Creating recovery point destinations” on page 80.

To edit recovery point destination network credentials

1 On the Manage page, in the right pane, click the Destinations tab.

2 Select a destination in the table with a network path.

Local folder destination paths are not editable.
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3 On the Tasks menu, click Edit.

4 In the Network credentials group box, type the new user name and password

to the destination.

5 If necessary, edit the Backup Exec Retrieve indexing settings.

6 Click OK.

Deleting recovery point destinations

You can delete previously defined destinations that you no longer use.

See “Editing a backup job” on page 127.

See “About managing recovery point destinations” on page 80.

Note: Any backup jobs (including Backup Exec for Windows Servers jobs that you

created from within Backup Exec System Recovery Manager) that use a recovery

point destination that you intend to delete must be edited to specify a new

destination. You should do this before you delete the old destination. Otherwise,

backup failures will occur.

To delete recovery point destinations

1 On the Manage page, in the right pane, click the Destinations tab.

2 Select a destination path in the table.

3 On the Tasks menu, click Delete.

4 Click Yes to confirm the deletion.

Viewing the properties of a recovery point destination

You can review all computers, backup jobs, and Backup Exec for Windows Servers

jobs that are assigned to a selected destination.

See “Configuring a Backup Exec for Windows Servers backup job” on page 135.

See “About managing recovery point destinations” on page 80.

To view the properties of a recovery point destination

1 On the Manage page, in the right pane, click the Destinations tab.

2 Select a destination path in the table.

3 On the Tasks menu, click Properties.
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4 In the left pane, click an assignment to view the accompanying results on the

right pane.

5 Click Close.

Editing server and client settings
You can customize certain aspects of the Backup Exec System Recovery Manager

console and server to suit your work environment.

Changes to options remain in effect (even after you exit Backup Exec System

Recovery Manager) until you change them again.

See “Ports used by Backup Exec System Recovery Manager ” on page 173.

Note: You can reconfigure TCP/IP port numbers to enable successful

communication with a new installation of Backup Exec System Recovery Manager,

or with existing managed computers.

See “Configuring TCP/IP ports for a new installation of Backup Exec System

Recovery Manager” on page 175.

See “Configuring TCP/IP ports for an existing managed computer” on page 177.

To edit server and client settings

1 Do one of the following:

■ On the Windows Start menu, click All Programs > Symantec > Backup

Exec SystemRecovery > Symantec Backup Exec SystemRecovery

Manager, and then click Settings. Go to step 4.

■ In the Backup Exec System Recovery Manager console, on the Tools menu,

click Options.

2 In the left pane, click Connectivity.

3 In the right pane, click Edit.
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4 Specify the following connection settings:

This port uses the console to communicate with Web Services

by way of https.

Secure Server port

If you are unable to connect to the secure port, you can set an

unsecure server port. The console uses the unsecure port to

communicate with Web Services by way of http.

See “Configuring TCP/IP ports for a new installation of Backup

Exec System Recovery Manager” on page 175.

The default is 8080 (unsecure).Port for viewing

log files
This port is used for viewing the log files created by Backup Exec

System Recovery Manager.

The default is 763 (unsecure).Default

Management

Control port
Note: This option is only available when you are logged on to

the Backup Exec System Recovery Manager console.

When a request comes from the Backup Exec System Recovery

Manager server (for example, to run a job or update the status

of computers), the server uses the client port number to "wake

up" the client computer by the Management Control component.

The client computer pulls the request from the server and pushes

a response back to the server. Any resulting information or status

is reflected in the console interface.

You can change the client port number if the firewall blocks it

or if you want to use a different port for selected computers only.

Use Client Options to change the client port number for one or

more computers, or for entire groups of computers.

See “Setting client options for computers” on page 153.

Default is 764 (unsecure).Default Indexing

Server port
Note: This option is only available when you are logged on to

the Backup Exec System Recovery Manager console.

Backup Exec Retrieve uses this port on the Backup Exec System

Recovery Manager server to communicate with the Windows

Server 2003 computer where Indexing Server is installed.

Click Tools >Options > Backup Exec SystemRecovery.

Select a server name and then click Configure to change the

server's port.
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Specify the number of minutes of inactivity before the current

session prompts you to log back on to the server or remain logged

off.

Session time-out in

minutes

Updates the job progress at the specified interval for all

computers. If Automatically refresh the console is checked (see

below), it updates all objects on the Manage and Home page.

Console refresh

interval in seconds

Check this option to update the job progress on the Manage and

Monitor pages at the console refresh interval that is set above.

If you uncheck this option, job progress is only updated on the

Monitor and Home page.

Automatically

refresh the console

5 Click OK.

About managing roles-based user accounts
Backup Exec System Recovery Manager includes ten pre-existing roles with various

levels of privileges. You can assign users to one of these roles to specify the level

of interaction they can have when they log on to the console.

Assigning different roles to console users provides a more granular method for

an administrator to permit or block features and functionality in the product,

based on a user's responsibilities.

You must have System Admin privileges to assign roles to users.

Table 4-2 describes the user account roles and privileges.

Table 4-2 User account roles and privileges

DescriptionRole name

This role gives the user full access to all features and functionality in

Backup Exec System Recovery Manager.

Any user assigned to the System Admin role can delete other users

including those who are also assigned the System Admin role. However,

you cannot deleted currently logged on users until they log off.

You can change the name of any user including the currently logged on

user.

You can assign multiple user accounts using System Admin privileges.

You can manage the accounts for each instance of the Backup Exec System

Recovery Manager console.

System Admin
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Table 4-2 User account roles and privileges (continued)

DescriptionRole name

This role allows the user to view information about various aspects of

managed computers. Users have no write access to the server, database,

or clients, so they cannot make any configuration changes.

Users can view the following:

■ Home, Manage, Reports, and Shortcuts pages

■ Properties of any job, computer, computer group, or backup location

■ Any pending jobs

■ Export data in tables

Read-only

Access

This role allows the user to run the tasks that affect managed computers.

Users have no ability to configure backup jobs, computers, groups of

computers, or backup locations.

In addition to read-only privileges, this role also allows the user to do the

following:

■ Access the Monitor page

■ Run jobs now

■ Remove jobs from computers

■ Troubleshoot

■ Disable or enable jobs

■ Request updated client information for computers or groups

■ Process pending jobs for computers or groups

■ Add licenses to computers

Execute

Access

This role does not allow users to log on to the console. They can, however,

log on to the Backup Exec System Recovery Download Center Web page

to download any Easy Installers.

This role uses "download" as the default user name and password. It is

recommended that you change the default user name and password before

you assign this role to any Easy Installers.

See “Deploying an Easy Installer by administrators” on page 68.

Download All

There are six roles in this group. A role has restricted download access to

Easy Installers that are assigned to a particular download group (for

example, Download B).

Download A –

Download F

Creating a user account

When you are logged on to the server through the console with System Admin

privileges, you can create user accounts (on the same Backup Exec System Recovery
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Manager server) with a user name and password. You can also assign roles to

users that best fit their level of responsibility.

See “About managing roles-based user accounts” on page 86.

To create a user account

1 On the Tools menu, click Options.

2 In the left pane, click Users.

3 Click Add.

4 In the Add User dialog box, do the following:

■ Type the user name that you want associated with its assigned roles.

■ Type the password twice.

■ In the Assigned Roles group box, check the roles that you want to assign

to the user.

5 Click OK.

The account is sent to the Backup Exec System Recovery Manager database.

Editing a user account

When you are logged on to the console with System Admin privileges, you can

change the user name, password, or assigned role of an existing account.

To edit a user account

1 On the Tools menu, click Options.

2 In the left pane, click Users.

3 In the Users list box, select a user name that you want to change.

4 Click Edit.

5 In the Edit User dialog box, type a new user name, or type a new password

twice.

If you want to change only the user's assigned roles, check the new roles from

the list box; you do not need to also change the password or user name.

6 Click OK.

The user account information is updated in the Backup Exec System Recovery

Manager database.
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Deleting a user account

When you are logged on to the console with System Admin privileges, you can

remove user accounts, including other System Admin user accounts. However,

you cannot delete your own user account while you are logged on, nor can you

delete the accounts of users who are already logged on at other Backup Exec

System Recovery Manager consoles.

To delete a user account

1 On the Tools menu, click Options.

2 In the left pane, click Users.

3 In the Users list box, select a user name.

4 Click Delete.

5 Click Yes to confirm the deletion.

6 Click OK.

Changing the description of a role

You can edit the description of a role to more accurately reflect the privileges that

are assigned to that role. Changing the description helps you to effectively manage

and assign roles to console users. The description appears to the right of the role

name in the software interface.

To change the description of a role

1 On the Tools menu, click Options.

2 In the left pane, click Roles.

3 In the Roles list box, select a role name whose description you want to change.

4 Click Edit.

5 Type a new description for the role in the Description text box.

6 Click OK.

About managing licenses
You can assign or unassign Backup Exec System Recovery licenses to computers

or groups of computers. When you assign licenses, you activate Backup Exec

System Recovery on the client computers and remove the 60-day trial. Unassigning

licenses from client computers returns Backup Exec System Recovery to a 60-day

trial version.
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Use Client Licensing in Backup Exec System Recovery Manager to manage product

licenses and their assignments throughout your organization. Whether you manage

Backup Exec System Recovery servers or desktops, you can view and monitor the

following license-related information:

■ Names of licensed products

■ Numbers of purchased and used licenses

■ Expiration dates of product keys or license files

■ Product keys or serial numbers

You can also do the following:

■ Add and remove product licenses

See “Adding Backup Exec System Recovery licenses to Backup Exec System

Recovery Manager” on page 93.

See “Removing Backup Exec System Recovery licenses from Backup Exec

System Recovery Manager” on page 94.

■ Purchase additional product licenses

See “Assigning Backup Exec System Recovery licenses to computers” on page 90.

See “Unassigning Backup Exec System Recovery licenses from computers”

on page 92.

See “Checking Backup Exec System Recovery license status on client computers”

on page 92.

Besides client product licenses, you can also check the Backup Exec System

Recovery Manager server license from the console. You can do the following in

the Manager Licensing dialog box:

■ View the total number of computers that you are able to manage, and the total

number of computers you currently manage on the server.

See “Checking the license status of the Backup Exec System Recovery Manager

server” on page 95.

■ Add a product key to fully activate a trial version of Backup Exec System

Recovery Manager server.

See “Adding a Backup Exec System Recovery Manager server license ”

on page 95.

■ Purchase additional products.

Assigning Backup Exec System Recovery licenses to computers

Product activation is a technology that protects users from pirated or counterfeit

software by limiting the use of a product to those users who have legitimately
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acquired the product. Activation of Backup Exec System Recovery requires the

addition of a product key (for Backup Exec System Recovery 8.0) or a license file

(for Backup Exec System Recovery 7.0) for each installation of Backup Exec System

Recovery.

See “About adding computers to the console” on page 55.

You must activate Backup Exec System Recovery within 60 days of installation;

otherwise the software stops working. You can activate it after the 60 days have

elapsed without having to reinstall the software.

See “Checking Backup Exec System Recovery license status on client computers”

on page 92.

See “About managing licenses” on page 89.

The 60-day evaluation of Backup Exec System Recovery lets you create recovery

points of system and data drives. You can also recover system and data drives and

files.

Depending on the Backup Exec System Recovery version you purchased, you

should have received a product key (for Backup Exec System Recovery 8.0) or a

Symantec License File (.slf) (for Backup Exec System Recovery 7.0). You add the

product key or install the license file on client computers.

To assign Backup Exec System Recovery licenses to computers

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

You may find it helpful to use the Filter bar to sort the computers by

operating system. This feature helps you assign licenses to the correct

edition of Backup Exec System Recovery.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

2 On the Tasks menu, click Assign > Licenses.

3 In the Available licenses list box, select a license name.

If you selected computers or groups with a mixture of operating systems (for

example, Windows Vista, Windows Server 2008, and Windows XP), you can

only select one particular license file for a given operating system and Backup

Exec System Recovery version.

4 Click Assign.

91Configuring Backup Exec System Recovery Manager
About managing licenses



Unassigning Backup Exec System Recovery licenses from computers

When you unassign (or remove) product licenses from client computers, Backup

Exec System Recovery returns to a 60-day trial version. You can continue to

manage the computer as usual until the end of the 60-day trial or until you assign

a product key or a client license file. Unassigned product keys or license files can

be used on other computers that you manage.

See “About managing licenses” on page 89.

To unassign Backup Exec System Recovery licenses from computers

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

2 On the Tasks menu, click Unassign > Licenses.

3 To confirm the unassignment, click Yes.

4 Click OK.

Checking Backup Exec System Recovery license status on client
computers

You can use the Manage page or the Home page to check the license status of

Backup Exec System Recovery on all managed computers.

See “Assigning Backup Exec System Recovery licenses to computers” on page 90.

See “About managing licenses” on page 89.

To check Backup Exec System Recovery license status on client computers

◆ Do one of the following:

■ On the Home page, from the drop-down list in the Status pane, select

License Status forAll Computers. A pie chart is displayed showing the

proportion of all managed computers that have a license, no license, or a

trial license.

■ On the Manage page, in the right pane, click the Computers tab.

On the Filter bar, from the Select columns to view drop-down list, make

sure License is selected. Check the License status column for one of three

status messages.
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A Backup Exec System Recovery license file is installed on

the computer.

Assigned

A Backup Exec System Recovery license file has not been

installed on the computer.

Not Assigned

A Backup Exec System Recovery license file is installed on

the computer and expires on the specified date and time.

Expires on <date>

<time> (<days>

remaining)

■ On the Reports page, in the left pane, click Client Versions or Managed

Computers.

You may need to scroll the right pane to view the License status column.

Adding Backup Exec System Recovery licenses to Backup Exec System
Recovery Manager

When you add client product keys (for Backup Exec System Recovery 8.0) or client

license files (forBackup Exec System Recovery 7.0), the file information is stored

in the Backup Exec System Recovery Manager database. The Product Licensing

dialog box in the console is also populated with the following information:

■ Name and number of each Backup Exec System Recovery product you are

licensed to use

■ Number of currently used product licenses

■ Expiration date of the licenses

■ Product key or serial number of the licenses

See “Removing Backup Exec System Recovery licenses from Backup Exec System

Recovery Manager” on page 94.

See “About managing licenses” on page 89.

To add Backup Exec System Recovery licenses to Backup Exec System Recovery

Manager

1 On the Tools menu, click Options.

2 Do one of the following:

■ In the left pane, click Client Product Keys.

■ Click Add.

■ Enter the product key, and then click OK.

To add Backup Exec

System Recovery 8.0

product keys
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■ In the left pane, click Client License Files.

■ Click Import.

■ Navigate to the Symantec License File (.slf) that you

want to import, and then click Open.

To import Backup Exec

System Recovery 7.0

license files

Removing Backup Exec System Recovery licenses from Backup Exec
System Recovery Manager

Exporting Backup Exec System Recovery licenses gives you the ability to reassign

the licenses to other computers.

When you remove or export a license, the following occurs:

■ All used licenses are removed from the computers that use the file.

■ Backup Exec System Recovery becomes a 60-day trial version on affected

computers.

■ The license file information is removed from the Backup Exec System Recovery

Manager database.

■ The license file information is removed from the list view in the Licensing

dialog box of the console.

■ You can choose to save the file to a new location.

To use the licenses again, you can re-add the product key (or re-import the .slf

file) and assign the licenses to computers as usual.

See “Adding Backup Exec System Recovery licenses to Backup Exec System

Recovery Manager” on page 93.

See “Assigning Backup Exec System Recovery licenses to computers” on page 90.

See “About managing licenses” on page 89.

To remove Backup Exec System Recovery licenses from Backup Exec System

Recovery Manager

1 On the Tools menu, click Options.

2 Do one of the following:

■ In the left pane, click Client Product Keys.

■ In the right pane, select a product name.

■ Click Remove.

■ Click Yes to confirm the product key removal.

To remove Backup Exec

System Recovery 8.0

product keys
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■ In the left pane, click Client License Files.

■ In the right pane, select a product name.

■ Click Export.

■ Navigate to the location where you want to save the

Symantec License File (.slf), and then click Save.

To export Backup Exec

System Recovery 7.0

license files

Checking the license status of the Backup Exec System Recovery
Manager server

You can check the license status of the Backup Exec System Recovery Manager

server to which you are currently logged on. This is helpful if you use a trial version

of the product and need to see the start of the trial and when it expires.

You can also review the total number of computers that the server can manage

and the total number of computers that the server currently manages.

To check the license status of the Backup Exec System Recovery Manager server

1 Do one of the following:

■ On the Help menu, click About. Select the server name in the list box to

review its license status. Go to step 4 below.

■ On the Tools menu, click Options. Go to step 2 below.

2 In the left pane, click Manager.

3 Review the information in the group box.

This information applies only to the Backup Exec System Recovery Manager

server to which you are currently logged on.

4 Click OK.

Adding a Backup Exec System Recovery Manager server license

If you use a trial version of the Backup Exec System Recovery Manager server,

you can use the console to add a Backup Exec System Recovery server product

key and fully activate the software.

See “Starting Backup Exec System Recovery Manager ” on page 41.

To add a product key for the Backup Exec System Recovery Manager server

1 On the Tools menu, click Options.

2 In the left pane, click Manager.
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3 In the right pane, click Product Key.

4 Enter the product key for the Backup Exec System Recovery Manager server,

and then click OK.

If you do not have a Backup Exec System Recovery Manager server product

key, click Purchasemore licenses.

About configuring Backup Exec Retrieve
Figure 4-1 describes the sequence of tasks and processes that must occur before

users can retrieve their own files with Backup Exec Retrieve.

Figure 4-1 Configuring Backup Exec Retrieve
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Configuring Backup Exec Retrieve

1 Indexing server: You must install (by way of an Easy Installer) the Indexing

Server on Windows Server 2003. The Indexing Server creates a table of

contents of all files that are inside the recovery point.

Note: The Indexing Server can only be installed on Windows Server 2003 and

Windows Server 2003 R2 editions. You cannot install an index server on

Windows 2000, Windows XP, or Windows Vista.

See “Downloading an Easy Installer by end users” on page 66.

See “Deploying an Easy Installer by administrators” on page 68.

2 Recovery point destination server: At the time you create the destination, it

is recommended that you specify a location (a network share) other than the

server where the Indexing Server is installed to reduce performance impact.

In the same dialog box, check Enable Backup Exec Retrieve indexing and

specify a computer that has the Indexing Server installed on it.

See “Creating recovery point destinations” on page 80.

Enable indexing for the backup destination as well as for the job. If indexing

is not enabled, indexing will not occur, and it will remove entries from the

index for all jobs, even if the job setting is to index. To enable indexing, from

any page, click Tools > Options. Select the Index Server, and then click Edit.

3 Create backup job: At the time you create the backup job, select the network

share that you chose as the destination for the recovery points. In the Options

dialog box, make sure you check Enable search engine support for Google

Desktop and Backup Exec Retrieve.

See “Creating a backup job” on page 103.

4 Assign backup job to client computers: Assign the backup job to computers

and groups with users who can benefit from retrieving their own files from

recovery points.

See “Assigning a backup job to computers or groups” on page 123.

5 Recovery points are created: The backup job creates recovery points that are

then stored at the chosen destination.
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6 Indexing of recovery points: The indexing server creates indexes of the files

inside recovery points at the destination.

Note: Indexing is a resource-intensive operation that you should consider

when you are planning for deployment. The indexing load will be at its peak

while indexing base recovery point images, such as the first time a storage

location is indexed, with a relatively smaller load when subsequent

incremental recovery points are indexed. It is not feasible to provide precise

guidance for the number of client machines that can be indexed by a single

server, since the actual impact of indexing on a machine will vary based on

the hardware configuration, the amount of data being indexed, and whether

the data resides on local storage or a network share. However, until you can

examine the actual performance in your specific installation, you should plan

for indexing to take minutes for each base image and seconds for each

incremental image.

7 Backup Exec System Recovery Manager server: The indexing results are sent

to the Backup Exec System Recovery Manager server. You can view events,

logs, and edit your server information. Click Tools > Options. Select a server

name to make changes or to view the server's log file.

8 Users retrieve files: When users need to retrieve files, they go to the Backup

Exec Retrieve Web page, search for the files, and then download them.

Non-administrator type users will only see files in their Documents and

Settings folders for which they are an administrator. They will not see all of

the drives and files, such as C$, even if they have file permissions. They would

only see files from the root level down if they have shared access to those

files. Also, non-administrator type users will only see the Documents and

Settings folder if they have ever logged onto the computer that was backed

up, and they are administrators on that server.
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Managing backups

This chapter includes the following topics:

■ About backup jobs

■ Creating a backup job

■ Assigning a backup job to computers or groups

■ Unassigning a backup job from computers or groups

■ Running an existing backup job immediately

■ Running a one-time backup

■ About working with backup jobs

■ About managing recovery points

■ Configuring a Backup Exec for Windows Servers backup job

About backup jobs
You can create backup jobs to automate the creation of recovery points with a

schedule. This method is useful if you want to create independent recovery points

during off-hours when you are not present, or if you want to create a recovery

point set without interrupting the normal flow of work.

You implement a backup job by doing the following:

■ Create a backup job

You specify what to back up, the backup destination where the resulting

recovery points are stored, and when to run the backup (scheduled or manually).

■ Assign a backup job to computers or groups
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You can also specify the compression levels of recovery points, enable security

settings (encryption and password protection) and search engine support for

Google and Backup Exec Retrieve, and many other options that let you customize

each backup according to your business needs.

While the client computer must be turned on to create a recovery point at the

scheduled time, the console does not need to be open for the backup to take place,

nor does a remote user need to be logged on to the computer. However, Windows

must be started on the client computer.

You can temporarily override a backup in Backup Exec System Recovery Manager

to create a recovery point immediately.

See “Running an existing backup job immediately” on page 124.

You can backup databases.

See “Backing up VSS-aware databases” on page 181.

See “About backing up non-VSS-aware databases” on page 183.

To verify that a backup completed as scheduled, you can use the Home page or

Manage page in the console to check the status information, or review the Recovery

Points Report in the Reports page.

Note: Backup Exec System Recovery Manager supports recovery point files saved

directly to a network hard disk or to a local hard disk on the client computer

(including USB or Firewire drives). It also supports saved recovery points that are

stored on the network to tape media using the Configure Backup Exec Job wizard.

Backup Exec System Recovery Manager does not support saving recovery point

files directly to CD or DVD.

See “Configuring a Backup Exec for Windows Servers backup job” on page 135.

Ways to work with recovery points

Table 5-1 describes the advantages and disadvantages of scheduled independent

recovery points or recovery point sets as part of your backup job.

Warning: The full recovery point and all associated incremental recovery points

that make up the recovery point set must be kept together in the same folder. If

files are missing, the recovery point becomes invalid and you cannot restore the

data.
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Table 5-1 Types of scheduled recovery points

Advantages and disadvantagesType

■ A recovery point set is the same as an Independent recovery point except

that it has incremental tracking enabled for the selected drive.

■ This type of backup creates a base recovery point with additional recovery

points that save only the hard disk sectors that have changed since the

creation of the base recovery point or the previous incremental recovery

point.

■ Incremental recovery points are created faster than the first (base)

recovery point and use less storage space than an independent recovery

point.

■ Recovery point sets are ideal when you combine them with a schedule.

■ If you use recovery point sets to protect a hard drive, when you restore

to a given point in time, the full recovery point plus all the incrementals

up to that point in time are used for the restore.

For example, suppose you have a full recovery point with eight incremental

recovery points. You decide to restore to the point in time that the fourth

incremental was taken. When you restore, the full recovery point and the

first four incrementals are used to restore the computer.

■ You can free hard drive space by deleting outdated recovery points and

incremental recovery points.

See “Deleting recovery points within a set” on page 131.

■ When you create a recovery point set, if you select a hidden drive

(partition) and a non-hidden partition in the same backup, the hidden

partition is backed up when a full recovery point is specified; no

incremental recovery points are created.

■ If Recovery point set option is disabled, it is because you have already

assigned a selected drive to an existing backup job and specified Recovery

point set as the recovery point type. You can only have one recovery point

set defined for each drive. Or, you might have selected an unmounted

drive that cannot be part of a recovery point set.

Recovery

point set

■ An independent recovery point creates a complete, independent copy of

the entire selected drive.

■ An Independent recovery point is not associated with incremental recovery

points or Recovery point sets in any way. As such, Independent recovery

points stand on their own and are usually a less complicated method for

protecting your computer than are recovery point sets.

You can take an Independent recovery point of a drive (using Run Backup)

even if that drive is tracked with a Recovery point set.

See “Running an existing backup job immediately” on page 124.

■ This backup type typically requires more storage space.

Independent

recovery

point

You can convert recovery points of a physical computer to a virtual disk.
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See “Converting recovery points to virtual disks” on page 133.

Tips for creating recovery points

The following information may help when you create recovery points:

■ Because the Backup Exec System Recovery Manager server also includes a

database, you should back up the server on a regular basis. You must quiesce

the Backup Exec System Recovery Manager database before backing up so you

do not lose or corrupt data.

See “Backing up the Backup Exec System Recovery Manager server and

database” on page 185.

■ The Backup Exec System Recovery Manager console does not need to be open

for a scheduled backup to start or run. Therefore, after you create a backup

job and assign it to computers, you can exit the console. The client computer

that you manage, however, must be turned on and Windows must be started.

To verify that the creation of a recovery point is in progress, check the status

information on the Monitor page. To verify that a recovery point was made,

you can review the Home page or the Computers tab on the Manage page.

■ To test a backup, click the Backup Jobs tab on the Manage page, and then select

a backup name in the table. Click Tasks > Run Backups. (Make sure that the

backup is assigned to at least one computer. If a backup is assigned to multiple

computers, it runs on each computer.)

See “Running an existing backup job immediately” on page 124.

■ All backup jobs (except any backup jobs you created by running One-time

Backup) are saved in the Backup Exec System Recovery Manager database so

that you can edit or run them later.

See “Running a one-time backup” on page 125.

■ Store recovery points to a network share or to a hard disk on the client

computer other than the primary hard disk C. This practice helps ensure that

you can recover the system in the event that the client's primary hard disk

fails.

■ Do not run a disk defragmentation program on the managed client computer

when a recovery point is being created. Doing so significantly increases the

time it takes to create the recovery point, and it may cause unexpected system

resource issues on the client computer.

■ If you have two or more drives that are dependent on each other, or they are

used as a group by a program like a database service, you should include both

drives in the same backup job. With Backup Exec System Recovery Manager,

you can back up multiple drives simultaneously by selecting two or more drives

in the Define Backup Wizard.
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■ Include multiple drives in the same backup job to reduce the total number of

backups that must be run.

■ Use the Performance feature in Client Options to reduce the impact of backups

on client computers and network performance.

See “Setting client options for computers” on page 153.

■ You should avoid storing recovery points on the Backup Exec System Recovery

Manager server because as the number or size of recovery points grows, you

have less disk space available for regular server use. Save recovery points to

a network location (preferred), or a separate drive to eliminate this problem.

About backing up dual-boot systems

You can back up dual-boot systems, or systems with more than one operating

system, even if you have drives (partitions) that are hidden within the operating

system where you run the product.

When you run a backup, everything on the drive is included in the recovery point,

so it is bootable later if you restore it. An exception is if you back up a bootstrapped

operating system. In such cases, you must back up–and then restore–every drive

with operating system boot information for your computer to boot in the same

way from a restored system as it did from the original configuration.

Note: You should not create incremental recovery points of shared data drives if

Backup Exec System Recovery is installed on both operating systems, and they

are both set to manage the shared drive.

You may encounter issues if you try to use Backup Exec System Recovery LightsOut

Restore or Backup Exec System Recovery Restore Anyware™ on a dual boot system.

Creating a backup job
You can automate the creation of recovery points with a daily, weekly, or monthly

schedule. If you create a recovery point set (instead of an independent recovery

point), you can also specify that certain events, like logging on or off of a computer,

create incremental recovery points.

See “Ways to work with recovery points” on page 100.

By default, file names for scheduled independent recovery points or recovery

point sets are appended with 001.v2i, 002.v2i, and so forth. File names for

incremental recovery points within a recovery point set are appended with

_i001.iv2i, _i002.iv2i, and so forth. For example, if your base recovery point were
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called C_Drive001.v2i, the first incremental recovery point would be called

C_Drive001_i001.iv2i.

By default, the name of the computer (where the backup occurs) is appended to

the recovery point file name.

Each backup job that you create is added to the Backup Jobs tab on the Manage

page.

See “Viewing the properties of a backup job” on page 127.

To create a backup job

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one computer in the table.

■ In the right pane, on the Computers tab, select two or more computers in

the table.

The backup that you create will be automatically assigned to all of the

computers that you selected.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

The backup that you create is automatically assigned to all of the

computers in the groups that you selected.

2 Do one of the following:

■ If you selected one or more computers, on the Tasks menu, click Assign

NewBackup Job to Computers.

■ If you selected one or more groups, on the Tasks menu, click AssignNew

Backup Job toGroups.

3 Do one of the following:

■ If you are defining a backup job for one computer, select one or more

drives that you want to back up. If you want to select any hidden and

unmounted drives, check ShowHiddenDrives.

■ If you are defining a backup job for two or more computers, click All

MountedDrives on Selected Computers to protect all drives that exist

on the client computers (excluding hidden and unmounted drives).

■ If you are defining a backup job that will backup certain drive letters on

the selected client computers, click ByDrive Letter, and then select the

drive letters that you want.

To view which client computers have the selected drive letters, click Show

Details.
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Sometimes a selected drive letter is not available for backing up on a particular

client computer. This is usually because the drive has been deleted or the

entire hard disk has been removed from the client computer since Backup

Exec System Recovery was installed. In such cases, when the recovery point

is created, it does not include the drive.

4 On the Recovery Point Type panel, click the recovery point type that you

want to create, and then click Next.

5 Select the destination where you want to store the recovery points by doing

one of the following:

■ From the drop-down list, select a local target folder on the client computer.

If a local target folder is not available from the drop-down list, clickCreate

newdestination to specify the path to the folder.

■ From the drop-down list, select a target folder on a network share. If a

network share is not available from the drop-down list, click Create new

destination to specify the UNC path to the folder. You need to specify the

user name and password to access the location with create, read, and write

privileges.

If there is not be enough space at the destination where the recovery point

is stored, the backup fails and an error is reported in the Home Page view.

You should avoid storing recovery points on the Backup Exec System Recovery

Manager server because as the number or size of recovery points grows, you

have less disk space available for regular server use. When you save recovery

points to a separate drive or a network location, it eliminates this problem.

See “About destination options for recovery points” on page 107.

6 On the Options panel, specify the recovery point options that you want.

See “About general options for creating recovery points” on page 111.

7 Click Advanced, specify the advanced options that you want, including any

security options, and then click OK.

See “About advanced options for creating recovery points” on page 113.

8 Click Next.
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9 If appropriate, specify a command file (.exe, .bat) from each drop-down list

to run during a particular stage in the recovery point creation process, and

then specify the amount of time (in seconds) that you want the command to

run before it is stopped.

See “About running command files during a back up” on page 116.

See “Creating a cold recovery point automatically” on page 184.

To add command files to the drop-down lists, clickAddorRemoveCommand

Files. Command files are copied and stored on the Backup Exec System

Recovery Manager server.

10 Click Next.

11 Check the scheduling options for how you want the backup job to run when

it is assigned to computers. The available scheduling options depend on the

backup type you selected at the start of the wizard.

See “About schedule options for creating recovery points ” on page 118.

Specify the frequency and time for creating a new recovery

point set, and then continue with next step. The default is a

Monthly schedule.

You can also click Advanced if you want to apply progressive

scheduling options to the backup job.

For example, you can do the following:

■ Use event triggers to automate the creation of incremental

recovery points.

■ Specify the amount of time to distribute the creation of

recovery points from all the computers where the backup

job is being deployed.

■ Specify options to have the job run more than once per day.

When you are finished selecting Advanced scheduling options,

click OK, and then continue to the next step.

If the backup type is

recovery point sets

Select No schedule if you intend to run the backup job on

assigned computers any time you want using the Run Backups

feature.

See “Running an existing backup job immediately” on page 124.

Otherwise, select the backup frequency and time for creating

new independent recovery points, and then continue to the

next step. The default is a Weekly schedule.

If the backup type is

independent recovery

points

12 Click Next.
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13 In the Completing the Define Backup Wizard dialog box, review the options

that you have selected.

14 To add the backup job to the Backup Jobs tab on the Manage page, clickFinish.

The backup appears in the Backup Jobs tab of the Manage page. If you defined

the backup without selecting any computers or groups first, you can now

assign the backup.

See “Assigning a backup job to computers or groups” on page 123.

About destination options for recovery points

When you define or schedule a backup job, you can save recovery points to a

network share, or to a local drive, USB drive, or FireWire drive on the client

computer.

Note: You should avoid storing recovery points on the Backup Exec System

Recovery Manager server. As the number or size of recovery points grows, you

have less disk space available for regular server use. When you save recovery

points to a separate drive or a network location, this problem is eliminated. Also,

if you decide to store recovery points on the client computer, store them to a

secondary hard disk and not the primary hard disk C. This practice helps ensure

that you can recover the system in the event that the client's primary hard disk

fails.

Table 5-2 shows the advantages and disadvantages of different storage locations

for recovery points.
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Table 5-2 Recovery point storage locations

DisadvantagesAdvantagesLocation

■ Uses valuable drive space

■ Vulnerable to complete

loss if the hard drive fails

■ Fast recovery point

creation

■ Can schedule

unattended recovery

points

■ Inexpensive because

drive space can be

repeatedly overwritten

■ Computer laptop users

can continue to back up

even if they are

disconnected from the

network.

Local hard drive on client

computer

See “About recovery points

stored in a local folder on the

client computer” on page 111.
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Table 5-2 Recovery point storage locations (continued)

DisadvantagesAdvantagesLocation

■ Must have supported NIC

drivers to restore from

Symantec Recovery Disk

■ Must understand and

assign the appropriate

rights for the users who

will create recovery

points and restorations

■ Computer laptop users

cannot continue to back

up if they are

disconnected from the

network.

■ Fast recovery point

creation

■ Can schedule

unattended recovery

points

■ Can define and save

storage locations for

reuse. See “About

managing recovery

point destinations”

on page 80.

■ Inexpensive because

drive space can be

repeatedly overwritten

■ Protection from local

hard drive failure

■ Location can be backed

up by Backup Exec

Continuous Protection

Server. Or, it can be

backed up to tape media

using the Configure

Backup Exec Job wizard,

available in Backup

Exec System Recovery

Manager.

■ Recovery points can be

indexed for simplified

and quick file retrieval

■ You can choose to

distribute the backup

evenly across a

specified amount of

time

Network share (recommended)

See “About recovery points

stored on a network

destination” on page 110.
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Table 5-2 Recovery point storage locations (continued)

DisadvantagesAdvantagesLocation

■ Additional expense for

the drive itself

■ May need to recreate the

Symantec Recovery Disk

to ensure that the correct

storage device drivers are

available when you do a

restore

■ Fast recovery point

creation

■ Can schedule

unattended recovery

points

■ Inexpensive because

drive space can be

repeatedly overwritten

■ Off-site storage is

possible

■ Reserves hard drive

space for other uses

USB or FireWire drive (local on

the client computer)

About recovery points stored on a network destination

You can choose to store recovery points on a selected network destination. To do

this, you need to specify the UNC path (\\server\share\folder) to the folder on the

network where you want to store the recovery points. Alternatively, you can click

Browse to navigate to the appropriate network share.

You also have the option to create a subfolder (checked by default) for each

computer's recovery points at the network destination. If you uncheck this option,

all recovery points for all computers assigned to the backup job are stored at the

root of the network destination.

See “About managing recovery point destinations” on page 80.

Because recovery point file names are unique and include the name of the

computer, you can use the same network storage location for multiple computers

or for groups of computers you have created in the console.

The user name that you enter needs read-write access to the network folders

where the recovery points are stored. The product uses this logon information to

access the network when you create a recovery point.

Note: You should avoid storing recovery points on the Backup Exec System

Recovery Manager server because as the number or size of backups grows, you

have less disk space available for regular server use. When you save recovery

points to a separate drive or a network location, the problem is eliminated.
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About recovery points stored in a local folder on the client
computer

You can store recovery points locally by specifying a drive and folder (for example,

E:\Data_RPoints\) on the hard drive of the client computer.

Warning: Saving recovery points to a network share or to a secondary hard disk

on the client computer is highly recommended.

While you can save recovery points to the same drive that you are backing up, it

is not recommended for the following reasons:

■ If the computer suffers a catastrophic failure, such as the failure of a primary

hard drive, you will not be able to restore the recovery point you need. Such

occurrences can happen even if you save the recovery point to a different drive

on the same hard disk.

■ As the number or size of recovery points grows, you have less disk space

available for regular use.

■ The recovery point itself is included in subsequent recovery points of the drive.

As a result, the size of recovery points increases exponentially over time.

Recovery points are stored on the computer itself, not on the computer where

you are running the Backup Exec System Recovery Manager console.

About general options for creating recovery points

Table 5-3 describes the general options that are available for recovery points.

Table 5-3 General options

DescriptionSetting

Type a new name in the text box for the backup job. Otherwise, you

can use the default name that appears.

Name
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Table 5-3 General options (continued)

DescriptionSetting

When you define a schedule for a backup job, you can choose the

compression level for the recovery points.

When a recovery point of a drive is created, compression results may

vary, depending on the types of files on the drive.

The following compression options are available:

■ None

This is the best choice if storage space is not an issue. However, if

the recovery point is saved to a busy network drive, the use of high

compression may be faster than no compression because less data

needs to be written across the network.

■ Standard (recommended)

(Default) Uses low compression for a 40% average data compression

ratio on recovery points.

■ Medium

Uses medium compression for a 45% average data compression

ratio on recovery point files.

■ High

Uses high compression for a 50% average data compression ratio

on recovery point files. High compression is usually the slowest

method.

When a high compression recovery point is created, CPU usage

may be higher than normal. Other processes on the computer may

also be slower. To compensate, you can adjust the operation speed

of the backup process. Speed adjustments may improve the

performance of other resource intensive applications that you are

running at the same time.

See “Setting client options for computers” on page 153.

Compression

Select this option to determine whether a recovery point or recovery

point set is valid or corrupt immediately following its creation.

For steps on how to verify the integrity of a recovery point long after

it has been created, refer to the Backup Exec System Recovery product

documentation.

Note: When you verify a recovery point, it can approximately double

the time that is required to create the recovery point.

Verify recovery

point after

creation
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Table 5-3 General options (continued)

DescriptionSetting

Select this option to specify the maximum number of recovery points

or recovery point sets that are saved for each drive.

When this limit is reached, each successive recovery point or set is

first created and stored, and then the oldest, previously created

recovery point or set is deleted (including all associated incrementals,

if applicable) from the same storage location.

Be sure you have enough hard disk space to accommodate the number

of recovery points or sets you specify, plus one additional recovery

point or set.

If you run out of hard disk space before the number is reached, the

recurring recovery point process cannot complete successfully, and

a current recovery point or set is not created.

Limit the number

of recovery point

sets saved for this

backup (Recovery

point sets only)

or

Limit the number

of recovery points

saved for this

backup

(Independent

recovery points

only)

Check this option to let your search engine software index all of the

file name that are contained in each recovery point.

By indexing file names, you can then use a search engine of choice to

locate the files that you want to retrieve. Client computers can have

a search engine already installed on their computer, such as Google

Desktop, to search their recovery points. Or, as a System Admin, you

must configure Backup Exec Retrieve in Backup Exec System Recovery

Manager.

See “About configuring Backup Exec Retrieve” on page 96.

See Appendix A: Using a search engine to search recovery points in the

Symantec Backup Exec System Recovery User's Guide for information

about using Google Desktop to retrieve files.

Enable search

engine support for

Google Desktop

and Backup Exec

Retrieve

Check this option to include indexing support for the operating system

and temporary files when a recovery point is created on the client

computer.

Include system

and temporary

files

Type a description of what is included in the backup to help you further

identify the recovery point's contents.

Description

(included in each

recovery point)

About advanced options for creating recovery points

When you define or schedule a backup job, you can set the advanced options for

the recovery points.

Table 5-4 describes the advanced options that are available for recovery points.
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Table 5-4 Advanced options

DescriptionOption

You can split a recovery point into two or more smaller files. This feature

is useful if you create or export a recovery point that you want to copy

to removable media later for safekeeping. The recovery point is split

into smaller, more manageable files. You can then copy the files onto

separate, removable media, such as a DVD or CD.

Note: If Symantec Backup Exec System Recovery creates an .sv2i file

in addition to the .v2i files, you need to save the .sv2i file on the same

media as the first .v2i file.

If you create a recovery point of volumes with thousands of files on a

computer that has low memory, by splitting the recovery point into

smaller segments, it may help speed the process.

If a recovery point is divided into multiple files, the file names for

subsequent files are appended with _S01, _S02, and so forth. For

example, if the default file name were Dev-RBrough_C_Drive.v2i, the

second file name would be Dev-RBrough_C_Drive_S01.v2i, and so on.

Divide into

smaller files to

simplify

archiving

SmartSector technology speeds up the copying process by copying only

hard disk sectors with data. However, in some cases, it may be desirable

to copy all sectors in their original layout, whether or not they contain

data.

If you want to copy both used and unused hard disk sectors, select

Disable SmartSector Copying.

Note: When you select this option, it increases the process time, and

usually results in a larger recovery point file size.

Disable

SmartSector

Copying

Select this option to create a recovery point even if there are bad sectors

on the hard drive. Although most drives do not have bad sectors, the

potential for problems increases during the lifetime of the hard drive.

Ignore bad

sectors during

copy
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Table 5-4 Advanced options (continued)

DescriptionOption

Check this option to set a password on the recovery point that is created.

Passwords can only use standard characters, not extended characters

or symbols. (Use characters with an ASCII value of 128 or lower.)

Warning: Store the password in a secure place. When you access or

restore a password-encrypted recovery point, the product prompts you

for the case-sensitive password. If you do not enter the correct password

or you forget the password, you cannot open the recovery point.

Warning: Symantec has no method for opening encrypted recovery

points.

Users must type this password before they can restore a backup, delete

recovery points within a recovery point set, or convert recovery points

to virtual disks.

For greatest security, recovery point passwords should adhere to the

following general rules:

■ Avoid the use of consecutive characters that repeat (for example,

BBB or 88).

■ Avoid the use of common words you would find in a dictionary.

■ Use at least one number.

■ Use both uppercase and lowercase alpha characters.

■ Use at least one special character like

({}[],.<>;:'"?/|\`~!@#$%^&*()_-+=).

■ Change the password of an existing encrypted recovery point file

after a set period of time with the Archive Recovery Point File feature

in the Recovery Point Browser. See the Backup Exec System Recovery

product documentation for more information about the Recovery

Point Browser.

Use password
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Table 5-4 Advanced options (continued)

DescriptionOption

You can enhance the security of your data by using AES (Advanced

Encryption Standard) to encrypt recovery points that you create or

archive. This encryption level is especially useful if you store recovery

points on a network share and need a high level of security protection

against unauthorized access and use.

You must enter the correct password before you can access or restore

an encrypted recovery point, delete recovery points within a recovery

point set, or convert a recovery point to a virtual disk. Besides bit

strength, the makeup of the password can improve the security of your

data.

Encryption strengths are available for the following levels:

■ Standard (password length is 8 characters or longer)

■ Medium (password length is 16 characters or longer)

■ High (password length is 32 characters or longer)

While higher strengths require longer passwords, the result is greater

security for your data.

You can view the encryption strength of a recovery point at any time

by viewing the properties of a selected backup on the Backup Jobs tab

on the Manage page.

Use AES

encryption

About running command files during a back up

You can use command files (.exe programs with no user interface, .cmd, .bat) and

configure them to run during all phases of a backup. Command files can be used

to integrate with any backup routines that you may be running on the client

computer or to integrate with the applications that may use a drive on the client

computer. These command files can run in the following three different stages

during the creation of a recovery point:

■ Before data capture

■ After data capture

■ After recovery point creation

You can also specify the amount of time (in seconds) that a command file should

be allowed to run.

The most common use for running command files is to stop and restart

non-VSS-aware databases (such as Windows 2000) that you want to back up with

Backup Exec System Recovery.
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See “About backing up non-VSS-aware databases” on page 183.

Note: Any command files that you specify in the Command Files dialog of the

wizard are copied to the Backup Exec System Recovery Manager server (the default

path is \Program Files\Symantec\Backup Exec System

Recovery\Manager\Services\tomcat\webapps\axis\depot\commands\commandFiles.)

When you assign the backup job to client computers, any command files you

specified are also assigned to the backup. Be sure you have the necessary rights

to run each command file.

To use a Visual Basic script file (.vbs) during a backup, you can create a batch file

(.bat) that runs the script. For example, you can create a batch file called stop.bat

that contains the following syntax:

Cscript script_filename.vbs

Make sure that Cscript precedes the Visual Basic script filename.

Warning: The command files that you install and use (such as an .exe) cannot

depend on any user interaction or have a visible user interface while they are

running during a backup. You should test all of the command files you intend to

use, outside of Backup Exec System Recovery, before using them during a backup.

When the backup begins, the command file runs during the specified stage. If an

error occurs while a command file is running, or the command file does not finish

in the time you specified (regardless of the stage), the entire backup is stopped,

the command file is ended (if necessary), and the error information is logged and

displayed.

Table 5-5 describes the three stages of recovery point creation.
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Table 5-5 Recovery point creation stages

DescriptionStage

This stage occurs after a backup has started and before the recovery

point is created. When you run a command during this stage, it lets you

prepare for the recovery point creation process by stopping (or notifying)

any open applications that the drive uses.

Note: If you use this stage option, be sure that the command file has an

error recovery mechanism that is built into it. If the computer has one

or more services that must be stopped at this stage (such as stopping a

non-VSS aware database or a resource intensive application), and the

command file does not contain any form of error recovery, one or more

of the stopped services may not be restarted. An error in the command

file can cause the entire recovery point creation process to end

immediately; no other command files can run.

Before data

capture

This stage occurs after the "virtual disk snapshot" is created. When you

run a command during this stage, you can allow services to safely resume

normal activity on the drive while continuing the recovery point creation

process.

Because the virtual disk snapshot takes only a few seconds to create, the

database is in the backup state momentarily, and results in a minimal

number of created log files.

After data

capture

This stage occurs after the actual recovery point file is created. When

you run a command during this stage, it lets you act on the recovery

point, itself, by copying it to an offline location.

After recovery

point creation

About schedule options for creating recovery points

Table 5-6 describes the schedule options that are available.
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Table 5-6 Recovery point schedule options

DescriptionSetting

If you selected Recovery point set as the backup type, you can specify how

frequently a new recovery point set should be started. Such frequency lets you

control the size of a recovery point set. If you specify Monthly and the backup

is scheduled to run daily, more recovery points are created. However, the

amount of required disk space depends on the amount of data that is written

to the hard drive during that time. You can customize these options further

by clicking Advanced on the Backup Time panel of the wizard.

Your options for starting new recovery point sets include the following:

■ Start new recovery set (base)

■ Weekly

A new recovery point set is created on the first scheduled or manual

backup of the week. Or, if you clicked Custom, a new recovery point set

is created at the specified time on each day of the week that you checked.

■ Monthly

A new recovery point set is created on the first scheduled or manual

back of the month. Or, if you clicked Custom, a new recovery point set

is created at the specified time on each day of the month that you

checked.

■ Quarterly

A new recovery point set is created on the first scheduled or manual

backup every three months from the date when you selected this option.

■ Yearly

A new recovery point set is created on the first scheduled or manual

backup of the year, once a year on the date that you selected this option.

■ Distribute strategy evenly across (minutes)

(This option is available when you click Advanced on the Backup Time panel

in the wizard.) If you are saving recovery points to a network destination,

you have the option to distribute the job evenly across a specified number

of minutes (0-1440) to all computers assigned to the job.

For example, suppose you want to distribute a backup in 60 minutes to 120

computers. The backup would begin on two computers at the indicated start

time, and then two more computers would begin the backup one minute

later, and so forth. The last two computers would begin backing up 60

minutes after the first two computers began their backup.

This option helps you avoid having to run the job at the same start time for

all computers which can sometimes cause a denial of service condition on

the network, the recovery point destination, or both.

Note: If you choose to archive recovery points, you might consider creating

recovery point sets more frequently to keep the size of your recovery point

sets smaller.

Backup

Time
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Table 5-6 Recovery point schedule options (continued)

DescriptionSetting

If you selected Recovery point set as the backup type, your options include the

following:

■ Run more than once per day

Check this option if you want to protect a system or data that changes

frequently.

■ Time between backups

Select the maximum amount of time to elapse before the next backup.

■ Number of times

Specify the number of times that you want the backup to occur,

beginning from the start time.

■ Automatically optimize

This option helps you manage the hard disk of the backup destination.

This is useful if you chose to create more than one incremental recovery

point per day. Recovery points, especially independent recovery points,

can use up disk space. Automatic optimization is a way to minimize the

use of disk space.

Never

No deletion of incremental recovery points is performed.

Every twelve hours

A deletion of incremental recovery points that are 12 hours old (or older)

is performed every 12 hours. Also, after the first incremental of the day

is taken, all incremental files from two days previous are consolidated

to a single file.

Every four hours

A deletion of incremental recovery points that are four hours old (or

older) is performed every four hours. Also, after the first incremental

of the day is taken, all incremental files from two days previous are

consolidated to a single file.

■ Distribute strategy evenly across (minutes)

See the description in the first row (Backup Time) of this table.

Advanced

options
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Table 5-6 Recovery point schedule options (continued)

DescriptionSetting

If you selected Recovery point set as the backup type, you can select the events

that can trigger the automatic creation of incremental recovery points. For

example, at the time you log off of a client computer or install an application,

you can have Backup Exec System Recovery create an incremental recovery

point.

You can specify when a backup occurs for the following types of events:

■ Any application is installed

Creates an incremental recovery point at the time users begin to install a

software application on their computer.

■ Specified applications are launched

Creates an incremental recovery point at the time users run a specified

software application on their computer.

■ Any user logs on to the computer

Creates an incremental recovery point when users log on to Windows on

their computer.

■ Any user logs off from the computer

Creates an incremental recovery point at the moment users log off from

Windows on their computer (but does not shut down Windows).

■ Data added to the drive exceeds

Creates an incremental recovery point when the added data on a drive

exceeds an amount (in megabytes) that you specify.

Event

Triggers–General
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Table 5-6 Recovery point schedule options (continued)

DescriptionSetting

Symantec ThreatCon is Symantec's early threat warning system that gives

people and systems adequate warning in order to protect data and systems

against attack.

You can configure a trigger in a backup job to detect a change in the threat

level whenever client computers are connected to the Internet. When the threat

level meets or exceeds the level you specify, Backup Exec System Recovery

automatically starts a backup job. You can specify a different ThreatCon level

for each backup job.

■ Do Not Monitor – Disable

The backup job will not start when a change in the ThreatCon level is

detected

■ Level 4 – Extreme

Extreme global security threats are in progress

■ Level 3 – High

An isolated security threat is in progress

■ Level 2 – Elevated

Security threats could occur, although no specific threats have been known

to occur

If client computers are not connected to the Internet, then they are not

susceptible to online threats. When they are connected to the Internet at any

time, they become vulnerable. You do not have to enable or disable ThreatCon

Response when client computers go online or offline.

The Symantec Web site includes more information about ThreatCon.

http://www.symantec.com

Event

Triggers–ThreatCon

Response
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Table 5-6 Recovery point schedule options (continued)

DescriptionSetting

If you selected Independent recovery point as the backup type, your scheduling

options include the following:

■ No Schedule

This option saves all of the backup job settings except a schedule. You can

later run the backup job at your convenience using Run Backups or assign

a schedule by editing the backup job.

■ Weekly

(Default) This option creates a new, independent recovery point on each

day of the week that you check, and at the specified time. When you create

independent recovery points one or more times per week, it can require

large amounts of disk storage space.

■ Monthly

This option creates a new, independent recovery point on each day of the

month that you check, and at the specified time.

■ Only run once

This option creates a single, independent recovery point once. The job does

not run again unless you change the date and the time settings by selecting

a new date and time in the future.

See “Running an existing backup job immediately” on page 124.

■ Distribute strategy evenly across (minutes)

See the description in the first row (Backup Time) of this table.

Backup

Time

Assigning a backup job to computers or groups
You can assign backup jobs to computers that have Backup Exec System Recovery

installed.

See “Unassigning a backup job from computers or groups” on page 124.

See “Creating a backup job” on page 103.

When you assign backups to a computer group. all of the computers within that

group have the same backup schedule.

Note:Make sure that any backups you assign to a computer or group do not overlap

in time; otherwise an error occurs. Also, only one recovery point set per drive can

be assigned on a client computer. If you assign a second recovery point set to the

same drive, an error occurs.
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To assign a backup job to computers or groups

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in the table.

3 Do one of the following:

■ On the Tasks menu, click Assign > Computers, and then select one or

more computer names from the table. Click OK.

■ On the Computers tab, select one or more computers in the table. In the

Drag-and-drop Workspace of the console, drag the Backups icon and drop

it onto the Computers icon within the same work space.

■ On the Tasks menu, click Assign >Groups, and then select one or more

group names from the table. Click OK.

■ On the Groups tab, select one or more group names in the table. In the

Drag-and-drop Workspace of the console, drag the Backups icon and drop

it onto the Groups icon within the same work space.

Unassigning a backup job from computers or groups
You can unassign (or remove) one or more backups at once from one or more

selected computers.

To unassign a backup job from computers or groups

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in the table.

3 Do one of the following:

■ On the Tasks menu, click Unassign > Computers, and then select one or

more computer names from the table. Click OK.

■ On the Tasks menu, clickUnassign>Groups, and then select one or more

group names from the table. Click OK.

Running an existing backup job immediately
After you assign one or more backup jobs to computers, you can use Run Backups

to create–on demand–an independent recovery point, a recovery point set, or an

incremental recovery point of the drive's most recent changes. A manual backup

starts immediately.

See “Ways to work with recovery points” on page 100.
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See “Running a one-time backup” on page 125.

Note: To use Run Backups, you must have already created a backup and assigned

it to at least one computer.

To run an existing backup job immediately

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select a computer name in the

table.

■ In the left pane, on the Backup Jobs tab, select one or more backup job

names that are assigned.

Check the Status column in the table to determine if a selected backup job

is assigned.

2 On the Tasks menu, click RunBackups.

3 Do one of the following:

Select the backup jobs that you want to run on the

selected computer, and then click RunBackups.

Click Yes to run the selected backup jobs.

If you selected a computer

name

Click Yes to run the selected backup jobs on all

assigned computers.

If you selected one or more

assigned backup job names

4 Click OK.

Running a one-time backup
You can use One-time Backup to create an independent recovery point. A One-time

backup job is not scheduled. Instead, it is run only once on the computers or groups

that you have selected (it is run immediately after you finish the wizard).

The backup appears on the Backup Jobs tab on the Manage page until the last

client computer finishes running it.

See “Creating a backup job” on page 103.

To run a one-time backup

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computers in

the table.
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■ In the right pane, on the Groups tab, select one or more group names in

the table.

2 On the Tasks menu, click One-TimeBackup.

3 Followed the steps in the Define Backup Wizard, and then click Finish to

begin creating the recovery point.

About working with backup jobs
You can assign a backup to multiple computers, or you can assign multiple backups

(recovery point sets excluded) to a single computer or to groups of computers.

Note:Make sure that any backups you assign to computers or groups do not overlap

in time; otherwise an error occurs. Also, only one recovery point set per drive can

be assigned on a client computer. If you assign a second recovery point set to the

same drive, an error occurs.

After a backup is assigned, the computers create recovery points according to the

schedule in the backup.

After you have defined a backup job, you can organize the backups in the following

ways:

■ Add backup jobs to computers and groups of computers.

See “Assigning a backup job to computers or groups” on page 123.

■ Remove backup jobs from one or more computers.

See “Unassigning a backup job from computers or groups” on page 124.

■ Review the details and settings of an existing backup job.

See “Viewing the properties of a backup job” on page 127.

■ Make changes to an existing backup job.

See “Editing a backup job” on page 127.

See “Editing the schedule of a backup job” on page 127.

■ Change the name of an existing backup job.

See “Renaming a backup job” on page 128.

■ Disable backup jobs on computers.

See “Disabling a backup job on computers” on page 128.

■ Disable backup job schedules on computers.

See “Disabling a backup schedule on computers” on page 129.

■ Delete a backup job.
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See “Deleting a backup job” on page 129.

Viewing the properties of a backup job

You can use Properties for a selected backup job to do the following:

■ View a summary of the options, settings, and the assigned schedule of the

backup job.

■ View the status of the backup job on assigned computers.

■ View a list of all computers that are assigned to the backup job.

To view the properties of a backup job

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name, in the table.

3 On the Tasks menu, click Properties.

4 In the left pane, click a detail or assignment to view the accompanying results

on the right pane.

5 Click Close.

Editing a backup job

You can edit any of the properties and options of a backup job, except the selected

drives that are backed up. The resulting backup job is updated on any computers

that are assigned to it.

To edit a backup job

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in the table.

3 On the Tasks menu, click Edit.

4 Use the Edit backup job Wizard to make any changes that you want to the

backup properties and options.

Editing the schedule of a backup job

Depending on the recovery point type that you create, you can edit the schedule

settings of a backup. The settings include the following:

■ Check (enable) or uncheck (disable) the schedule

■ Backup schedule

■ Recovery point set schedule
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■ Event triggers that automate the creation of recovery points (for recovery

point set backup jobs only)

The resulting schedule is updated on any computers that are assigned to the

backup job.

To edit the schedule of a backup job

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in the table.

3 On the Tasks menu, click Change Schedule.

4 Use the Edit Schedule dialog box to set the options and properties that you

want.

Renaming a backup job

You can change the name of any backup job you have created.

To rename a backup job

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in the table.

3 On the Tasks menu, click Rename.

4 Type a new name for the backup.

5 Click OK.

Disabling a backup job on computers

You can temporarily disable a backup job. The creation of recovery points is

"turned off" on the computers that are assigned to the backup. You enable or "turn

on" the backup later when you want recovery point creation to resume.

To disable a backup job on computers

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in table.

3 On the Tasks menu, click Disable.

To enable the backup job repeat the steps above, but make sure Enable is

selected in step 3.
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Disabling a backup schedule on computers

You can temporarily disable the schedule of a backup so that the creation of

recovery points is reduced on the computers that are assigned to the backup. For

example, any event triggers associated with the backup can still cause the creation

of recovery points despite the schedule being disabled. Also, when a backup

schedule is disabled, you can run the backup manually with the Run Backups

feature.

To disable a backup schedule on computers

1 On the Manage page, in the right pane, click the Backup Jobs tab.

2 Select a backup name in table.

3 On the Tasks menu, click Change Schedule.

4 In the Backup Time dialog box, uncheck Schedule, and then click OK.

To enable the backup schedule repeat the steps above, but make sure Schedule

is checked in step 4.

Deleting a backup job

Deleting a backup job removes it from the console and all client computers to

which you have it assigned. Any recovery points there were created by the backup

job will remain.

To delete a backup job

1 On the Manage page, in the right pane, click the Backup Jobs tab, and then

select a backup name in the table.

2 On the Tasks menu, click Delete.

3 Click Yes.

About managing recovery points
Backup Exec System Recovery includes features to help you manage your backup

data. For example, you can delete recovery points and recovery point sets to

prevent an accumulation of obsolete backup data at the destination. You can also

convert recovery points of a single drive or multiple drives to a VMware Virtual

Disk (.vmdk) or a Microsoft Virtual Disk (.vhd).

See “Viewing existing recovery points” on page 130.

See “Deleting a recovery point set” on page 130.

See “Deleting recovery points within a set” on page 131.
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See “Converting recovery points to virtual disks” on page 133.

Viewing existing recovery points

You can view all recovery points that have been created for computers, groups of

computers, or backup destinations.

See “About managing recovery points” on page 129.

To view existing recovery points

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

■ In the right pane, on the Destinations tab, select one or more destination

paths in the table.

2 On the Tasks menu, click Recovery Points >View.

3 From the drop-down list, select the backup destination where the recovery

points reside.

4 To further organize and refine the results, use the options on the Filter bar

above the table.

Deleting a recovery point set

If you no longer want a particular recovery point set, you can delete it at any time.

After you delete a recovery point set, access to files or system recovery from that

point in time is no longer available.

See “About managing recovery points” on page 129.

You can also delete recovery points within a set.

See “Deleting recovery points within a set” on page 131.

To delete a recovery point set

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.
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■ In the right pane, on the Destinations tab, select one or more destination

paths in the table.

2 On the Tasks menu, click Recovery Points >Delete.

3 From the drop-down list, select the backup destination where the recovery

points reside.

This step is only necessary if you selected multiple names or paths from a

tab in Step 1.

4 Do one of the following:

■ In the list box, select a recovery point set that contains one or two recovery

points.

■ In the list box, select a computer name that contains one or two recovery

points.

5 Click Delete on the toolbar.

6 To confirm the deletion of the set, click Yes, and then click OK.

Deleting recovery points within a set

The base recovery point and all of its incrementals that are taken up to a

point-in-time are required whenever you want restore to a specific point in time.

Depending on the duration of the backup, there can be a large accumulation of

incremental recovery points. You can reduce the amount of needed storage space

for the recovery point set by deleting multiple incremental recovery points within

a set. (The base recovery point and the first and last incremental recovery points

are required for a restore and cannot be deleted.) Deleting recovery points within

a set consolidates the data only, it does not delete data.

If the backup you defined includes the assignment of a password (as specified in

the Advanced Options dialog box of the Assign a New Backup Job Wizard), you

may be prompted to type the password to complete the operation.

See “Creating a backup job” on page 103.

Depending on the number of incremental recovery points that you delete,

additional memory may be required to restore or browse a consolidated

incremental recovery point. Additionally, when you delete recovery points over

the network, it may significantly increase network traffic.
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Note: Be careful about which recovery points you choose to delete. For example,

suppose a user created a new document that was captured in the third recovery

point in your recovery points list. The remote user deletes the file accidentally,

at which time the fourth recovery point captures the deletion. The user could lose

the file permanently if you delete the third recovery point.

See “About managing recovery points” on page 129.

You can also delete an entire recovery point set.

See “Deleting a recovery point set” on page 130.

To delete recovery points within a set

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

■ In the right pane, on the Destinations tab, select one or more destination

paths in the table.

2 On the Tasks menu, click Recovery Points >Delete.

3 From the drop-down list, select the backup destination where the recovery

points reside.

This step is only necessary if you selected multiple names or paths from a

tab in Step 1.

4 In the list box, select a computer that has three or more recovery points in

the list box.

5 On the toolbar, click Delete Points.

6 Do one of the following:

■ In the list box, select a recovery point set that contains three or more

recovery points.

■ In the list box, select a computer name that contains three or more

recovery points.

7 Do one of the following:

■ To delete all but the first and the last recovery point in the set, click

Automatic, and then click OK.

■ ClickManual, and then clickOK. Select the recovery points that you want

to delete from the list, and then click Delete.
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The first and the last recovery points in the set cannot be deleted.

■ Click Delete all recovery points in the set, and then click OK. To confirm

the deletion, click Yes.

Converting recovery points to virtual disks

You can use Backup Exec System Recovery Manager to convert the recovery points

of a physical computer to a VMWare Virtual Disk (.vmdk) or a Microsoft Virtual

Disk (.vhd). When you convert recovery points to virtual disks, it has the following

benefits:

■ It is useful in the event that the physical hardware on the client computer

fails.

■ You avoid losing the services on the physical computer (for example,

performing a hot swap of a service from a physical to virtual environment).

■ It is excellent for testing and evaluation purposes.

Virtual disks that are created from recovery points are supported by the following

platforms:

■ VMware GSX Server 3.1 and 3.2

■ VMware Server 1.0

■ VMware ESX Server 2.5 and 3.0

■ VMware Infrastructure 3

■ Microsoft Virtual Server 2005 R2

See “About managing recovery points” on page 129.

To convert recovery points to virtual disks

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer name in the table.

3 On the Tasks menu, click Convert to Virtual.

4 Do one of the following:

■ Click Convert recovery points for an entire computer to virtual disks.

From the date drop-down list, select the date of a recovery point. Based

off of the recovery point date, check the drives that you want to convert.

■ Click Convert a single recovery point to a virtual disk. From the list box,

select a recovery point for a single drive that is based on the date or size

when it was created.

5 Click Next.
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6 From the Virtual disk format drop-down list, select the virtual disk file format

that you want to use.

7 Do one of the following:

Click Create newdestination.

■ Type a UNC path to a network share.

■ Type the IP address path to a network share.

■ Type a local folder path. The local folder path you

specify is relative to the managed computer; it is not

the folder path on the computer where you are

running the Backup Exec System Recovery Manager

console. Local folder paths do not get indexed by the

Backup Exec Retrieve indexing server; only network

share paths.

If you typed a path to a network share, set the proper

network credentials, and then click OK.

To define a new destination

for the resulting virtual

disk

From the drop-down list of predefined locations, select

the location where you want to save the virtual disk, and

then click OK.

To use an existing

destination for the

resulting virtual disk

Check this option if you want to divide the virtual disk

file into smaller files.

For example, you can use this option if you need to copy

the virtual disk to a FAT32 hard drive, or if you want to

copy the virtual disk files to a DVD but the size is larger

than the DVD allows.

Split into 2GB files

8 To change the file name of the virtual disk, click Rename, and then type a

new file name.

You do not need to add the file extension. The extension is automatically

appended to the file name, based on the virtual disk format you selected. (The

virtual file name is based on the physical disk that the drive was a part of.)

9 Click Next.

10 Review the options you have selected for the conversion, and then clickFinish.
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Configuring a Backup Exec for Windows Servers
backup job

Using Backup Exec System Recovery Manager, you can create backup jobs that

back up client computers, and then store the resulting recovery points on a network

share (the recovery point storage location). You can then back up (to tape, for

example) the recovery point location using the Configure Backup Exec Job Wizard

within Backup Exec System Recovery Manager. This wizard is a finite version of

the full Symantec Backup Exec for Windows Servers command line applet.

For complete documentation on the various script file switches and entries that

are used in the wizard, refer to the Backup Exec for Windows Servers Command

Line Applet User's Guide for the version you have installed (10d or 11d).

Symantec Backup Exec for Windows Servers must already be installed and started

before you can create a backup using the Configure Backup Exec Job Wizard in

Backup Exec System Recovery Manager.

The first time you configure a Backup Exec for Windows Servers job, certain files

must be imported onto the Backup Exec System Recovery Manager server. These

files are necessary to integrate Backup Exec System Recovery Manager with the

version of Symantec Backup Exec for Windows Servers that you have installed.

See “Importing Backup Exec for Windows Servers files” on page 137.

When you are finished with the wizard, the resulting job is stored on the Backup

Exec for Windows Servers server and appears in the Backup Exec for Windows

Servers Administration Console. You can use the Backup Exec System Recovery

Manager console to view existing Backup Exec for Windows Servers backup jobs

that you have created.

See “Viewing existing Backup Exec for Windows Servers backup jobs” on page 136.

To edit the job, use the Backup Exec for Windows Servers Administration Console.

Note: Backup Exec 11d for Windows Servers files are backward compatible with

Backup Exec 10d for Windows Servers. Therefore, you can configure, run, and

delete backup jobs on either version. However, Backup Exec 10d for Windows

Servers files are compatible with version 10d only.

To configure a Backup Exec for Windows Servers backup job

1 On the Manage page, in the right pane, click the Destinations tab.

2 Do one of the following:

■ On the Tasks menu, click BackupExec forWindowsServers >Configure.
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■ Select a network destination path in the table, and then clickBackupExec

forWindows Servers > Configure.

See “Creating recovery point destinations” on page 80.

3 If the Import Backup Exec for Windows Servers files dialog box appears, select

the product version whose files you want to upload to the Backup Exec System

Recovery Manager server.

If you have already imported the necessary files for the version you are

running, you can go to Step 5.

4 In the Location text box, specify the folder path to the requested Backup Exec

for Windows Servers files, and then click Next.

5 Do one of the following:

■ To make changes to your selections, click Back.

■ Review the listed product and files, and then click Finish to copy the files

to the server.

The Backup Exec Definition Properties dialog box appears.

6 Specify the source, destination, and settings options.

7 When you finish, click RunNow.

Viewing existing Backup Exec for Windows Servers backup jobs

You can view all of the current Backup Exec for Windows Servers jobs that you

configured using the Backup Exec System Recovery Manager console. You can

review the job names, when they were last updated, and the details of a selected

job. To edit the details of a job, use the Backup Exec for Windows Servers

Administration Console.

You can also delete selected jobs from the job view.

To view existing Backup Exec for Windows Servers backup jobs

1 On the Manage page, in the right pane, click the Destinations tab.

2 Select a destination path in the table.

3 On the Tasks menu, click Backup Exec forWindows Servers >View.

4 Select a job name to review its associated job details.

5 Click Close.
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Deleting a Backup Exec for Windows Servers backup job

When you delete a Backup Exec for Windows Servers job, it is removed from the

Backup Exec Windows server, and from the Backup Exec System Recovery Manager

server. Also, the network destination for the recovery points is no longer backed

up by that particular job.

To delete a Backup Exec for Windows Servers backup job

1 On the Manage page, in the right pane, click the Destinations tab.

2 Select a Backup Exec for Windows Servers destination path in the table.

To identify Backup Exec for Windows Servers jobs, check the Status column

in the table.

3 On the Tasks menu, click Backup Exec forWindows Servers >Delete.

4 If you selected a destination path in Step 2 that contained two or more jobs,

select a job name that you want to delete, and then clickDeleteJob. Otherwise,

go to the next step.

5 Specify the following settings.

Specify the IP address or UNC path (for example,

\\server_name\share_name) where the Backup Exec for Windows server

is located.

Server

name

Type the user name for an account that has administrative rights on the

Backup Exec for Windows server.

User

name

Type the password for an account that has administrative rights on the

Backup Exec for Windows server.

Password

6 Click OK.

Importing Backup Exec for Windows Servers files

The first time you configure a Backup Exec for Windows Servers job, certain files

must be imported onto the Backup Exec System Recovery Manager server. These

files are necessary to integrate Backup Exec System Recovery Manager with the

version of Backup Exec for Windows Servers that you have installed. However, if

you upgrade from Backup Exec 10d for Windows Servers to version 11d, you can

import the necessary files.
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Note: Backup Exec 11d for Windows Servers files are backward compatible with

Backup Exec 10d for Windows Servers. Therefore, you can configure, run, and

delete backup jobs on either version. However, Backup Exec 10d for Windows

Servers files are compatible with version 10d only.

To import Backup Exec for Windows Servers files

1 On the Manage page, in the right pane, click the Destinations tab.

2 On the Tasks menu, clickBackupExecforWindowsServers>ImportBackup

Exec forWindows Servers files.

3 In the Location text box, specify the folder path to the requested Backup Exec

for Windows Servers files, and then click Next.

4 Do one of the following:

■ To make changes to your selections, click Back.

■ Review the listed product and files, and then click Finish to copy the files

to the server.

Deleting Backup Exec for Windows Servers files

If you no longer need or use them, you can delete imported Backup Exec for

Windows Servers files from the Backup Exec System Recovery Manager server.

To delete Backup Exec for Windows Servers files

1 On the Manage page, in the right pane, click the Destinations tab.

2 On the Tasks menu, clickBackupExec forWindowsServers>DeleteBackup

Exec forWindows Servers files.

3 To confirm the deletion, click Yes.
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Recovering files, folders, or

entire drives

This chapter includes the following topics:

■ About recovering a drive

■ About Symantec Backup Exec Retrieve

■ About recovering files or disks using Symantec pcAnywhere

About recovering a drive
You can use Recover Drive to remotely recover a selected partition on the client

computer's hard disk.

For example, if a client computer loses data on a secondary drive (a drive other

than the system drive where the Windows operating system is installed), you can

use an existing recovery point of that drive to restore the data.

Additionally, you can use LightsOut Restore to recover an entire system (or

primary) drive as long as its file system is intact and the computer is still running.

Otherwise, you must manually boot the computer into the Symantec Recovery

Environment to recover the drive (or manually boot the computer using the

Symantec Recovery Disk).

When LightsOut Restore is installed on client computers, a customized version

of the Symantec recovery environment is installed directly to the file system on

the system partition. When a system recovery is initiated from the Backup Exec

System Recovery Manager console (using the Recover Drive feature), the client

computer reboots directly into the Symantec recovery environment using the

files that are installed on its system partition. The recovery of the system drive

occurs, and the results are reported back to the console.
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See “About installing LightsOut Restore on client computers” on page 140.

Note: LightsOut Restore does not work on a multi-boot client computer (booting

multiple operating systems from the same partition). It only works on the primary

operating system. Also, if the file system becomes corrupt and you are not able

to access the boot menu, LightsOut Restore will not work (you must boot the

computer from the Symantec Recovery Disk CD).

As an additional option, when the recovery environment boots as part of LightsOut

Restore, you can have it can automatically start a pcAnywhere thin host (to enable

or disable this feature, you must edit the Easy Installer that is associated with the

LightsOut Restore package). You can then use pcAnywhere to connect to the thin

host and remotely use the recovery environment to assist you with troubleshooting

or other issues.

About installing LightsOut Restore on client computers

You must install LightsOut Restore (using an Easy Installer, or through the use

of a logon script) before you can perform a remote recovery of a system drive

using the LightsOut Restore capability.

Note:To run the LightsOut Restore feature requires a minimum of 1 GB of memory

on the client computer.

The following is an overview on how to install LightsOut Restore on client

computers.

■ Create a package of LightsOut Restore.

See “Creating packages for an Easy Installer ” on page 56.

■ Create an Easy Installer of the LightsOut Restore package.

See “Creating an Easy Installer ” on page 58.

■ Deploy the LightsOut Restore Easy Installer to client computers.

See “Downloading an Easy Installer by end users” on page 66.

See “Deploying an Easy Installer by administrators” on page 68.

Recovering a drive

To remotely recover a data drive, a current recovery point that includes the drive

to be recovered, must already exist.
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Note: Before proceeding, you may want to inform the user of the client computer

to close any applications and files that may be running or open on the drive that

you are recovering.

Warning: When you recover a remote drive, all of the current data on that drive

is replaced by the data that is contained in the recovery point you use for the

recovery. This means that if a user makes changes to data on the drive after the

date of the recovery point you use for the recovery, such as the creation of a new

file, those changes are lost.

To recover a drive

1 On the Manage page, in the right pane, click the Computers tab, and then

select a computer name whose drive you want to recover.

2 On the Tasks menu, click RecoverDrive.

3 Select a recovery point, and then click Next.

Use the Date, Recovery Point, and Size columns in the table to refine your

choice.

4 Select the target drive (the drive to recover), and then click Next.

If there is not enough free space to restore the recovery point, you can press

the Shift key, and then select multiple, contiguous destinations that exist on

the same hard disk.

5 If the recovery point is password protected, type the password in the Password

text box, and then click OK.

6 Specify the options that you want the recovery to perform.

Determines whether a recovery point is

valid or corrupt before restoring it. If the

recovery point is corrupt, the recovery

process is discontinued.

This option is set by default and

significantly increases the time that is

required for the recovery to complete.

However, it ensures that the recovery

point being restored is valid.

Verify recovery point before restore

Checks the recovered drive for errors after

restoring the recovery point.

Check for file system errors
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Automatically expands the drive to occupy

the destination drive's remaining

unallocated space.

Resize restored drive

Makes the recovered drive the active

partition (the drive the client computer

boots from). Only one drive can be active

at a time. If you recover a secondary

drive–a drive other than the one where

the Windows operating system is

installed–do not check this option.

Set drive active (for booting OS)

Restores the original disk signature of the

hard drive.

This option is recommended for advanced

users.

Restore original disk signature

Click one of the following options:

■ Primary partition: Restore the

recovery point as a primary partition.

■ Logical partition: Restore the recovery

point as a logical partition within an

extended partition.

This option is unavailable when you

recover a non-system drive.

Partition type

Select a drive letter that you want

assigned to the partition.

This option is unavailable when you

recover a non-system drive.

Drive letter

The actual options that are available are dependent on the target drive you

selected earlier.
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7 Click Next to review the recovery options you have selected.

8 Click Finish >Yes to restore the remote drive.

If the Wizard cannot lock the remote data drive to perform the recovery under

Windows (typically, because the drive is in use by a program), it starts the

recovery environment to complete the recovery.

LightsOut Restore must already be installed on the client computer if you

intend to recover a system drive. If LightsOut Restore is not installed on the

client computer at the time you restore the system drive, the recovery fails

and reports the error back to the Backup Exec System Recovery Manager

console.

When the recovery is finished, the computer is restarted automatically.

See “About installing LightsOut Restore on client computers” on page 140.

About Symantec Backup Exec Retrieve
Symantec Backup Exec Retrieve lets end users quickly retrieve their own

documents from recovery points. End users can locate files by doing the following:

■ Searching by filename

■ Browsing to the file by using a path

■ Viewing a list of recently modified or recently deleted files

Files that are modified or deleted since the previous backup are not included

in this list because changes to such files are only identified in subsequent

recovery points.

Downloading selected files restores the selected copy to the end user's computer.

You can link to Backup Exec Retrieve in the Backup Exec System Recovery Manager

console, and on the desktop of each managed Symantec Backup Exec System

Recovery computer. The URL for this link is https://manager

computer:8443/BERetrieve

Before you use Backup Exec Retrieve, you must configure it so that end users can

retrieve their own files.

See “About configuring Backup Exec Retrieve” on page 96.

Features of Backup Exec Retrieve

Table 6-1 describes the features that are available in Backup Exec Retrieve.
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Table 6-1 Backup Exec Retrieve features

DescriptionFeature

Find folders and files by name. Use standard

Windows-like search capabilities to find a

file when the folder or file name is unknown

or only partially known.

Search

Navigate through shared folders to which

you have permissions, and view any of the

files that were backed up. When a file is

located, you can view all stored versions of

that file. Review the date, time, and file size

to determine the version of the file that you

want to retrieve.

Browse

View a list of files that were recently

modified or deleted. Recent activity includes

files from the earliest through the latest

snapshot on record. The file list is sorted in

order by files from today, yesterday, earlier

this week, last week, and two weeks ago.

The Recent Activity list does not show any

files that have been modified or deleted after

the last snapshot was taken.

Recent Activity

View the items you have selected for

retrieval. Remove selected items, unselected

items, select all, or unselect all to make the

appropriate modifications. Unless specified

otherwise, retrieved files are saved to My
Documents\My Recovered Files.

Retrieve List

File types and retrieval ability

Due to the nature of download files from the Web, some file types are limited in

their ability to be retrieved using Backup Exec Retrieve.

LimitationsFile type

Downloading and retrieving these file types

will result in garbled or unuseable data, or

an access denied error.

■ Windows Encrypted File (EFS)

■ Reparse points
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LimitationsFile type

These file types can be retrieved using

Backup Exec Retrieve, but the end result is

a file that is no longer compressed, sparse,

read-only, or has custom security

permissions set on it.

■ Compressed

■ Sparse

■ Read-only

■ Customized security permissions

System requirements for using Backup Exec Retrieve

Backup Exec Retrieve is designed to work with Microsoft Internet Explorer 6.0 or

later. Other browsers should also be compatible, but certain features and user

interface layouts may vary.

How file access is secured

When using Backup Exec Retrieve, end users log in with their domain credentials,

and then the system restricts their access so that they can only retrieve the files

to which they originally had access. For example, if a file server is protected, end

users likely will only have access to the files that are located inside shared folders.

If an end user's desktop is protected, and the end user is a local administrator on

the computer or has access as the administrator, then the end user can retrieve

any file on that computer.

Some end users might not be administrators on their own computers, but still

need to retrieve files. Backup Exec Retrieve makes this possible by generating a

virtual share of the Documents and Settings folder on each computer, and then

restricts access so that only end users who have ever logged on to that computer

can access the share. Thus, non-administrator users can retrieve files out of their

profile directories, but only if they could originally access those files.

About workgroup environments

In workgroup environments, there are no domain accounts for end users to log

in with. To use Backup Exec Retrieve in a workgroup environment, set the

permissions on every share to allow the Everyone group read access (at a

minimum), and then on the Backup Exec Retrieve computer, create a local

computer account for each end user.

Retrieving files using Backup Exec Retrieve

When an end user has located a file to retrieve, simply clicking the name of the

file opens the most recent backup. To view previous revisions of the file, the end
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user can click the View all versions link, and then open the desired version by

clicking on it.

The process of retrieving directories or multiple files functions like a shopping

cart. An end user can select the needed files from the relevant directories, and

then use the interface to add those files to a list of items for retrieval. When all

of the needed files have been selected, the end user simply "checks out" by clicking

a button to retrieve the items. To accomplish the retrieval, a download manager

program is downloaded to the end user's computer, which then retrieves each

file.

Note: There are two versions of the download manager program that are used to

retrieve files. One requires the Microsoft .NET 2.0 framework, while the other one

does not. The .NET 2.0 version provides a more seamless retrieve experience, and

will be used when it is available on the end user's computer, but the system will

use the non-.NET version when necessary.

To retrieve files using Backup Exec Retrieve

1 From the Manage page, in the left pane under Services, click Retrieve Files

and Folders.

The Backup Exec Retrieve Web page is displayed.

Note: You can link to Backup Exec Retrieve in the Backup Exec System

Recovery Manager console, and on the desktop of each managed Symantec

Backup Exec System Recovery computer. The URL for this link is

https://manager computer:8443/BERetrieve

2 If the standard Windows security alert screens are displayed, click Yes or OK

to continue.

3 If a message is displayed with information about the security certificate, it

is related to SSL. Click Continue to this website (not recommended).

4 In Backup Exec Retrieve the logon screen, enter the user name, password,

and domain (or computer name if in a workgroup), and then click Log on.

5 In the Backup Exec Retrieve screen, select one of the following options to

locate and specify the data that you want to retrieve:

■ The Search tab lets you search for the data by file name.

■ The Browse tab lets you browse the backup data.
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■ The Recent Activity tab lets you select the data from files that were

recently modified or deleted.

6 To display the folders that have been backed up, click the computer name.

Subsequent clicks on the folder name let you navigate deeper into

subdirectories. At any level, you can use the check box to select that folder

and subordinate folders and files.

7 To view recently modified or deleted files, on the Recent Activity tab, do one

of the following:

■ To view modified files, click RecentlyModified.

■ To view deleted files, click RecentlyDeleted.

8 To add the file to your list of data to be retrieved, select the file, and then

click Add toRetrieve List.

9 If necessary, add more files to the retrieve list by using the Browse tab and

then locating the files. To add the files to the retrieve list, select the desired

files, and then click Add toRetrieve List.

10 To view a list of all of the files you selected, click the Retrieve List tab.

11 On the Internet Explorer File Download screen, click Open (or Run) to

download a small executable file (downloadmanager.exe) that restores the

selected files.

12 On the File Restore screen, select the default <user>\My Documents\Restored

Files, or browse to the chosen restore location.

13 To begin the file retrieval, click Next.

14 Verify that the selected files were retrieved.

Integrating with Backup Exec 11d

You can use Backup Exec Retrieve to connect to existing Backup Exec 11d

installations, and include files and folders from those sources to provide a unified

view of all Backup Exec System Recovery and Backup Exec 11d data.

To enable this feature, on the Backup Exec System Recovery Manager console, at

the Options dialog, in the Backup Exec 11d CPS Servers section, add each Backup

Exec 11d Continuous Protection Server or Backup Exec 11d DLO Administration

Server. You need to provide administrator credentials to connect to each host –

these are used to read configuration information only; the end user's credentials

will always be used to restrict the files that are viewable in Backup Exec Retrieve.
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To provide a unified view of all Backup Exec System Recovery Manager and Backup

Exec 11d data

1 From any page on the Backup Exec System Recovery Manager console, click

Tools > Options.

2 On the left pane, click Backup Exec 11d CPS.

3 On the right pane, click Add, and then enter the CPS or DLO administration

server name and credentials.

4 To automatically redirect the end user to the unified Backup Exec Retrieve

Web site, under Redirection, select the check box. This modifies the existing

Backup Exec 11d pages on the 11d server.

5 Click OK.

Note: You can have multiple Backup Exec System Recovery managers sharing the

same 11d servers, but be sure to only have the 11d server redirected to one of

them. Otherwise, the redirection may bounce back and forth between the two

different Backup Exec System Recovery Manager servers that are attached to it.

Integrating with the Backup Exec 11d Desktop and Laptop
Option

When properly configured, Backup Exec 11d Retrieve included data from Backup

Exec's Desktop and Laptop Option (DLO). If you previously configured the DLO

integration, the DLO data will automatically be included. If you did not include

DLO data in Backup Exec 11d, you can manually include it in Backup Exec Retrieve.

To manually include DLO data in Backup Exec Retrieve

1 From any page on the Backup Exec System Recovery Manager console, click

Tools > Options.

2 On the left pane, click Backup Exec 11d CPS.

3 On the right pane, click Add, and then enter the DLO administration server

name and credentials.

4 Click OK.

Troubleshooting Backup Exec Retrieve

For help with resolving problems that you might encounter with Backup Exec

Retrieve, you can check the following information.

■ Clicking on a file causes an error in the application that launches for viewing

the file
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■ I cannot log in with a local account

■ I cannot see all of my data (indexing is taking too long)

Clicking on a file causes an error in the application that
launches for viewing the file

When you click on a file in Microsoft Internet Explorer, it first saves the file to

the Internet cache, and then launches the associated program to open it. If the

Do not save encrypted pages to disk option is selected in Internet Explorer (which

is the default on Windows 2003, but not Windows XP), then Internet Explorer

does not write this file to the Internet cache. However, it still launches the

associated application, which consequently cannot open the file. To fix this issue,

deselect the option in Internet Explorer.

To deselect the option to save encrypted pages to disk

1 In Internet Explorer, click the Tools menu, and then click Internet Options.

2 Click Advanced, and then scroll down to the Security section.

3 Uncheck the Do not save encrypted pages to disk checkbox.

4 Click Apply > OK.

I cannot log in with a local account

Backup Exec Retrieve nearly always runs on a different computer than the original

computer that was backed up. The only authority for local accounts and passwords

is the original computer, which might not be available when using Backup Exec

Retrieve. You will need to use a domain account to login and retrieve files using

Backup Exec Retrieve. Backup Exec Retrieve makes every effort to capture domain

users and groups that are part of local groups, so if your domain account is a

member of the Local Administrators group on your computer, you can retrieve

your files.

I cannot see all of my data (indexing is taking too long)

Indexing is a resource-intensive process. Performance expectations will vary

significantly, depending on your hardware, network configuration, and data

change rate. Initial indexing for a new storage location that contains many base

recovery points will be the most intense load, in the range of minutes per image,

while a smaller load for subsequent incremental recovery points will be in the

range of seconds per incremental. Images that are not indexed will not display in

search results, so if you find that indexing is taking too long, you might need to

distribute the load across additional indexing servers.
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About recovering files or disks using Symantec
pcAnywhere

You can start Symantec pcAnywhere (if installed) on the Shortcuts page and

connect to a managed client computer that also has pcAnywhere installed and

running. This connection lets you restore files on a remote computer using the

Recovery Point Browser, or restore an entire drive using Backup Exec System

Recovery with a user interface.

Table 6-2 describes the locations where software must be installed.

Table 6-2 Recovery on remote computer

Software that must be installed at the

location

Location

Symantec pcAnywhere (ships on a separate

CD with Backup Exec System Recovery

Manager)

Backup Exec System Recovery Manager

console

■ Symantec pcAnywhere host

■ Backup Exec System Recovery - full

product

Note: The remote computer cannot be a

pcAnywhere host if it is currently under

Windows XP Remote Desktop (or Terminal

Services) control.

Remote computer

If you connect to a remote computer that has Backup Exec System Recovery

without a user interface installed (as opposed to Backup Exec System Recovery

with a user interface), you must use Symantec Recovery Disk to restore files or

disks. See the Backup Exec System Recovery product documentation for more

information about Symantec Recovery Disk.

After pcAnywhere is installed, you can launch the program directly from the

console. You can deploy pcAnywhere hosts to all managed computers that you

want to connect to for recovery tasks using Backup Exec System Recovery. For

more information about using pcAnywhere and deploying hosts, see the Symantec

pcAnywhere product documentation.

Starting Symantec pcAnywhere from the console

To start Symantec pcAnywhere from the console, make sure that you have installed

the product on the same computer on which you are running the Backup Exec

System Recovery Manager console.
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Note: The pcAnywhere host needs to be installed and running on the remote

computer before you can remotely recover files or disks.

After you connect to the remote computer through pcAnywhere, you can either

open the Recovery Point Browser to recover files or folders, or you can open

Backup Exec System Recovery to recover disks.

To start Symantec pcAnywhere from the console

◆ On the Shortcuts page, in the right pane, click Symantec pcAnywhere.
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Monitoring computers and

processes

This chapter includes the following topics:

■ Setting client options for computers

■ Refreshing client computer information in the console

■ Changing how a computer reports backup status

■ Exporting a console table to a file

■ About monitoring computers

Setting client options for computers
You can set a variety of options that affect one computer or entire groups of

computers.

Warning: If you select multiple computers or one or more computer groups, all of

the client options that are currently set in the Client Options dialog box are default

settings only. Unlike when you select one computer, these settings do not reflect

the current state of the multiple computers or groups. Any changes you make to

these settings affect all of the computers or computer groups that you have

selected. Changes are made on a page-by-page basis only.

To set client options for computers

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one computer name in the

table.
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■ In the right pane, on the Computers tab, select two or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

2 On the Tasks menu, click Client Options.

3 To edit the setting, in the left pane, click the name of the option.

Adjust the operation speed of Backup Exec System Recovery during

the creation of a recovery point by dragging the slider bar to the left

or to the right. By reducing the operation speed of Backup Exec System

Recovery, you can improve the performance of other software programs

that may be running on the client computer. When Backup Exec System

Recovery (with a user interface) is installed, the throttle value that you

set in Backup Exec System Recovery Manager takes precedence over

the throttle value that a remote user may set..

If you save recovery points to a network storage location, you can also

set a network throttle value by specifying the maximum number of

kilobytes per second (200-1048576) of recovery point data that is

transferred over the network. If your network has limited bandwidth,

you can enable network throttling during a recovery point to help

reduce network traffic.

Performance

Choose to show or hide the Backup Exec System Recovery system tray

icon on client computers. Hiding the tray icon is useful for the following

reasons:

■ You want the actions of the Backup Exec System Recovery to remain

invisible to the user

■ You do not want to add another icon to the system tray of the client

computer

■ You want users to avoid having any intervention with Backup Exec

System Recovery on critical computers such as production servers

Backup Exec System Recovery and Management Control must already

be installed on the computer.

You can choose the level of messages that you want the remote user to

see, regardless of whether the system tray icon is visible or hidden.

Tray Icon
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Choose how you want the Backup Exec System Recovery Manager server

to communicate securely with client computers with one of the

following methods:

■ Specify the secure Management Control port (checked by default)

The default port is 763. This is the default secure port used by

Backup Exec System Recovery Manager to ask the Management

Control component to communicate with the server regarding

backup jobs, the status of recovery points, and each computer's

current state.

To specify an alternate port for Management Control other than

the default 763, the following must occur:

■ On the console, you configure the alternate port value as outlined

above.

■ On the client computer, you configure the same alternate port

value in the client firewall software that is running.

See “Configuring an alternate port for Management Control in

client firewall software” on page 179.

Management

Control

■ Client polling interval

The default value is 60 minutes. The client computer contacts the

Backup Exec System Recovery server at recurring intervals for job

information or status updates.

■ Specify the IP address that Management Control uses to contact

the server

Check this option if the server computer has two or more network

interface controllers (NICs), and then select the IP address that you

want to use from the drop-down list.

■ Publish progress

The default interval is 5 percent. Check this option to publish the

progress of a job at a specified percentage interval. For example, if

you specified 10 (the default), the job updates the console display

after each 10 percent of the job's completion on the client computer.

Specifying a higher percentage does not update the job progress as

frequently in the console, but it may improve performance in the

console interface.

If Publish progress is unchecked, no job progress is published to

the console. Instead, an entry for the job appears on the Monitor

page. When the job finishes, the entry is removed.
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■ Upload log files

If you are logged on in the role of System Admin, you can check this

option to upload Backup Exec System Recovery and Management

Control log files for availability and viewing from the console. If

you uncheck this option, no log files are published. This may

improve the performance of the Backup Exec System Recovery

Manager server and network on which it is running.

■ Verbose logging

This option is unchecked by default. Verbose logging is a client

computer logging mode that records very detailed information

not found in a traditional logging mode. A verbose log tracks all

low-level job changes and settings applied to the client computer

by Backup Exec System Recovery Manager and also from Backup

Exec System Recovery as jobs are run.

Because verbose logging increases the size of the log file, it takes

more time to upload it to the Backup Exec System Recovery

Manager server for viewing in the console. Verbose logging may

also impact client computer performance. You should only check

this option if you need further assistance with diagnosing or

troubleshooting an error.

See “Editing server and client settings” on page 84.

Choose from the following log file options:

■ Priority Level

Choose the minimum priority level and error message types that

you want logged to a file regarding Backup Exec System Recovery

on the client computer.

■ Log file location

Specify the path that you want to use for storing log files.

■ Maximum file size

You can also specify the maximum file size of the log file. When the

maximum file size is reached, the log file is renamed (*.old). A new

log is started and the original file name is used.

Log File

Choose the minimum priority level and error message types that you

want added to the Windows application log regarding Backup Exec

System Recovery on the client computer.

Event Log
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You can configure a user to receive SMTP email notification messages.

Choose the minimum priority level and error message types that you

want sent regarding Backup Exec System Recovery on the client

computer.

In the From text box, type the email address of the user from whom

the notification message is sent.

In the To text box, type the email address of the recipient to whom the

notification message is sent. For example, name@comany.com

Type the name of an SMTP mail server (for example,

smtpserver.domain.com or server1) on which you have a valid user

account. Backup Exec System Recovery Manager does not check the

server name or the email address for validity.

You can increase the security of the email being sent by specifying an

authentication level (Basic or NTLM), and a user name and password.

Anonymous authentication does not require a user name and password.

You must have an SMTP-compliant email system, such as a POP3 mail

server, to receive notification messages.

SMTP

E-mail

SNMP (Simple Network Management Protocol) is a method by which

a network can be monitored from a central location. SNMP-enabled

network applications (like Backup Exec System Recovery) report to an

SNMP Console. (By default, Backup Exec System Recovery is not enabled

to send traps to NMS managers). The console receives messages (traps)

from Backup Exec System Recovery regarding specified status and

error conditions.

In order to receive SNMP traps from Backup Exec System Recovery,

you must install and configure the Windows SNMP system service.

Choose the minimum priority level and error message types that you

want trapped regarding Backup Exec System Recovery on the client

computer. You can also select the version of SNMP traps to be sent (V1

or V2).

SNMP Trap

4 Click OK.

Refreshing client computer information in the console
When you use the Refresh Client option, the Management Control checks the

server for any queued jobs such as backups or recoveries. If jobs are found, they

are immediately processed.

See “Viewing the properties of a computer” on page 165.
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Note: Backup Exec System Recovery and Management Control must already be

installed on client computers to use Refresh Client.

To refresh client computer information in the console

1 On the Manage page, do one of the following:

■ In the right pane, on the Computers tab, select one or more computer

names in the table.

■ In the right pane, on the Groups tab, select one or more group names in

the table.

2 On the Tasks menu, click Refresh Client.

3 To approve the refresh, click Yes.

Changing how a computer reports backup status
You can change how Backup Exec System Recovery Manager reports the status

of a particular drive on a client computer.

For example, if drive D contains unimportant data and you have chosen not to

include it in a backup job, the backup status on the Home page reports that the

computer is at risk. You can configure Backup Exec System Recovery Manager to

ignore drive D so that it does not calculate the status of drive D in the Status panel

on the Home page. Or, you can specify that only errors, such as missed or failed

backups, are included in the status report.

Note: The backup status of each drive on a computer is reported throughout the

software, wherever the drive is listed. When you customize status reporting for

a drive, the status is reflected anywhere that the drive is listed in Backup Exec

System Recovery Manager.

You should first determine how important the data is on a particular drive before

deciding on the level of status reporting to assign to it.

See “Viewing the backup status of a computer” on page 160.

To change how a computer reports backup status

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer in the table.

3 On the Tasks menu, click Backup Status.

4 Click Drive Status.
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5 Select one or more drives.

6 Click Status Reporting.

7 Click the status reporting level that you want for the selected drives.

Shows the current status of the selected drive backups on the

Home and Status pages. Click this option if the data is critical.

Full status

reporting

Shows the current status of the selected drive backups only when

errors occur. Click this option if the data is important, but you

only want the status to report errors when they occur.

Errors only status

reporting

Does not show any status for the selected drive or file and folder

backups. Click this option if the data is unimportant and missed

or failed backups do not need to be reported.

No status reporting

8 Click OK.

Exporting a console table to a file
You can export the tables of information on any Manage page to the following

formats:

■ Text file (.csv)

■ Web page (.html)

■ Excel spreadsheet (.xls)

■ XML data (.xml)

To export a console table to a file

1 From any tab on the Manage page, do one of the following:

■ Select one or more items in the table, and then clickTasks>SaveSelected.

■ Click Tasks > SaveAll .

2 In the Save As dialog box, specify the name and location of the file.

3 Click OK.

A displayed message tells you how many rows were exported.

About monitoring computers
You can use the Backup Exec System Recovery Manager console to do any of the

following:
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■ View the backup protection status of a selected computer.

See “Viewing the backup status of a computer” on page 160.

■ View the progress of currently running jobs.

See “Viewing the progress of jobs” on page 161.

■ View all jobs that are waiting to run.

See “Viewing pending backup jobs” on page 162.

■ View errors for all jobs.

See “Viewing job failures” on page 163.

■ View predefined reports.

See “Viewing reports” on page 163.

■ View the properties of a selected computer.

See “Viewing the properties of a computer” on page 165.

■ View client computer and Backup Exec System Recovery Manager server log

files.

See “Viewing a client computer log” on page 167.

See “Viewing the Backup Exec System Recovery Manager server log” on page 167.

Viewing the backup status of a computer

You can use Backup Status to view details about which drives on a selected

computer are protected. For example, if one or more drives on a computer are not

included in a backup job, the background color and status icon change to reflect

the level of backup protection. The Status Details pane provides recommendations

on what actions you can take.

See “Changing how a computer reports backup status” on page 158.

Table 7-1 describes each of the levels of backup protection that are available.

Table 7-1 Backup protection levels

DescriptionBackup status

The computer has made a recovery point of all drives in the last 30 days

and has not missed the last scheduled back up. A computer can be

considered "Backed Up" without having an assigned backup job as long

as one or more recovery points have been created within the last 30 days.

This status indicates that all drives, files, and folders can be fully

recovered, if necessary.

Backed Up
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Table 7-1 Backup protection levels (continued)

DescriptionBackup status

The computer has a backup job assigned but it has not been run for a

long time, or it has missed the last scheduled backup (meaning that

existing recovery points are probably old).

A computer drive that needs attention can be recovered, but if the

recovery points are older, it will not contain the latest versions of files

or folders.

Needs Attention

No recovery points are available from which to recover the drives.

A computer at risk cannot be recovered.

At risk

The status is not yet calculated, or you have not assigned a license to

Backup Exec System Recovery on the client computer. Either wait a few

seconds for the status to update, or make sure that you have assigned a

Backup Exec System Recovery license to the client computer.

Status unknown

To view the backup status of a computer

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer in the table.

3 On the Tasks menu, click Backup Status.

Review the status details.

4 If the backup status indicates that a client computer is at risk or needs

attention, do one of the following:

■ To create a recovery point for selected drives, click FixNow.

■ To create a backup job for the selected drives, run a backup job that is

already assigned to a drive, or change how backup status is reported for

a selected drive, click Drive Status.

Viewing the progress of jobs

You can use the Monitor page to display real-time status information regarding

the following types of jobs as they occur:

■ Backups

■ Deletion of recovery points

■ Recovery of a data drive on a client computer

■ Conversion of recovery points to virtual disks
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Note: Status information regarding the progress of jobs is updated when the

Monitor page in the console is displayed in the console.

You can affect the published progress of a job in the console by specifying a

percentage interval. For example, if you specified 10 (the default) in the

Management Control panel of Client Options, the job updates the console display

after each 10 percent of the job's completion on the client computer. You can also

choose to have no job progress published. In such cases, only an entry for the

running job appears on the Monitor page. When the job is finished, the entry is

removed.

See “Setting client options for computers” on page 153.

To view the progress of jobs

1 On the View menu, click Monitor.

2 Do one of the following:

■ To stop a job, select the job you want, and then on the toolbar, clickCancel.

■ To troubleshoot computers with job errors, on the toolbar, click Errors.

■ To view a list of computers with jobs waiting to be run, on the toolbar,

click Pending jobs.

■ To further refine the progress of each job, use the options on the Filter

bar.

■ To reorganize information, drag column headings in the table to another

column header.

Viewing pending backup jobs

You can view a list of computers with backup jobs waiting to be run.

To view pending backup jobs

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer in the table.

3 On the Tasks menu, click ViewPending Jobs.

4 Select a job name in the table.

5 Do one of the following:

■ To view job settings, click BackupDetails.

■ To stop the job from running, click Cancel Job.

6 Click Close.
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Viewing job failures

Different conditions can cause failures. To troubleshoot these failures, you can

use View Failures to narrow the possibilities and solve the more problems quickly.

View Failures provides error information for the following types of jobs on a

selected computer.

■ Backups

■ Remote recovery of a computer

■ Conversion of recovery points to virtual disks

■ Deletion of recovery points

From the View Failures dialog box, you can do the following:

■ View the client computer's event log

■ View the details of the failed job

■ Retry the failed job

■ Clear the job failure

To view job failures

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer in the table.

3 On the Tasks menu, click ViewFailures.

4 If the computer has more than one type of job failure, select the job type that

you want to view.

5 Do one of the following:

■ To view the event log associated with the job failure, on the toolbar, click

ShowEvent Log.

■ To view detailed information regarding the job failure, on the toolbar,

click BackupDetails.

■ To try running the job again, on the toolbar, click Retry.

■ To remove the failure, on the toolbar, click Clear Failure.

Viewing reports

You can use the Reports tool to generate 12 different predefined reports that show

detailed information about your backup management system.

Table 7-2 describes the predefined reports that you can generate.
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Table 7-2 Available reports

DescriptionReport

Displays a high-level summary regarding the status of managed

servers and desktop computers that are running Backup Exec System

Recovery.

Executive Summary

Displays trend data, such as errors and recovery point failures, for

all managed computers within a specified date range. This report

provides similar information to the trends line chart on the Home

page.

Trends

Displays a detailed overview of all backup jobs that are available in

Backup Exec System Recovery Manager.

Backup Definitions

Displays a detailed list of all managed computers, including their

current group assignment, if any.

Managed Computers

Displays detailed information about the hard drive of a selected

computer that Backup Exec System Recovery Manager manages.

Managed Computer

Details

Displays detailed information about available recovery points, failed

recovery points and, optionally, recovery points that were deleted.

Recovery Points

Displays all managed computers and the number of days since the

last backup occurred.

Recovery Protection

Displays a list of all managed computers and their assigned backup

schedule. If any computers do not have an assigned backup

scheduled, the report includes this information.

Backup Schedules

Displays a list of all managed (and reporting) computers and detailed

information about each partition on its hard disk.

Disk Usage

Displays a list of all managed (and reporting) computers and the

version of Backup Exec System Recovery and Management Control

that is installed on them.

Client Versions

Displays a list of one or more managed (and reporting) computers

with errors, warnings, and other events, within a specified date

range.

Managed Computer

Events

Displays a list of all managed computers that are reporting or not

reporting to the Backup Exec System Recovery Manager server.

Computers Not

Reporting

You can save a report as a text file, Web page, Excel spreadsheet, or an XML data

file. You can also print each report directly from the console.
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Some reports, such as Backup Exec System Recovery Event or Trend let you specify

filter parameters or a date range to refine further the displayed results.

To view reports

1 On the View menu, click Reports.

2 Click the name of a report in the sidebar.

The results are displayed in the right pane.

Depending on the report that you have selected, you may need to specify a

date range. Or, you may be able to use the Filter bar to refine further the

resulting displayed results.

The report results are displayed on the right pane.

3 Do one of the following:

■ To save the results to a file, in the right pane, click Save above the

displayed report.

■ In the right pane, above the displayed report, click Print.

You can either preview the report before printing it, or you can print the

report with the default printer that is set up on the computer where the

console is running.

Viewing the properties of a computer

Computer properties are details about a selected client computer that you manage.

Property details including the following:

■ Drives that are on the computer

■ A backup history of the computer

■ An event log that identifies errors, information, and warnings

■ Backups that are currently assigned to the computer

■ Computers that are assigned to groups

See “Refreshing client computer information in the console” on page 157.

To view the properties of a computer

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer name in the table.

3 Do one of the following:.

■ On the Tasks menu, click Properties.

■ Double-click the computer name.
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4 In the left pane, click the name of the property that you want to view.

View specific information about the computer's hard drive

(like the file system that is used and storage capacity), the

storage location for recovery points, and when the last

recovery point occurred.

In the Drives window, in the Last Backup column, notice that

any unprotected drives (that is, any drives that have not yet

had a backup job run on them) are blank. Each drive's

protection status is also displayed in the Status column.

Drives

View the backup history of a computer and general status

information, such as the recovery point type, size, and

destination.

You can also view a chronological history of all of the

recovery points that are taken of selected drives (even if the

recovery point has been deleted from the storage location).

The picture icon next to each drive letter gives you a quick

visual indication about the type of recovery point that is

created (a recovery point set, or an independent recovery

point).

See “Deleting recovery points within a set” on page 131.

Backup History

View information, errors, or warnings for the selected

computer.

You can also use the Windows Event Viewer on the client

computer to view events from the application logs.

Events

View the backup jobs that are currently assigned to the

selected computer.

In the right pane, use the Filter bar above the table to refine

the view.

Backup Jobs

View the computers that are currently assigned to the

selected group.

In the right pane, use the Filter bar above the table to refine

the view.

Groups

View Backup Exec System Recovery licensing details for the

selected computer.

License

5 Click Close.
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Viewing a client computer log

You can use View Computer Logs to open a selected computer's log for Management

Control or Backup Exec System Recovery.

Note: To view client computer log files, make sure you have checked the option

to upload log files to the Backup Exec System Recovery server (as set in the

Management Control panel of Client Options). Otherwise, you will get an error

message telling you to first publish the log files before you attempt to view them.

See “Setting client options for computers” on page 153.

To view a client computer log

1 On the Manage page, in the right pane, click the Computers tab.

2 Select a computer name in the table.

3 On the Tasks menu, click ViewComputer Logs >Management Control Log

or Backup Exec SystemRecovery Log.

To perform log file tasks, use the Menu bar options in the log window.

Viewing the Backup Exec System Recovery Manager server log

You can use View Server Log to open the Backup Exec System Recovery Manager

server log in the default browser window.

To view the Backup Exec System Recovery Manager server log

◆ On the Manage page, click Tools >View Server Log.

To perform log file tasks, use the Menu bar options in the log window.
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Using the Shortcuts page

This chapter includes the following topics:

■ About the Shortcuts page

■ Adding a link to the Shortcuts page

■ Editing a link on the Shortcuts page

■ Deleting a link from the Shortcuts page

About the Shortcuts page
You can use the Shortcuts page to add links to external programs, full URLs, or

to files. You double-click the link to launch the program or open the associated

file.

When you installed the console, default program shortcut icons for certain

Symantec programs were automatically added to the Shortcuts page. These

program shortcuts are active if you have installed the respective program on the

same computer as the console. You cannot edit or remove the default program

shortcuts.

Shortcuts are displayed in alphabetical order by name.

Adding a link to the Shortcuts page
You can add tool links to external program, URLs, or files, and then launch the

link from the Shortcuts page in the console. On the Shortcuts page, you can display

links with a graphical icon of your choice and the link's name. When you hover

the mouse pointer on a link, the name, link location, and description are displayed

in a pop-up window.
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To add a tool link to the Shortcuts page

1 Do one of the following:

■ Drag a shortcut from the Windows desktop and drop it onto the right pane

of the Shortcuts page.

■ On the Shortcuts page, on the toolbar, click Add, and then continue with

the steps below.

2 Specify the following options:

Type the name that you want displayed with the link's graphical icon.

A display name is optional. However, if you do not specify a name, the

Target path is used instead.

Name

Do one of the following:

■ Specify the full path to a program file (.exe) that exists on the

computer. If necessary, click Browse to locate the file.

■ Specify the full path to a Web link. The Web link path must begin

with http:// or https://, so that it can open correctly using the

installed browser.

Path

Specify a path to the folder that contains the files that the program

may need to use.

If this text box is left empty, the path to the program file in the Path

text box is used. Or, if a Web link was specified as the path, this text

box remains empty.

Start In

Click Change Image, and then specify a path to a graphic image file

that you want to represent the link.

Valid graphic image file formats include the following file extensions:

■ .jpg or .jpeg

■ .gif

■ .bmp

Icon files (.ico) are not supported.

If you do not specify an image file (or the file is invalid or unavailable),

Backup Exec System Recovery Manager supplies a default image. The

image that is used is based on the type of link you created (an executable

or Web link).

Change

Image

3 Click OK.
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Editing a link on the Shortcuts page
You can edit links to tools that you have added. However, default tool links that

were installed with Backup Exec System Recovery Manager cannot be edited.

To edit a link on the Shortcuts page

1 On the Shortcuts page, select a link that you have added.

2 On the toolbar, click Edit.

3 In the Edit Shortcuts dialog box, make the changes that you want.

4 Click OK.

Deleting a link from the Shortcuts page
You can remove links that you no longer use from the Shortcuts page. However,

default tool links that were installed with Backup Exec System Recovery Manager

cannot be deleted.

To delete a link from the Shortcuts page

1 On the Shortcuts page, select a link that you have added.

2 On the toolbar, click Delete.

3 To confirm the deletion, click Yes.
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Configuring TCP/IP ports

for network communication

This appendix includes the following topics:

■ Ports used by Backup Exec System Recovery Manager

■ Configuring TCP/IP ports for a new installation of Backup Exec System

Recovery Manager

■ Configuring TCP/IP ports for an existing managed computer

■ Configuring an alternate port for Management Control in client firewall

software

Ports used byBackupExec SystemRecoveryManager
If you are running the Backup Exec System Recovery Manager console with client

computers behind a local firewall, or using Windows XP Service Pack 2, you may

need to configure certain ports so that Backup Exec System Recovery Manager

can communicate with the client computers.

You cannot configure these ports remotely from Backup Exec System Recovery

Manager because the ports must be open in order for the console and server to

communicate with the client computer.

See “Editing server and client settings” on page 84.

Table A-1 identifies the various ports and protocols that Backup Exec System

Recovery Manager uses.
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Table A-1 Ports used by Backup Exec System Recovery Manager

PortCommunication path

■ TCP 8080 (unsecure): Used for viewing

log files.

See “Editing server and client settings”

on page 84.

■ TCP 8443 (secure): Used by Management

Control to communicate with the server.

See “Configuring TCP/IP ports for a new

installation of Backup Exec System Recovery

Manager” on page 175.

See “Configuring TCP/IP ports for an

existing managed computer” on page 177.

Bidirectional between remote managed

computers and the Backup Exec System

Recovery Manager server

■ TCP 8443 (secure): Used by Management

Control to communicate with the server.

See “Editing server and client settings”

on page 84.

■ TCP 763 (unsecure): Used by Backup Exec

System Recovery Manager to ask

Management Control to communicate

with the server. You can configure this

port to use an alternate address other

than the default.

See “Configuring an alternate port for

Management Control in client firewall

software” on page 179.

From remote managed computers to the

Backup Exec System Recovery Manager

server

TCP 8443 (secure): Used by Management

Control to communicate with the server.

See “Editing server and client settings”

on page 84.

From the Backup Exec System Recovery

Manager console to the Backup Exec System

Recovery Manager server

■ UDP 138

■ TCP 139

Used with NetBIOS over default TCP/IP.

These are the ports that are used by the File

and Printer Sharing service that is located

in the Exceptions tab of Windows Firewall

(Windows XP SP2 only).

From remote managed computers to the

backup location on the network.
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Table A-1 Ports used by Backup Exec System Recovery Manager (continued)

PortCommunication path

TCP 8080 (unsecure): Used for viewing the

log files created by Backup Exec System

Recovery Manager.

Viewing log files

TCP 764 (unsecure): Backup Exec Retrieve

uses this port on the Backup Exec System

Recovery Manager server to communicate

with the Windows Server 2003 computer

where Indexing Server is installed.

See “Editing server and client settings”

on page 84.

From the Backup Exec System Recovery

Manager server to the Indexing Server.

Configuring TCP/IP ports for a new installation of
Backup Exec System Recovery Manager

Use the following method to configure a new installation of Backup Exec System

Recovery Manager for communication using port numbers other than the default

8080 and 8443. This method of configuration may also be necessary if you

experience problems when you log on to the Backup Exec System Recovery

Manager server and you have an installation of Backup Exec 10d or Backup Exec

11d for Windows Servers.

See “Configuring TCP/IP ports for an existing managed computer” on page 177.

See “Ports used by Backup Exec System Recovery Manager ” on page 173.

To configure the TCP/IP ports for a new installation of Backup Exec System

Recovery Manager, you must complete the following tasks:

■ Stop the Backup Exec System Recovery Manager Web services.

■ Configure server.xml.

■ Restart Backup Exec System Recovery Manager Web services.

■ Configure the Backup Exec System Recovery Manager console to communicate

with the server.
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To configure TCP/IP ports for a new installation of Backup Exec System Recovery

Manager

◆ Install the Backup Exec System Recovery Manager 8.0 server. You must install

the Backup Exec System Recovery Manager 8.0 console later in this process.

Be sure that you remember the folder where you installed the product. The

default installation path is C:\Program Files\Symantec\Backup Exec System

Recovery.

Stopping Backup Exec System Recovery Manager Web Services

1 On the Windows taskbar of the Backup Exec System Recovery Manager server,

click Start >Run.

2 In the Open text box, type services.msc, and then click OK.

3 Under the Name column, click BackupExecSystemRecoveryManagerWeb

Services.

4 Click Action > Stop.

The Backup Exec System Recovery Manager Web Services are stopped. Leave

the Services window open so you can return to it to restart the Web services

later.

Now you must configure the server.xml file.

Configuring server.xml

1 Open server.xml in Notepad.

The default path to the file is C:\Program Files\Symantec\Backup Exec System

Recovery\Services\tomcat\conf\.

2 Search for the following line in the file:

<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

<Connector port="8080"

3 Change the connector port number "8080" to the port number that you want

to use for unsecure communication.

4 Search for the following line in the file:

<!-- Define a SSL HTTP/1.1 Connector on port 8443 --> <Connector

port="8443"
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5 Change the connector port number "8443" to the number that you want to

use for secure communication.

6 Save server.xml with the new port numbers.

Now you must restart the Backup Exec System Recovery Manager Web

services.

Restarting the Backup Exec System Recovery Manager Web Services

1 Return to the Services window that you opened earlier.

2 Under the Name column, click BackupExecSystemRecoveryManagerWeb

Services.

3 Click Action > Start.

Backup Exec System Recovery Manager uses the new ports for secure and

insecure communication.

Now you must configure the Backup Exec System Recovery Manager console

to communicate with the server.

Configuring the Backup Exec System Recovery Manager console

1 Make sure the Backup Exec System Recovery Manager 8.0 console is installed.

2 ClickAllPrograms>Symantec>BackupExecSystemRecovery>Symantec

Backup Exec SystemRecoveryManager.

Do not log on to the console. If you log on before you finish the configuration

of the console, the console does not function correctly.

3 In the Log on dialog box, click Settings.

4 Type the new secure port number that you specified earlier.

5 Click OK.

6 Finish logging on to the Backup Exec System Recovery Manager console.

If you are unable to log on to the console (due to a "Connection refused" error),

be sure you check that the secure port number used to configure the Backup

Exec System Recovery Manager Web services matches the port number that

you used to configure the Backup Exec System Recovery Manager console.

Configuring TCP/IP ports for an existing managed
computer

If you have already installed Backup Exec System Recovery Manager, you need

to configure each managed computer that you have added to the server. You can

view all managed computers on the Manage page in the console.
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See “Configuring TCP/IP ports for a new installation of Backup Exec System

Recovery Manager” on page 175.

See “Ports used by Backup Exec System Recovery Manager ” on page 173.

To configure the TCP/IP ports for an existing managed computer, you must

complete the following tasks:

■ Configure the TCP/IP port in the registry of a managed computer

■ Configure the TCP/IP port in PublisherUI on the same managed computer

To configure the TCP/IP port in the registry of a managed computer

1 On the Windows taskbar of the managed client computer, click Start >Run.

2 Type services.msc in the text box, and then click OK.

3 Stop the Backup Exec System Recovery service.

4 On the Windows taskbar of the managed client computer, click Start >Run.

5 Type regedit in the text box, and then click OK.

6 In the registry entry, HKLM/SOFTWARE/Symantec/Backup Exec System

Recovery Manager/8.0/Publisher, change the “WebServiceAddress” entry

value to the secure port number that you use.

Use “https://<server_name>:<port_number>/axis/services/Publisher where

<server_name> is the name of the server where the Backup Exec System

Recovery Manager 8.0 server is installed and <port_number> is the secure

port number that you are using.

7 On the File menu, click Exit.

8 Restart the Backup Exec System Recovery service.

9 On the File menu, click Exit.

Now you must configure the port in PublisherUI, on the same managed

computer, to use the same port that you specified in step 6 above.

To configure the TCP/IP port in PublisherUI

1 On the same managed computer as above, navigate to \Program

Files\Symantec\Backup Exec System Recovery\Manager\Management Control.

2 Double-click the file PublisherUI.

3 In the Web Service Address field, change the existing port number that is

specified in the address path to the port number you that you specified above

in step 6.

4 Click Save.

5 Click PublishNow.
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Repeat the two tasks above for each managed client computer.

Configuringanalternateport forManagementControl
in client firewall software

To specify an alternate port for Management Control other than the default 763,

the following must occur:

■ On the console, you specify the alternate port value using the Management

Control panel in the Client Options dialog box.

See “Setting client options for computers” on page 153.

■ On the client computer, you configure the same alternate port value for

Management Control in the client firewall software that is running.

To configure an alternate port value for Management Control in Symantec Client

Firewall

1 On the client computer, open Symantec Client Firewall.

2 On the tool bar, click Options.

3 Click the Secure Port tab.

4 In the Protocol group box, make sure TCP is selected.

5 In the Port Number box, type the alternate port value that is specified in the

Management Control panel of Client Options in the Backup Exec System

Recovery Manager console.

6 Click OK.

7 Close Symantec Client Firewall.

The client computer status in the Backup Exec System Recovery Manager

console is updated to reflect the change.

To configure an alternate port value for Management Control in Windows Firewall

1 On the client computer, open Windows Firewall.

2 Click the Exceptions tab.

3 Click AddPort.

4 In the Name box, type Management Control Port.

5 In Port number box, type the alternate port value that is specified in the

Management Control panel of Client Options in the Backup Exec System

Recovery Manager console.
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6 Make sure TCP is selected.

7 Click OK twice.

The client computer status in the Backup Exec System Recovery Manager

console is updated to reflect the change.
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About backing up

databases

This appendix includes the following topics:

■ Backing up VSS-aware databases

■ About backing up non-VSS-aware databases

■ Backing up the Backup Exec System Recovery Manager server and database

Backing up VSS-aware databases
Backup Exec System Recovery Manager can co-exist with Microsoft VSS (Volume

Shadow Copy Service) to automate the process of backing up VSS-aware databases

like production Exchange 2003 and SQL 2005 databases, transaction logs on

Windows Server 2003, Active Directory, and the latest versions of Oracle.

VSS-aware databases are auto-enabled and cannot be turned off.

Note: Licensing Backup Exec System Recovery on client computers does not give

users any rights to use VSS. VSS must be licensed separately from Microsoft, and

users must conform to any license agreement or documentation that accompanies

VSS.

See “About backing up non-VSS-aware databases” on page 183.

VSS lets IT administrators create a shadow copy backup of drives on a server. The

shadow copy includes all files (including open files).

When a backup job starts, Backup Exec System Recovery alerts the VSS that a

recovery point is about to be created. VSS then communicates this information

to the VSS-aware databases and puts them into a quiesced (sleep) state. (Backup
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Exec System Recovery always attempts to communicate with VSS if it is installed

on a desktop or server and tries to provide VSS with information to quiesce

databases.)

While in this quiesced state, the databases continue to write to transaction logs,

and Backup Exec System Recovery takes an instantaneous snapshot that also

includes any open files. When the snapshot is complete, VSS is notified, the

databases are activated, and the transaction logs continue writing to the database.

(To verify that there are no errors and that VSS is running, you should check the

Microsoft error logs.)

While the recovery point is being created from the snapshot, the databases and

applications return to an active state and continue to write data.

This kind of integration means that you can back up business-critical databases

at anytime during the day without affecting productivity.

Additional points for backing up and restoring VSS-aware databases include the

following:

■ Backup Exec System Recovery supports VSS Exchange Server 2003, which

implements VSS technology. If the database load is heavy, the VSS request

might be ignored.

■ Run backups during the lightest load time.

■ Additional backup applications are not needed to run Backup Exec System

Recovery with Exchange databases.

■ There are known VSS issues that are resolved in 2003 Service Pack 1, and also

the Exchange 2003 Service Pack 1.

■ Backup Exec System Recovery prevents VSS snapshots from occurring during

the time the Backup Exec System Recovery is creating a recovery point.

■ If a full system restore is done from a recovery point, individual files can be

restored from a VSS snapshot. However, the recommended restore process is

to use Backup Exec System Recovery to mount the recovery point file as a

virtual drive (using the Recovery Point Browser). Or, if you enabled file indexing

when you defined the backup job, you can use Backup Exec Retrieve to quickly

restore the files you need.

■ After a full system restore from a Backup Exec System Recovery recovery

point, a VSS snapshot that was taken prior to the date and time of the Backup

Exec System Recovery snapshot can no longer be used to restore the entire

system.
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Warning:Database corruption may occur if the computer is low on hard disk space

when you are rebuilding a database at the same time you are running a backup.

To avoid database corruption, you should quiesce the database before backing it

up, and you should not rebuild or restore the database at the same time that you

are backing it up. Finally, to avoid possible conflict, Backup Exec System Recovery

does not let you take VSS snapshots and Backup Exec System Recovery snapshots

at the same time.

About backing up non-VSS-aware databases
With Symantec Backup Exec System Recovery, you can create manual or automatic

cold recovery points or hot recovery points of non-VSS-aware databases.

Because the Backup Exec System Recovery Manager server also includes a database,

you should back up the server on a regular basis. You must stop the Backup Exec

System Recovery Manager Web Services before backing up so you do not lose or

corrupt data. To do this, you can use Backup Exec System Recovery Manager to

create a cold recovery point automatically.

See “Creating a cold recovery point manually” on page 183.

See “Creating a cold recovery point automatically” on page 184.

See “Creating a hot recovery point” on page 185.

See “Backing up the Backup Exec System Recovery Manager server and database”

on page 185.

Creating a cold recovery point manually

A manual cold (or offline) recovery point ensures that all database transactions

are committed to the hard disk. You can then use Backup Exec System Recovery

to create the recovery point, and then restart the database.
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To create a cold recovery point manually

1 Stop the database manually.

2 Use Backup Exec System Recovery Manager to run a backup immediately

using the Run Backup or One-time Backup feature.

See “Running a one-time backup” on page 125.

Backup Exec System Recovery instantaneously snaps a “virtual volume

recovery point” of the database.

3 Manually restart the database anytime after the recovery point progress bar

appears on the Monitor page of the console.

While the database is restarted, the actual recovery point is already being

created from the virtual volume recovery point.

Creating a cold recovery point automatically

When you automate the creation of a cold recovery point of a non-VSS-aware

database, you run a command file in the backup job, before data capture, to stop

(quiesce) the database momentarily and commit all transaction logs to the hard

disk. Backup Exec System Recovery will then instantaneously snap a “virtual

volume recovery point.” A second command file is run in the backup to

automatically restart the database while the recovery point is created from the

virtual volume recovery point.

Because the virtual volume snapshot takes only a few seconds to create, the

database is in the recovery point state momentarily, resulting in a minimal number

of created log files.

Note: In cases where the domain controller is running on a Windows 2000 server

without VSS support, the Active Directory database must first be backed up using

NTbackup prior to using Backup Exec System Recovery to protect the full system.

This process can be automated by running command files in the backup.

See “Backing up the Backup Exec System Recovery Manager server and database”

on page 185.
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To create a cold recovery point automatically

1 Define a backup that includes the command files that you have created for

the following stages of the recovery point:

A command file that stops the database.Before data capture

A command file that restarts the database.After data capture

2 Use Backup Exec System Recovery to run the backup job that includes the

command files.

Creating a hot recovery point

If a cold recovery point is not possible in your organization, the next available

option for backing up non-VSS-aware databases is a hot (or online) recovery point.

Backup Exec System Recovery takes a “crash-consistent” recovery point. Such a

recovery point is equivalent to the state of a system that was running when the

power failed. A database that can recover from this type of failure can be recovered

from a “crash-consistent” recovery point.

To create a hot recovery point

◆ Use Backup Exec System Recovery to create a recovery point without stopping

or restarting the database.

Backup Exec System Recovery instantaneously snaps a “virtual volume

recovery point” from which the recovery point is created.

Backing up the Backup Exec System Recovery
Manager server and database

Because the Backup Exec System Recovery Manager server also includes a database,

you should back up the server on a regular basis. This requires you to stop the

Backup Exec System Recovery Manager Web Services before backing up so you

do not lose or corrupt data. To automate such a backup process, you can use

Backup Exec System Recovery Manager to create a "cold" recovery point.

See “Creating a cold recovery point automatically” on page 184.

185About backing up databases
Backing up the Backup Exec System Recovery Manager server and database



To backup the Backup Exec System Recovery Manager server and database

1 Install Backup Exec System Recovery and Management Control on the Backup

Exec System Recovery Manager server.

2 Create a backup job exclusively for the Backup Exec System Recovery server.

No other computers should be assigned to this backup job.

■ The backup job needs to run two command files: One command file to stop

the Backup Exec System Recovery Manager Web Services before the

snapshot is taken of the computer, and the other command file to restart

the Web Services immediately after the snapshot.

Backup Exec System Recovery Manager ships with two pre-defined

command files (StopServices.bat and StartServices.bat) that you can use

during the backup of the server and database. The two command files are

located at the following path on the Backup Exec System Recovery Manager

product CD:

\\Support\Utilities\StopServices.bat and StartServices.bat

See “About running command files during a back up” on page 116.

■ Make sure that the backup job will run at a time when backup jobs for

other managed computers are not running. For example, if most of your

backup jobs are scheduled to run at 2:00 A.M., the backup job for the

Backup Exec System Recovery Manager server should run earlier than

2:00 A.M. (or later if you prefer).

See “About schedule options for creating recovery points ” on page 118.

3 Make sure that the Backup Exec System Recovery Manager server computer

is not assigned to any Groups that you may have defined in the console. This

ensures that backup jobs, intended for other computers, do not get assigned

to the server.
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About Active Directory

This appendix includes the following topics:

■ The role of Active Directory

The role of Active Directory
When you protect a domain controller with Backup Exec System Recovery, be

aware of the following:

■ If your domain controller is Windows Server 2003, it supports VSS. Backup

Exec System Recovery automatically calls VSS to prepare the Active Directory

database for backup. Windows 2000 Domain Controllers do not support VSS.

In cases where the domain controller is running on a Windows 2000 server,

the Active Directory database must be backed up using NTbackup before using

Backup Exec System Recovery to protect the full system. This process can be

automated with an external command that Backup Exec System Recovery

calls. When you create a backup job, you have the option to enter external

commands. This provides a simple process for protecting domain controllers

that do not support VSS.

■ In order to participate on a domain, every domain computer must negotiate a

trust token with a domain controller. This token is refreshed every 30 days by

default. This time frame can be changed, and is referred to as a secure channel

trust. But a trust token contained in a recovery point cannot be automatically

updated by the domain controller. Therefore, when a computer is recovered

with a recovery point that contains an outdated token, the recovered computer

cannot participate in the domain until it has been added to the domain by

someone with the proper credentials.

In Backup Exec System Recovery, this trust token can be re-established

automatically if the computer currently participates in the domain at the time

the recovery process is started.
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■ In most cases, domain controllers should be restored non-authoritatively. This

prevents outdated objects in the Active Directory from being restored. Outdated

objects are referred to as tombstones. Active Directory does not restore data

older than the limits it sets. Restoring a valid recovery point of a domain

controller is the equivalent of a non-authoritative restore. Refer to the

Microsoft documentation to determine which type of restore that you want to

perform. A non-authoritative restore prevents tombstone conflicts.

For additional details about protecting non-VSS aware domain controllers, see

the white paper Protecting Active Directory at the following Symantec Web site:

http://eval.veritas.com/mktginfo/enterprise/white_papers/ent-whitepaper_protecting_active_directory.pdf
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Troubleshooting Backup

Exec System Recovery

Manager

This appendix includes the following topics:

■ Troubleshooting Symantec Backup Exec System Recovery

Troubleshooting Symantec Backup Exec System
Recovery

Use the troubleshooting information to find solutions to problems that might

occur when using Backup Exec System Recovery Manager.

For additional troubleshooting information, see the Readme.txt file on the product

CD, or refer to the Symantec Web site.

■ See “Improving performance when many computers are downloading an Easy

Installer at the same time” on page 190.

■ See “How results of Run Backups are displayed in the console” on page 191.

■ See “Adding the server to the console” on page 192.

■ See “Deploying a backup to a computer with an expired license of Backup Exec

System Recovery” on page 192.
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Improving performance when many computers are downloading an
Easy Installer at the same time

You can improve Backup Exec System Recovery Manager performance when many

computers are downloading an Easy Installer at the same time by doing any of

the following:

■ Use a phased approach to deploy or download an Easy Installer. That is, if 150

computers need to download an Easy Installer, only have 15 computers

download at a time.

■ Avoid having the console open at the same time that an Easy Installer is being

downloaded by many computers.

■ Edit web.xml to use a smaller value for the parameter maxsetupbundlethreads.

This will reduce the console unresponsiveness time.

To edit web.xml

1 On the computer that run the Backup Exec System Recovery Manager server,

navigate to the following path:

\Program Files\Symantec\Backup Exec System

Recovery\Manager\Services\tomcat\webapps\axis\WEB-INF\web.xml

2 Open web.xml in an XML editor.

3 Navigate to the parameter name maxsetupbundlethreads.

4 In the parameter value field (directly below the parameter name), change the

value 1000 to 10.

5 Save the web.xml file and exit the editor.

Now you must restart the Backup Exec System Recovery Manager Web

services.

6 On the Windows taskbar of the Backup Exec System Recovery Manager server,

click Start >Run.

7 In the Open text box, type services.msc, and then click OK.

8 Under the Name column, click BackupExecSystemRecoveryManagerWeb

Services.

9 Click Action >Restart.

10 Click File > Exit.
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Adjusting the memory allocation for the tomcat server

If you experience out of memory errors for the tomcat server (the Backup Exec

System Recovery Manager server software that works with the Backup Exec

System Recovery Manager database), you can adjust the allocated memory.

To adjust the memory allocation for the tomcat server

1 On the Windows taskbar of the client computer, select Start >Run.

2 Type regedit in the text box, and then click OK.

3 Open the registry key HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software

Foundation\Procrun 2.0\SBESRMWEB\Parameters\Java.

4 In the right pane, double-click the nameOptions to open the Edit Multi-string

dialog box.

5 Locate the value -Xmx in the Value data list box.

This value specifies the maximum Java heap size in megabytes.

6 Specify the new memory value that you want the tomcat server to use.

For example, if the current value is -Xmx256m, you can set it to a higher value

such as -Xmx1024m.

7 On the File menu, click Exit.

Now you must restart the Backup Exec System Recovery Manager Web

services.

Restarting the Backup Exec System Recovery Manager Web services

1 On the Windows taskbar of the Backup Exec System Recovery Manager server,

click Start >Run.

2 In the Open text box, type services.msc, and then click OK.

3 Under the Name column, click BackupExecSystemRecoveryManagerWeb

Services.

4 Click Action >Restart.

5 Click File > Exit.

How results of Run Backups are displayed in the console

When you use the Run Backups feature on a managed computer (a desktop

computer, for example) that does not have an assigned backup, the recovery point

status of the computer indicates that it was successful. However, on the Home

page, the Desktop pie chart categorizes the computer as “At Risk” instead of

“Backed Up” or "Needs Attention". This status is accurate.
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For a computer to appear in the Backed Up or Needs Attention category of the pie

chart, it must have a recovery point of all drives. If the client computer has an

assigned backup job, that job is used to determine if the computer needs attention

because the last scheduled backup job was missed.

Adding the server to the console

If you add to the Backup Exec System Recovery Manager console the computer

where the Backup Exec System Recovery Manager server is installed , you may

need to reboot the server manually after adding the computer. This is true if the

option "Reboot client computer if necessary after install" is unchecked in the Easy

Installer of Backup Exec System Recovery.

Following the manual reboot of the server, the computer appears on the Manage

page of the console.

Deploying a backup to a computer with an expired license of Backup
Exec System Recovery

When you deploy a backup to a computer that has an expired license of Backup

Exec System Recovery, the status in the console indicates that the backup is in a

perpetual state of being assigned to the computer. This information is accurate.

You can check the Backup Exec System Recovery license status on client computers

by checking the License column on the Manage page. Or, you can check the license

status for all computers in the Status pie chart of the Home page. Click a pie slice

to get detailed license status for the affected computers.
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